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1 Safety Information

1 Safety Information

1.1 General Safety Information

Notes

Intended use

Qualification

Disposal

Please read this manuali before using the instrument. it will provide you with
important information on using the instrument and on safety. This will protect
you and prevent damage to the instrument. Pay particular attention to the
basic safety information in CHAPTER 1 and the information on installation,
operation and maintenance in CHAPTER 3.

Please keep this manual in a safe place and make it available to people using
the instrument. Never pass the instrument on without the manual.

In this manual the following graded safety and warning labels are used:

NOTE !

Identifies action required {o simplify using the instrument.

CAUTION 1

Danger from "Reason for Danger™! - Ideniifies the danger caused by an
action which could result in damage to the instrument if it is not avoided!

WARNING !

Danger from "Reason for Danger” | - |dentifies a possible danger resulfing
from an action which could lead to death or {serious) injury if it is not avoided!

The instrument is intended for laboratory use and for use in an industrial
environment. It may only be used within the limits given in the technical
specifications (refer to CHAPTER 7).

Faultless and safe operation of the instrument depends on correct and proper
transport and storage, installation and assembly as well as careful operation
of the instrument.

When assembling, installing and operating the instrument, the safety and
accident-prevention regulations for the respective use must be adhered to.

This instrument may only be operated by persons who are familiar with
electrical measurement equipment and have been instructed in the use of
lasers. Please pay attention to the information on laser safety in SECTION 1.2.

Intervention for maintenance and repair work may only be carried out by the

manufacturer himself or by qualified personnel authorized by the
manufacturer.

An instrument which is no longer required must be disposed of according to
local regulations unltess otherwise provided for by the manufacturer.
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1 Safety Information

1.2 Information on Laser Safety

1.2.1 Safety Information

1-2

The light source of the instrument is a helium neon laser and the light source
of the optional scanning head with geometry scan unit PSV-A-420 is a laser
diode. it is important to understand that laser light has different properties
from ordinary light sources. Laser light is generally extremely intense due to
the beam's low divergence. When handling lasers, great care should be taken
in any case to make sure that the direct or reflected beam does not enter the
eye.

The protective measures taken described in the following support compliance
with the safety standards for laser class 2:

NOTE |

Please see CHAPTER 7 for detalled technical specifications!

» Polytec instruments generally comply with the standards IEC and EN
60825-1 and US 21 CFR 1040.10 and 1040.11 respectively except for
deviations pursuant to Laser Notice no. 50, dated 26 July 2001.

e The optical output power of the laser beam emitted from the sensor head
is less than 1 mW provided the equipment is used in the manner for which
it was intended. This means that the instrument conforms with laser class
2 and is generally very safe. It is thereby usually assumed that eyes are
protected by prevention mechanisms including the blink reflex. This
reaction offers appropriate protection under reasonably foreseeable
operating conditions. This includes the use of optical instruments for
observing the laser beam. Even when optimally focused, the laser beam
is not intense enough to harm the skin.

« The scanning head is equipped with a beam shutter to block the laser
beam during the warm-up, or when the vibrometer is not in use, aithough
switched on.

¢ An emission indicator on the scanning head indicates the activity of the
installed laser and thus the potential hazard of laser beams emitted.

e The laser in the scanning heads are switched on using the key switch on
the appropriate controller. The key can only be removed if the controller
and therefore also the laser is switched off.

¢ The user should not attempt {o open the housing of the instrument which
contains the laser unit as he could be exposed {o a higher level of laser
energy that is potentially hazardous

WARNING |

Danger from uncontrolled light emission ! - Use of controls or adjustments
or performance of procedures other than those specified herein may result in

hazardous radiation exposure.




1 Safety Information

1.2.2 Safety Precautions

Pay attention to the following safety precautions when using the instrument:

Only qualified and fully trained persons should be entrusted with setting
up the instrument, adjusting and operating it!

Avoid looking directly into the laser beam with the naked eye or with the
aid of mirrors or optical instruments!

WARNING !

Danger from [aser light! - It can be dangerous to look directly into the laser
beam for any length of time!

NOTE!

Wear suitable laser protection glasses when you have to look at the target
area of the laser beam long and hard to set it up!

Never intentionally direct the laser beam at anyone!

WARNING |

Danger from [aser light ! - Do not use any reflective tools, watches etc. when
you are working in the beam path of the laser!

Only open the beam shutter when making measurements !

Avoid staying in the scanning area! The laser beam can exit the scanning
head at an angle of £20°,

To position the scanning head, always close the heam shutter. The beam
shutter should not be opened until the scanning head has been roughly
aligned and mounted securely!

The laser beam should be terminated at the end of its intended path
where this is practically possible.

Instruments which are not in use should be stored in places which
unauthorized persons do not have access to.
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1 Safety Information

1.2.3 Laser Warning Labels

Warning labels  The laser warning label for the scanning head are shown in FIGURE 1.1. For
the countries in the European Union (EU), label 2 is affixed in the language of
the customer's country (see right-hand-side).

1
Laser Radiation T . Laserstrahtung
Do not stare into beam : E| s "
! Class 2 Laser Product : Nicht in den Straht blicken
2 : According to IEC/EN 60825-1 (2001} : Laser Klasse 2

I Complios with 21 CFR 1040.10 and 1040.11 |
1 excapt for deviations puesuant to . . Nach EN 60825-1 (2001)

Laser Notice no. 50, dated 26 July 2001 i ]

P < 1 mWiow, A =B20-700 n);n | i P <1 mWicw: 2 =620-700 nm

Figure 1.1: Laser warning labels for the scanning head

Position The position of the laser warning labels on the scanning head is shown in
FIGURE 1.2.

Figure 1.2: Position of the laser warning label on the scanning head
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1.3 Information on Electrical Safety

1.3.1 Safety Information

NOTE |

Please note that the information on electrical safety and EMV mentioned here,
only applies to controllers permitted by Polytec. You will find the
corresponding declaration of conformity in the user manual of the controlier.

The instrument complies with the electrical protection class 1 in accordance
with the EU directive 2006/95/EEC (low voltage directive). With correct
mains connection and intended use, exposure to electric current is prevented
by the closed, grounded metal housing.

The instrument is subjected to the EU directive 2004/108/EG (EMC directive)
and therefore complies with the limit values for emission and immunity of the
standards they are based on (refer also to section SECTION 7.1 and

APPENDIX D).

1.3.2 Safety Precautions
Pay attention to the following safety precautions when using the instrument:

« The PSV system components (controller, junction box and PC} are only to
be connected up using a three-pin mains cable to AC system 50/ 60 Hz
with grounded protective conductor with a nominal voliage of between
100V and 240V.

« Defective mains fuses may only be replaced by fuses of the same kind
with the rating given on the back of the instrument.

« |f the mains switches are not freely accessibie, use the mains plugs to
disconnect the devices in case of danger. This means that the mains piug
needs to be freely accessible. Otherwise an additional disconnection
device must be installed.

e The housing may not be opened when using the instrument as intended.
Opening the housing will invalidate the warranty. None of the equipment
may be operated with opened housing.

WARNING |

Danger from electrical current! - Intervention for maintenance and repair
work may only be carried out by the manufacturer himself or by qualified
personnel authorized by the manufacturer.

NOTE |

Before removing parts of the housing for instaliation and servicing purposes,
as a general rule the mains plug should always be unplugged.

o Airinlets and outlets must always be kept free to ensure sufficient cooling.
If you notice that the cooling fan is not working, immediately switch the
instrument off.
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1 Safety Information

CAUTION !

Danger from heat accumulation! - If you mount the instrument into a
switching cabinet, pay attention that the air inlets in the bottom plate must
always be kept free!

16



2 Introduction

2 Introduction

2.1 Area of Application and System Summary

The Polytec Scanning Vibrometer PSV measures the two-dimensional
distribution of vibrational velocities on the basis of laser interferometry. The
system components are shown in FIGURE 2.1.

Junction box

Controller

Figure 2.1: System componenis of the PSVY

The interferometer signal is decoded in the controller with the velocity
decoder. An analog voltage signal is thus generated which is proportional to
the vibrational velocity.

The junction box is the central connection point between the system
components and provides the interfaces for peripheral devices.

The scanning head consists of the interferometer, the scanner mirrors to
deflect the laser beam and a video camera to visualize the measurement
object.

The measurement data is digitally recorded in the Data Management

System. The PSV software controls the data acquisition and offers user-
friendly functions to evaluate the measurement data.

2-1



2 Introduction

2.2 Polytec's Modular Concept of the Controller

2.2.1 Principle

The construction of Polytec vibrometers is based on a modular principle and
thus allows user-specific configuration. The modularity is initially achieved
through strict separation of optics and electronics. The controller is designed
s0 that it can be equipped with different signal processing modules optimized
for the respective application. The various decoders with digital and analog
technology can thereby be combined with all sensor heads. A schematic
layout of the corresponding signal flow in the controller is shown in

FIGURE 2.2.

HF stage Decoder stage LF slage
Valocity :
3| decodar § Velocity 1 analog
analag/digital
Analog filter ————(3% Velocity Output
. Velocity 2 analog
Xelocﬂy ,
p| decoder y .
.E’ analog/digital Valocity 2 digital
[
o
g ——— DSPfilter [—— Velocily DSP Qut
Doppler B 2
signaldoMHz | & o
e B
[+
5 3
E ?IP.DIﬁt — (3 Digital Out Electrical
ransmitter . .
£  Displacament digital G Digital Out Optical
g
.| Displacement
| decoder Displacement anatog —{5 Displacement Output
Counts (3 External Decoder
Auxiliary decoder| .
=‘_m,°dt;>’of Velocity or Dlsplacement analog _O» Auxiliary Oulpat
displacement

Figure 2.2: Schematic layout of signal flow in the controller

The high-frequency Doppler signal coming from the scanning head initially
enters into a high-frequency stage. Whichever decoders the controller has
been equipped with, the measurement signal is optimally conditioned here
and supplied to the decoder stage. In this stage velocity or displacement
information respectively are recovered from the signal. The decoder stage is a
followed by a low-frequency stage, consisting of an analog filier module and a
digital interface.



2 Introduction

2.2.2 Available Decoders

VD-03

VvD-04

VD-05

VD-07

VD-08

DD-300

vD-09

In the following, you will find the decoders listed which are available for the
PS8V controller. You will find different PSV models with the corresponding
decoders in SECTION 2.3.

With three measurement ranges, the VD-03 covers the entire dynamic range
of the vibrometer in the frequency range 0.5Hz to 1.5MHz.

With three measurement ranges, the VD-04 covers the entire dynamic range
of the vibrometer in the frequency range 0.5Hz to 250kHz.

The velocity decoder VD-05 with two measurement ranges is suitable to
acquire extremely high-frequency vibrations up to 10MHz. Despite the wide
bandwidth and the reiatively rough scaling, the VD-05 attains excellent
resolution values with spectral signal evaluation. Furthermore the VD-05 is
suitable to acquire fast transient motions.

The decoder VD-07 equipped with the digitai signal processing (DSP
technology) has six measurement ranges which allow high-precision, high-
resolution acquisition of vibrations in the frequency range from OHz to
350kHz with a maximum velocity of 0.5m/s. Apart from the usual analog
voltage output, it provides the option of {ransmitting measurements signals up
to 42kHz signal frequency via the digital interface (S/P-DIF format) directly to
suitable equipped signal acquisition systems.

Only the PSV -400-H4 instead of the VD-07: The decoder VD-08 equipped
with the digital signai processing (DSP technology) has eight measurement
ranges which allow high-precision, high-resolution acquisition of vibrations in
the frequency range from OHz to 25kHz with a maximum velocity of 0.5m/s.
Apart from the usual analog voltage oufput, it provides the option of
transmitting measurements signals via the digital interface (S/P-DIF format)
directly to suitable equipped signal acquisition systems.

The displacement decoder DD-300 has been developed especially for
acquiring high-frequency vibrations and impulses in the frequency range from
30kHz to 24 MHz. The amplitude range limited to £75nm is adapted to the
physical limitations of high-frequency processes.

Only PSV-400-M2, PSV-400-M4 and PSV-400-M2-20: The VD-09 is a digital
broadband decoder and is universally suitable for applications in the
frequency range up to 2.5 MHz. It is equipped with digital signal processing
and has eight measurement ranges which allow extremely accurate and high-
resolution acquisition of vibrations or transient movements with a maximum
velocity of 10m/s. The lower cutoff frequency of OHz (DC capability) enables
the decoder VD-09 to be used unlimited also for the acquisition of uniform,
intermittent or rotational movements.
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2 Introduction

2.3 The Different PSV Models

The decoder and filter in the controller as well as the data acquisition board in
the PC determine the characteristics of the PSV. Depending on the

application there are different models available; their characteristics are
summarized in TABLE 2.1.

Table 2.1: Summary of the PSV models
PSV-400-H4
PSV model High frequency model PSV-400-8
Basic model
4 channels
Controller OFV-5000 OFV-5000
Velocity Decoders VD-03 + VD-08 VD-04
Measurement range [5%/V] VD-03: 10/100/1000
i VD-08: 8 ranges from 0.2 to 50 10710071000
Maximum frequency VD-03: 0.25/1.5/1.5MHz
VD-08; 5kHz to 25kHz 250kHz
Digital signal processing PSV-W-401-H4 PSV-W-401-B
Data acquisition board - - 1
q PCl-4462 {+ PCI-4462) PCI4461
Internal function generator PCI-6711
Maximum bandwidth 80kHz 40kHz
Input channel (simultaneous) 4 (8) 2
Output channel {generator) 4 (1)
Maximum bandwidth (generator) 80kHz (20kHz)
! The designations In brackets are available as an option.
PSV-400-M2 PSV-400-M4
PSV model High frequency model High frequency model
2 channels 4 channels
Controller OFV-5000 OFV-5000
Velocity Decoders VD-09 + VD-07 VD-09 + VD-07

Measurement ranges [¥%/V]
digital-

VD-09: 8 ranges from 5 to 1000
VD-07: 6 ranges from 1 to 50

VD-09: 8 ranges from 5 to 1000
VD-07: 8 ranges from 1 to 50

Maximum frequency

VD-09: 0.1MHz to 2.5MHz
VD-07: 20kHz to 350kHz

VD-09: 0.1MHz to 2.5MHz
VD-07: 20kHz to 350kHz

Digital signal processing PSV-W-401-M2 PSV-W-401-M4
Data acquisition board

PCI-6111 PCI-6110
internat function generator
Maximum bandwidth 1MHz (2MHz)! 1 MHz (2MHz)
tnput channel {(simultanecus) 2 4
Qutput channsi (generator) 1 1
Maximum bandwidth (generator) 500kHz 500kHz

' The designations in brackets are available as an oplion.
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2 Introduction

PSV model

PSV-400-M2-20
High frequency model
2 channels (max. 20 MHz)

Controlier

OFV-5000

Velocity Decoders

VD-09 + VD-07 + VD-05

Measurement ranges [5~/'V]

VD-08: 8 ranges from 5 to 1000
VD-07: 6 ranges from 1 to 50
vD-05: 100/500

Maximum frequency

VD-09: 0.1 MHz to 2.6MHz
VD-07: 20kHz to 350kHz
VD-05: 10MHz

Disptacement decoder

(DD-300)

Measurement range [nm/V]

50 (DD-300)?

Maximum measurable displacement

+75nm (DD-300)

Maximum frequency

24 MHz (DD-300)

Digital signal processing

PSV-W-401-M2-20

Data acquisition board MI.3025
Internal function generator MI.6030
Maximum bandwidth 40MHz
Input channel {simuitaneous) 2
Output channel (generator) 1
Maximum bandwidth {generator) 40MHz

*instead of the velecity decoder VD-05
2 At load resistance 500
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3 First Steps

3 First Steps

3.1 Unpacking and Inspection

Unpacking

The PSV is made up of the following components:

Controller OFV-5000
Scanning head PSV-1-400

CAUTION !

Banger from hard Jolting ! - Protect the unpacked scanning head from hard
jolts as these can lead to misalignment of the interferometer!

Junction box PSV-E-401

Data management system PSV-W-401 consisting of industrial PC with
keyboard and mouse (according o the model}

TFT monitor with monitor cable and mains cable
Tripod with fluid stage VIB-A-T02

Hand set PSV-Z-051 (optional for PSV-400-B)
Umbilical cable

Interferometer cable

S-Video cable with adapter cable

Acquisition cable

3 BNC cable

RS-232(X) cable (cross-wired)

USB cable

Generator cable (only PSV-400-H4 and -B)

Data acquisition and generator cable (ACQ/GEN 20MHz, only
PSV-400-M2-20)

SMB-SMB connecting cable (only PSV-400-M2-20)
3 mains cables

Optional

Junction box PSV-E-408 with plug-in power supply {only PSV-400-H4)
Acquisition cable (only PSV-400-H4)

System cabinet PSV-A-010

Close-up unit PSV-A-410

Scanning head with geometry scan unit PSV-A-420

Acoustic gate unit PSV-A-430 with BNC cable

Heavy duty tripod with motorized pan-tilt stage, connector box and mains
cable PSV-A-T11 (instead of the VIB-A-T(02)

Test stand PSV-A-T18
Hand set PSV-A-PDA (only PSV-400-H4)
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Inspection Please pay attention to the following steps when unpacking PSV:
1. Check the packaging for signs of unsuitable handling during transport.

2. After unpacking, check all components for external damage (scratches,
loose screws, damaged lenses etc.).

3. In the case of a wrong delivery, damage or missing parts, please inform
your local Polytec representative immediately and give them the serial
number of the instruments. The identification labels can be found on the
back of the instruments, on the bottom side of the scanning head as well
as on the inside cover of this manuali.

4. Carefully retain the original packaging in case you have to return the
instrument PSV.

Install the PSV as described in SECTION 3.4 and carry out a functional test as
described in SECTION 3.5.

3.2 Operating and Maintenance Requirements

Ambient The PSV can be operated in dry rooms under normal climatic conditions (refer
conditions to CHAPTER 7). In particular the optical components in the scanning head are
sensitive fowards moisture, high temperatures, shocks and diri.

If the PSYV is taken into operation after being stored in a cold environment, a
sufficient acclimatization period should be allowed before swifching it on.
Avoid condensation on the optical components caused by a rapid change in
temperature.

Assembly The scanning head should not be set up provisionally but should be securely
mounted as free of vibration as possible on a stable tripod or an alternative
stable base using the mounting threads.

Cooling It is very important to ensure that there is sufficient air circulation to cool the
system components. The back panel of the instruments must be at least
50mm away from the wall.

CAUTION 1

Banger from heat accumulation! - The PSV may only be operated in the
system cabinet if the cover of the system cabinets are removed. Otherwise
generation of heat can cause damages in the instruments!

CAUTION 1

Danger from heat accumulation! - If you mount the instrument info a
_ switching cabinet, pay attention that the air inlets in the bottom plate must

always be kept free!

Connecting As a general rule, the PSV may not be switched on until all connecting cables

cables have been connected up. Make sure that all jacks are connected properly and
firmly. Plug in the SCSI-type connectors of the acquisition cable with great
care at the right angles. Only use the original RS-232(X) cable from Polytec
for the RS-232 connection (cross-wired).
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Mains
connection

Warming-up

Cleaning

Pan-tilt stage

Installation of
other
components

Opening the
instruments

3 First Steps

Protect all connecting cables from mechanical damage and from high
temperatures. The bending radius should not fall below 50 mm.

The mains voltage input of the instruments is designed to be a wide range
input and can be connected up to all mains voltages with nominal values in
the range of 100V to 240V.

The plug-in power supply, contained in the scope of supply, for the junction
box PSV-E-408 offers a wide range input and can therefore be connected up
to all mains voltages with nominal value in the range of 100V to 240V,

The helium neon laser in the scanning head will take a little while to reach the
optimal working temperature after it has been switched on. The PSV therefore
reaches its optimal properties after a warm-up period of approx. 30 minutes.
After that you can be sure that all components are working properly in
accordance with the specifications. Less critical measurements, such as to
align the PSV for example, can however be carried out before this warm-up
period has expired.

The housing surfaces of the instruments can be cleaned with mild detergent
or disinfectant solutions. Organic solvents must not be used.

Avoid any additional weight on the pan-tilt stage by placing the objects on top
of the scanning head as this can put strain on the pan-tilt stage.

Hard or software components which do not belong to the PSV system can
damage the system. Using them will invalidate the warranty. If you want to
install such components please contact Polytec.

It is not necessary to open the housings when using the equipment as
intended and will invalidate the warranty.
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3 First Steps

3.3 Control Elements

3.3.1 Controller

Front panel

The front panel of the controller is shown in FIGURE 3.1.
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Figure 3.1: Front view of the controller

1

Mains switch

The key switch disconnects the controller from the mains {position O) and
is used to switch it off in case of danger.

CAUTION !

Danger from mishandling [- Always connect up all connecting cables before
you switch the controller on! if you do not keep the order, damage to the
instrument may occur!

2

34

POWER LED

The LED lights up, if the controller has been switched on with the key
switch (position |) and indicates that the controlier is ready to operate.

Liquid Crystal Display (LCD) with background lighting

The display shows the configuration and settings of the controller. In the
PS8V, the controller is operated via the software (refer to software manual).
Operating the controller without the software is described detailed in
SECTION 5.15.

Function keys

Use these keys to navigate through the menus of the controller or change
the settings respectively according to the icons shown in the display next
to them. In the PSV, the controller is operated via the software (refer to
software manual). Operating the controller without the software is
described detailed in SECTION 5.15.
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3 First Steps

AUXILIARY OVER LED for the auxiliary decoder

The LED lights up if the output voltage either reaches the positive or the
negative full scale value of the selected measurement range. if the LED
lights up permanently, the next highest measurement range must be
selected if available (refer also to secTiON 4.2.1).

VELOCITY OVER LED for the velocity decoder

The LED lights up if the output voltage either reaches the positive or the
negative full scale vaiue of the selected measurement range. If the LED
lights up permanently, the next highest velocity measurement range must
be selected if available (refer to SECTION 4.2.1).

Signal output VELOCITY DSP OUT (BNC jack)

Output signal of the optional DSP filter (only when using the adaptive DSP
filter)

Signai output VELOCITY QUTPUT (BNC jack)

Output signal of the velocity decoder. The voltage at this output is
proportional to the instantaneous vibrational velocity of the object. The
voltage is positive when the object is moving towards the scanning head.

Signal oufput DISPLACEMENT OUTPUT (BNC jack)

Output signal of the displacement decoder. This output is only active if a
displacement decoder has been installed. The voltage at this output is
proportional to the instantaneous deflection of the object. The voltage
increases when the object is moving towards the scanning head.

Signal output AUXILIARY OUTPUT (BNC jack)
Output signal of the auxiliary decoder. This output is only active if an
auxiliary decoder has been installed.

Signal input DISPLACEMENT TRIG IN (BNC jack)

This input is only active if a displacement decoder has been installed. This
signal input can be used to reset the displacement decoder remotely to
the zero position.

Signal output AUXILIARY UNIVERSAL (BNC jack)
Signal output for special functions of the auxiliary decoder

CLEAR key for the displacement decoder

This key is only active if a displacement decoder has been installed. This
key can be used io reset the displacement decoder manually to the zero
position.
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Back panel The back panel of the controller is shown in FIGURE 3.2.
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Figure 3.2: Rear view of the controlier

1 ldentification label
On the identification label you will find, among other things, the serial
number of the instrument.

2 Digital signal output Optical {TOSLINK jack)
Connector for an optical fiber cable with a TOSLINK plug to transmit the
S/P-DIF signal

3 Digital signal output Electrical (TRIAX jack}
Connector for the optional S/P-DiF cable to transmit the
S/P-DIF signal

4 Cooling fan

CAUTION !

Danger from heat accumulation | - This opening must always be kept free to
ensure sufficient cooling. The distance to the wall must be at least 50mm!
Furthermore, provide sufficient free space under the controller as air vents are
located there!

5 Signal output SIGNAL (BNC jack)

The DC voltage at this output is proportional to the logarithm of the optical
signal level. This signal can be used to monitor the optical measurement
conditions externally,

6 Instrument warning label
Label with technical data for the fuses and the mains connection

7 Mains connection (socket for standard power cord with built-in fuses)

The mains voltage input is designed to be a wide range input (refer also to
SECTION 3.2).

3-8



3 First Steps

WARNING !

Danger from electrical current! - Working on an open housing can lead to
personal injury!

NOTE !

Before checking the fuses, the mains plug must be disconnected!

8 SENSOR connector (Sub-D jack)
Connector for the interferometer cable from the junction box

9 External Decoder interface (Sub-D jack)
Not used for PSV systems!

10 RS 232 interface (9-pin Sub-D connector)

Connector for the RS-232(X) cable from the junction box to control the
PSV via the software

NOTE I

To conirol the PSV via the software, in the controlier the transfer rate must be
sef to 115200 Baud (refer also to SECTION 5.16)!
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3.3.2 Junction Box PSV-E-401

Front panel

The front panel of the junction box is shown in FIGURE 3.3.
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Figure 3.3: Front view of the junction box PSV-E-401

1 DIFF Leb for the differential input

The LED being lit indicates that for the channels (VELO, REF 1, REF 2,
REF 3) selected in the software the Differential Input is activated in the
software (differential mode = not grounded). You can thus avoid ground

J&/J

loops and generally improve transmission reliability. Activating and
deactivating the differential input is described in the software manual.

2 ICP Lep for REF1

The LED being lit indicates that for the reference input REF 1 the IEPE

power supply (ICP®) is activated in the software.

3 Analog input REF1 (BNC jack)

Analog voitage input for the reference signal. To this jack you can also
connect sensors that are equipped with an integrated amplifier according
to the |IEPE concept (ICP®) (4mA/24V). Activating or deactivating the

IEPE power supply {ICP®) is described in your software manual.

4 [CP Lep for REF2, only PSV-400-H4 and PSV-400-M4

The LED being lit indicates that for the reference input REF 2 the IEPE

power supply (ICP®) is activated in the software.

5 Analog input REF2 (BNC jack), only PSV-400-H4 and PSV-400-M4

Analog voltage input for the second, additional reference signal. To this
jack you can also connect sensors that are equipped with an integrated
amplifier according to the |IEPE concept (ICP®) (4mA/24V). Activating or
deactivating the IEPE power supply (ICP®) is described in your software

manual.
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ICP LED for REF 3, only PSV-400-H4 and PSV-400-M4

The LeD being lit indicates that for the reference input REF 3 the IEPE
power supply (ICP®) is activated in the software.

Analog input REF 3 (BNC jack), only PSV-400-H4 and PSV-400-M4

Analog voltage input for the third, additional reference signal. To this jack
you can also connect sensors that are equipped with an integrated
amplifier according to the IEPE concept (ICP®) (4 mA/24 V). Activating or
deactivating the IEPE power supply (ICP®) is described in your software
manual.

Analog input VELO for the velocity signal (BNC jack)
Analog voltage input for the velocity signal from the controller

TTL output SYNC (BNC jack)

Synchronization pulse for the signal of the internal function generator
PSV-400-B: The output is only active with the corresponding option.

TTL input TRIG IN (BNC jack)
TTL input for an external trigger signal

TTL output AUX OUT (BNC jack)

TTL output for especially application, programmable via Visual Basic®
Engine

TTL input AUX IN (BNC jack)

TTL input for especially application, programmable via Visual Basic®
Engine

Generator output SIGNAL1 (BNC jack)

Analog voltage output for the signal of the internat function generator
PSV-400-B: The output is only active with the corresponding option.

Generator outputs SIGNAL 2 to SIGNAL4 (BNC jacks),
only PSV-400-H4: Here are three additional analog voltage outputs
available for the signals of the internal function generator

POWER LED

The Leb lights up when the junction box is connected up correctly to the
controller and the key switch on the controller is turned to position |. The
LED indicates that the junction box is ready to operate.
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Back panel

The back panel of the junction box is shown in FIGURE 3.4,
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Figure 3.4: Rear view of the junction hox PSV-E-401
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1

USB interface (Universal Serial Bus, type B)

Connector for the USB cable from the PC to control the PSV via the
software

S-VIDEO output (4-pin circular jack)
Connector for the S-Video cable to the PC to transmit the video signal

Connector GENERATOR IN (Sub-D plug)

PSV-400-H4, -B: Connector for the generator cable from the PC to
transmit the signals of the internal function generator

PSV-400-M2-20: Connector for the acquisition and generator cable ACQ/
GEN 20 MHz from the PC to transmit the measurement and control
signals as well as the signals of the internal function generator

Connector ACQUISITION BOARD (SCSi-il type)

Connector for the Acquisition cable to the PC to transmit both
measurement and frigger signals; with the PSV-400-M2-20, the connector
is not connected!

Cooling fan

CAUTION |

Danger from heat accumulation! - This opening must always be kept free to

ensure sufficient cooling. The distance to the wall must be at least 50mm|

.. Furthermore, provide sufficient free space under the junction box as air vents
are located there!

6

Identification label

On the identification label you will find, among other things, the serial
number of the instrumant.




PRInk § i

Mains connection (socket for standard power cord with buiit-in fuses)

The mains voitage input is designed to be a wide range input (refer also to
SECTION 3.2.

WARNING 1

Danger from electrical current! - Working on an open housing can lead to
personal injury!

NOTE !

Before checking the fuses, the mains plug must be disconnected!

CAUTION |

Danger from mishandling! - Always check the fuses before installing the
PSV!

10

11

12

13

Instrument warning label
Label with technical data for the fuses and the mains connection

Connector SCANNING HEAD(industrial-style)
Connector for the Umbilical cable from the scanning head

Connector for the CONTROLLER (Sub-D jack)
Connector for the interferometer cable to the controller OFY -5000

TTL input GATE IN (BNC jack)

TTL input for the external Gate signal to start and stop a measurement.
Level LOW of the signal discontinues the measurement

PSV -400-B: The input is only active with the corresponding option.

RS 232 interface (9-pin Sub-D plug)

Connector for the RS-232(X) cable to the confrofler to control the PSV via
the software.

Connector OPTION

For special function, in the standard version not installed!
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3.3.3 Junction Box PSV-E-408 (optional, only PSV-400-H4)

Front panel The front panel of the junction box is shown in FIGURE 3.5.
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Figure 3.5: Front view of the junction box PSV-E-408

CAUTION |
Danger from heat accumulation! - To ensure sufficient ¢ooling, these

openings must kept free!

2 ldentification label

On the identification label you will find, among other things, the serial
number of the instrument.

3 DIFF LED for the differential input

The LED being lit indicates that for the channels (REF 21, REF 22,

REF 23, REF 24) selected in the software the Differential Input is
activated in the software (differential mode = not grounded). You can thus
avoid ground loops and in certain cases improve fransmission reliability.
Activating and deactivating the differential input is described in the
software manual.

4 ICP LeD for REF 21

The LED being lit indicates that for the reference input REF 21 the [EPE
power suppiy (ICP®) is activated in the software.

5 ICP Lep for REF 22

The LED being lit indicates that for the reference input REF 22 die IEPE
power supply (ICP®) is activated in the software.

6 ICP Lep for REF 23

The LED being lit indicates that for the reference input REF 23 the IEPE
power supply (ICP®) is activated in the software.

7 ICP LED for REF 24

The LED being lit indicates that for the reference input REF 24 the |IEPE
power supply (ICP®) is activated in the software.
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Analog input REF 24 (BNC jack)

Analog voltage input for the reference signal. To this jack you can also
connect sensors that are equipped with an integrated ampilifier according
to the IEPE concept (ICP®) (4mA/24V). Activating or deactivating the
IEPE power supply (ICP®) is described in your software manual.

Analog input REF 23 (BNC jack)

Analog voitage input for the reference signal. To this jack you can also
connect sensors that are equipped with an integrated amplifier according
to the IEPE concept (ICP®) (4mA/24V). Activating or deactivating the
IEPE power supply (ICP®} is described in your software manual.

Analog input REF 22 (BNC jack)

Analog voltage input for the reference signal. To this jack you can also
connect sensors that are equipped with an integrated amplifier according
to the IEPE concept (ICP®) (4mA/24V). Activating or deactivating the
IEPE power supply (ICP®) is described in your software manual.

Analog input REF 21 (BNC jack)

Analog voltage input for the reference signal. To this jack you can also
connect sensors that are equipped with an integrated amplifier according
to the |IEPE concept (ICP®) (4 mA/24V). Activating or deactivating the
IEPE power supply (ICP®) is described in your software manual.

The back panel of the junction box is shown in FIGURE 3.6.

o T

S EE d—=p

b ACQUISITION BOARD M

Figure 3.6: Rear view of the junction box PSV-E-408

1

USB interface (Universal Serial Bus, type A)
Connector for the USB cable to the PC

Connector for the power supply cable (5VDC)

Caonnector for the plug-in power supply of the junction box (refer also to
SECTION 3.2)

Connector ACQUISITION BOARD for the data acquisition board (SCSI-Ii
type)

Connector for the Acquisition cable to the PC to {ransmit the additional
reference signals
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3.3.4 PC

Front panel for  The front panel of the PC for all PSV models is shown in FIGURE 3.7. The
all models Jockable front flap is shown as transparent.
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Figure 3.7: Front view of the PC

1 Cooling fan

CAUTION I

Danger from heat accumulation | - To ensure sufficient cooling, these
openings must kept free!

2 POWER Lep

The green LED lights up when the PC is switched on using the mains
switch on the back and the black key on the front has been pressed.

3 HDDLep
The yellow LED being lit indicates the activity of the hard disk drive (HDD)
in the PC.

4 RESET key

This white key is used to reset all components of the PC and the PC is
restarted. The status of the PC is the same as it was after first being
switched on.

5 DVD recorder

You will find an exact description of the DVD recorder in the user manual
of the manufacturer.
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6 3,5" disk drive

7 POWER key
By pressing the black key, the PC will be switched on.

8 USB interface (Universal Serial Bus, type A)
Connector for a mass storage device

9 Lock with key in the front flap

To secure the PC for unauthorized using, the front flap can be locked
using the key.

Back panel for  The back panel of the PC for the PSV mode!l -H4 is shown in FIGURE 3.8. The
models -H4 and  order of the plug-in boards may vary from that shown in the picture. The PC of

-B the PSV model -B contains another data acquisition board. You will find a
description of the connectors of the data acquisition board in the following
section.
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Figure 3.8: Rear view of the PC for the PSV model -H4

N
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1 Mains connection (socket for standard power cord)

The mains voltage input is designed to be a wide range input (refer also to
SECTION 3.2).

2 Mains switch

The mains switch disconnects the PC from the mains (position O) and is
used to switch it off in case of danger.

CAUTION |
Danger from mishandling ! - Always connect up all connecting cables before

you switch on the PC!

3-15



3 Flrst Steps

3-16

10

1"

12

13

14

15

16

Connector MOUSE (8-pin circular jack)
Connector KEYBOARD (6-pin circular jack)

USB interface (Universal Serial Bus, type A)

Alternative connector for peripheral devices such as mouse, keyboard,
etc. or to connect the hardlock to release the software

Serial interface COM1 (9-pin Sub-D plug)

Parallel PRINTER connector {(25-pin Sub-D jack)
Connector for the printer and the hardlock to release the software

MONITOR connector (15-pin Sub-D jack)

Connector NETWORK
For connecting up to an ethernet network

USB interface (Universal Serial Bus, type A)

Connector for the USB cable from the junction box to control the PSV via
the software

Monitor connector (DVI jack)
Connector for an additional TFT monitor

Network connector
To connect the WLAN Access Point of the optional PSV-A-PDA

USB interface (Universal Serial Bus, type A)

Additional alternative connectors for peripheral devices such as mouse,
keyboard, etc. or o connect the hardlock to release the software

AV connector (S-Video jack)

Connector for the video cable from the junction box to transmit the video
signal

Connector GENERATOR of the internal function generator (SCSI-Il type),
only PSV-400-H4

Connector for the generator cable to the junction box to transmit the
signal of the internal function generator

Connectors ACQUISITION for the data acquisition (BNC jacks and SMB
jack)

Connectors for the data Acquisition cable from the junction box PSV-E-
401 to transmit both measurements and trigger signals. You will find a
detailed description of the connectors of the data acquisition board in the
following.

NOTE |

Please make sure that you always connect the junction box PSV-E-401 to
these connectors |




Data acquisition
board for PC
model -H4

3 First Steps

17 Connectors ACQUISITION PSV-E-408 for additional reference signals
(BNC jacks and SMB jack), optional onily PSV-400-H4

Connectors for the data Acquisition from the optional junction box PSV-E-
408 to transmit the additional reference signals

NOTE!

Please make sure that you always connact the optionat junction box
PSV-E-408 to these connectors |

18 Air vents

CAUTION |

Danger from heat accumulation! - To ensure sufficient cooling, these
openings must kept free! The distance to the wall must be at least 50mm!

19 IEEE-1394 inferface
20 MONITOR connector (DVI jack)
21 Video output (9-pin circular jack)

22 Instrument warning label
Label with technical data for the mains connection

23 ldentification label

On the identification label you will find, among other things, the serial
number of the instrument.

24 Cooling fan

CAUTION !

Danger from heat accumulation ! - This opening must always be kept free
to ensure sufficient cooling! The distance to the wall must be at least 50 mm!

The connectors of the data acquisition board PCI-4462 for the PC model -H4
are shown in FIGURE 3.9.

Pg_o 'i 'i & i

Figure 3.9: View of the data acquisition board PCI-4462

1 TTL input PF1_0 (SMB jack)
TTL input for an external trigger signal

2 Analog input Al_3 (BNC jack)
Analog voltage input for the reference signal
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Analog input Al_2 (BNC jack)
Analog voltage input for the reference signal

Analog input Al_1 (BNC jack)
Analog voltage input for the reference signal

Analog input Al_0 (BNC jack)
Analog voltage input for the vibrometer signal (Velocity)

Data acquisition The connections of the data acquisition board PCI-4461 are shown in
FIGURE 3.10.

board for PC
model -B
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Figure 3.10:View of the data acquisition board PCI-4461

1

TTL input PFI_0 (SMB jack)
TTL input for an external trigger signail

TTL output AO_1 (BNC jack)

Synchronization puise for the signal of the internal function generator. The
cutput is only active with the corresponding option.

Analog output AO_0 (BNC jack)

Analog voltage output for the signal of the internal function generator of
the data acquisition board PCI-4461. The output is only active with the
corresponding option.

Analog input Al_1 (BNC jack)

Analog voitage input for the reference signal

Analog input Al_0 (BNC jack)

Analog voitage input for the vibrometer signal {Velocity)
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Back panel for  The back panel of the PC for the PSV models -M2 and -4 is shown in

the models FIGURE 3.11. The order of the pilug-in boards may vary from that shown in the
-M2 and -M4 picture.

A\

@)\@@\@i\@\'\

\ S 90308 °o°o 09050808030203 §
s §C3R559598858399855988559558 S
5 O
& e m
<€ 2
g
m ® é
H ]
=
ml P T
- /| i e}
/ =

d @/@/@/@/@/@//J/ @/@/@g,/ J

Figure 3.11: Rear view of the PC for the PSV models -M2 and -M4

1

Mains connection (socket for standard power cord)

The mains voltage input is designed to be a wide range input (refer also to
SECTION 3.2,

Mains switch

The mains switch disconnects the PC from the mains (position Q) and is
used to switch it off in case of danger.

CAUTION |

Danger from mishandling ! - Always connect up all connacting cables before
you swiich on the PC!

Connector MOUSE (6-pin circular jack)
Connector KEYBOARD (6-pin circular jack)

USB interface {Universal Serial Bus, type A)

Alternative connector for peripheral devices such as mouse, keyboard,
etc. or to connect the hardlock to release the software

Serial interface COM1 (9-pin Sub-D plug)

Parallel PRINTER connector (25-pin Sub-D jack)
Connector for the printer and the hardlock to release the software
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10

11

12

13

14

15

16

MONITOR connector (15-pin Sub-D jack)

Connecior NETWORK
For connecting up to an ethernet nefwork

USB interface (Universal Serial Bus, type A)

Connector for the USB cable from the junction box to control the PSV via
the software

Monitor connector (DVI jack)
Connector for an additional TFT monitor

Network connector
To connect the WLAN Access Point of the optional PSV-A-PDA

USB interface (Universal Serial Bus, type A)

Additional aiternative connectors for peripheral devices such as mouse,
keyboard, etfc. or to connect the hardlock to release the software

AV connector (S-Video jack)

Connector for the video cable from the junction box to transmit the video
signal

Connector ACQUISITION for the data acquisition (SCSI-lI type)

Connector for the acquisition cable from the junction box to transmit both
measurement and trigger signals

Air vents

CAUTION !

Danger from heat accumulation! - To ensure sufficient cooling, these
openings must kept free! The distance to the wall must be at least 50mm!

17

18

19

20

21

22

IEEE-1394 interface
MONITOR connector (DVI jack)
Video output (9-pin circular jack)

Instrument warning label
Label with technical data for the mains connection

Identification label

On the identification label you will find, among other things, the serial
number of the instrument,

Cooling fan

; CAUTION !
Danger from heat accumulation] - This opening must always be kept free to
ensure sufficient cooling! The distance to the wall must be at least 50mm|!
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Back panel for  The back panel of the PC for the PSV model -M2-20 is shown in FIGURE 3.12.
model -M2-20 The order of the plug-in boards may vary from that shown in the picture.
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Figure 3.12: Rear view of the PC for the PSV model -M2-20

1

Mains connection (socket for standard power cord)

The mains voltage input is designed to be a wide range input (refer also to
SECTION 3.2).

Mains switch

The mains switch disconnects the PC from the mains (position Q) and is
used to switch it off in case of danger.

CAUTION {

Danger from mishandling | - Always connect up all connecting cables before
you switch on the PC!

Connector MOUSE (6-pin circular jack)
Connector KEYBOARD (6-pin circular jack)

USB interface (Universal Serial Bus, type A)

Alternative connector for peripheral devices such as mouse, keyboard,
etc. or to connect the hardlock to release the software

Serial interface COM1 (9-pin Sub-D plug)

Parallel PRINTER connector (25-pin Sub-D jack)
Connector for the printer and the hardlock to release the software
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10

11

12

13

14

15

16

17

MONITOR connector (15-pin Sub-D jack)

Connector NETWORK
For connecting up to an ethernet network

USB interface (Universal Serial Bus, type A)

Connector for the USB cable from the junction box to control the PSV via
the software

Monitor connector (DVI jack)
Connector for an additional TFT monitor

Network connector
To connect the WLAN Access Point of the optional PSV-A-PDA

USB interface (Universal Serial Bus, type A)

Additional alternative connectors for peripherai devices such as mouse,
keyboard, etc. or to connect the hardlock {o release the software

AV connector (S-Video jack)

Connector for the video cable from the junction box to transmit the video
signal

Connectors ACQUISITION for the data acquisition (SMB jack)

Connectors for the acquisition and generator cable ACQ/GEN 20MHz
from the junction box PSV-E-401 to transmit both measurements and
control signals. You will find a description of the connectors of the data
acquisition board in the following section.

Connectors GENERATOR of the generator board (SMB jacks)

Connectors for the acquisition and generator cable ACQ/GEN 20MHz to
the junction box PSV-E-401 to transmit the signal of the internal function
generator. You will find a description of the connectors of the generator
board in the following section.

Air vents

CAUTION !

Danger from heat accumulation ! - To ensure sufficient cooling, these
A openings must kept free! The distance to the wall must be at least 50mm!

18
19
20

21

22

IEEE-1394 interface
MONITOR connector (DV} jack)
Video output (2-pin circular jack)

Instrument warning label
Label with technical data for the mains connection

Identification label

On the identification label you will find, among other things, the serial
number of the instrument.
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23 Cooling fan

CAUTION !

Danger from heat accumulation ! - This opening must always be kept free
to ensure sufficient cooling! The distance to the wall must be at least 50mm!

Data acquisition The connectors of the data acquisition board Spectrum MI.3025 for the

board for PC PSV-400-M2-20 are shown in FIGURE 3.13.
model -M2-20

/// 0
d @ & ®

Figure 3.13:View of the data acquisition board for the PSV modei -M2-20

1 Signal input Ch1 (SMB jack)
Signal input for the reference signal

2 Signal output Ck (SMB jack)

Output for the clock signal to synchronize the data acquisition board with
the generator board

3 Signal input Tr (SMB jack)
Signal input for an external trigger signal

4 Signal input Ch0 (SMB jack)
Signal input for the velocity signal
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Generatorboard The connectors of the generator board Spectrum MI.6030 for the
PSV-400-M2-20 are shown in FIGURE 3.14.

for PC model
M2-20
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Figure 3.14:View of the generator board for the PSV model -M2-20

1

Clock input Ck {SMB jack)

Input for the clock signal (Clock) to synchronize the generator board with
the data acquisition board

Signal input Tr (SMB jack)
Not active

Pulse output D1 (SMB jack)
Not active

Pulse output DO (SMB jack)
Synchronization pulse for the signal of the internal function generator

Signal output CHO (SMB jack)
Signal output of the internal function generator
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3.3.5 Scanning Head

Front panel

The front panel of the scanning head is shown in FIGURE 3.15.

<

O >

Figure 3.15: Front view of the scanning head

—

»N

W

Front lens of the video camera

The video camera is controlled via the software as described in your
software manual.

Mounting threads for the optional close-up unit PSV-A-410

The optional close-up unit is used for scanning small parts at short
distance (refer to SECTION A.2).

Drill holes for mounting the optional close-up unit

Rotary knob BEAM SHUTTER ON/OFF for the beam shutter

The apertures for the laser beam and the video camera are closed if the
rotary knob is turned counterclockwise until the mark points at OFF. Thus
also the laser beam is blocked.

WARNING !

Danger from faser light [ - Only open the beam shutier when you are making
measurements!

Laser beam aperture

Positioning and focusing the laser beam is controlied via the software
described in your software manual. The laser beam can also be
positioned and focused using the hand set PSV-Z-051 as described in
SECTION 5.5 and SECTION 5.6.
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Back panel

3-26

WARNING !

Danger from laser light! - Avoid looking directly into the laser heam with the
naked eye or with the aid of mirrors or optical instruments!

6

REMOTE CONTROL connectors for the hand set PSV-Z-051 (12-pin
circular jack)

The hand set is used for positioning and focusing the laser beam (refer to
SECTION 5.5 and SECTION 5.6).

The back panel of the scanning head is shown in FIGURE 3.16.

T

& Milylee  PSV-400
SCANNING HEAD

SIGNAL LEVEL EASER

L 10
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&)

// //
e

Figure 3.16: Rear view of the scanning head

N

w

5

Transport handle

Cover for the optional geometry scan unit PSV-A-420

The scanning head with geometry scan unit is described in detail in
SECTION A.1.

SIGNAL LEVEL display

The length of the bar is a measure of the amount of light scattered back
from the measurement surface.

LLASER LED

The LED lights up when the scanning head is connected up correctly to the
junction box and the laser is switch on (key switch on the controller is
turned to position 1). The LED indicates that the laser is active, even if the
beam shutter is closed (refer to SECTION 5.3).

Main connection (industrial-styie)
Connector for the umbilical cable to the junction box
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View from the The view from the bottom of the scanning head is shown in FIGURE 3.17.

bottom

=

Figure 3.17: Bottom view of the scanning head

1

Label for the front lens model
On this label, it is marked which front lens model is instailed.

Identification label

On the identification label you will find, among other things, the serial
number of the instrument.

Mounting threads M6

Using these two mounting threads, the scanning head can be mounted on
adapter plates, e.g. for mounting on the as an option pan-tilt stage PSV-A-
T11 (refer to SECTION 3.4.1) or the optional test stand PSV-A-T18 (refer o
SECTION A.3). You will find the dimensions of the mounting threads in the
technical drawing in SECTION 7.5.

NOTE !

The mounting screws of the scanning head have {o be tighten only with
maximal 1.5Nm otherwise the laser beam interference of the scanning head
with the geometry scan unit can be disturbed!

Mounting thread 1/4"-20UNC

Using the mounting thread, the scanning head can be mounted on stable
camera tripods with thread basing on inch-system.

Mounting threads for hexagonal quick release plate

Using these mounting threads, the hexagonal quick release plate can be
mounted on the scanning head, e.g. for mounting the scanning head on
the tripod with fluid stage VIB-A-TO02.
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6 PAN-TILT connector for the optional pan-tilt stage (7-pin circular jack)

Connector for the connecting cable to the optional pan-tilt stage PSV-A-
T11 to control the pan-tilt stage via the software

3.4 Installation

3.4.1 Assembly

Scanning head

3-28

The scanning head is mounted on either a tripod with fluid stage (VIB-A-T02)
or a heavy duty tripod with motorized pan-tilt stage (PSV-A-T11, optional).
The heavy duty tripod can also be mounted on a trolley {on request). The
scanning head mounted on the tripod with fluid stage is shown in FIGURE 3.18.

Figure 3.18:Scanning head mounted on the fripod with fluid stage

Before attempting to mount the scanning head, all locking mechanisms of the
trolley and the tripod, particularly screws, should be checked to make sure
they are tight. A loose screw may cause the stand to be unstable and possibly
coliapse.

NOTE !

It is best to carry out the following assembly when someocne is there to help
you!
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Tripod with fluld  If your PSV is equipped with a tripod with fluid stage, you must proceed with
stage the assembly as follows:
(VIB-A-T02)
1. Assemble the tripod as described in the assembly instructions provided by
the manufacturer MANFROTTO.

2. Then mount the fluid stage as described in the assembly instructions
providing by the manufacturer MANFROTTO.

3. Open the locking mechanism on the fluid stage by simultaneously
pressing the safety latich and opening the safety lever.

4. A suitable hexagonal quick release plate has been pre-mounted on the
scanning head. Use this plate to position the scanning head on the fluid
stage.

The safely lever clicks into place automatically.

5. Ensure that the quick release plate is attached all the way around. This
needs to be done before the scanning head is ready to use.

6. Whenever you want to remove the scanning head from the fluid stage,
one person should hold the scanning head while the second person opens
the safety lever.

7. Keep the assembly instructions for the tripod and the fluid stage in a safe
place.

Tripod with pan- If your PSV is equipped with a heavy duty fripod with pan-tilt stage, you must
filt stage PSV-A- proceed with the assembly as follows:
T11 (optional)
1. Unpack the pan-tilt stage and check it for external damage (scratches,
loose screws, efc.).

2. Check the contents of the assembly kid:

1 Adapler plate with 3 Allen screws M6x 16

1 Connector box with 4 Allen screws M8x40

3 Allen screws M8x 16 with washers

1 Mounting plate with 2 countersunk screws M6x 16
2 Allen screws M6x 16 with washers

1 Allen key size 4mm

1 Allen key size 5mm

1 Allen key size 6mm

.. CAUTION !
banger from mounting error! - Make sure that the screws are always

tightened to ensure that the system is both stable and functions accurately!

3. Attach the mounting plate on the underside of the scanning head with
2 countersunk screws M6x16. To do this use the Allen key size 4 mm.

CAUTION |

Danger from mounting error! - Make sure that the mounting plate is
correctly aligned! The FRONT labeled side of the plate has to be mounted in
the direction of the front pane! of the scanning head as shown in FIGURE 3.19.
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Figure 3.19:Fixing the mounting plate on the scanning head

4.

10.

Unpack the tripod and check it for external damage (scratches, loose
screws, etc.).

Assembie the tripod as described in the assembly instructions provided by
the manufacturer MANFROTTO.

Unscrew the protective cap, which is located on the centrai thread of the
tripod.

Unscrew the rotary handle on the underside of the tripod and remove the
fripod plate.

Unscrew the three set screws on the underside of the tripod plate and
keep the set screws in case you may need them at a later date.

Put the tripod plate onto the tripod again and screw in the plate with the
rotary handle. Pay attention to the horizontal alignment of the tripod plate.

Now mount the adapter plate on the top of the tripod plate using 3 Allen
screws M6x 16 as also shown in FIGURE 3.20.

NOTE !

Ensure that the rotary handle on the underside of the tripod is always
tightened securely.
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4 Allen screws M8 x 40

Connector box

3 Allen screws M6 x 16
Adapter plate

Tripod plate

Rotary handie

Figure 3.20:Mounting the pan-iilt stage on the tripod

11. Screw the connector box on the adapter plate using 4 Allen screws
M8x40. To do this use the Allen key size 6mm.

12. Fix the pan-tilt stage on the connector box using 3 Allen screws M8x 16
and the washers,

CAUTION |

: Danger from mounting error! - Make sure that the pan-tilt stage is aligned
f o correctly to the connector box! The FRONT labeled sides have to be mounted

in the same direction.

13. Then mount the scanning head with its mounting plate on the pan-tilt

stage using 2 Allen screws M6x16 and the washers as shown in
FIGURE 3.21.

CAUTION |

Danger from mounting error! - Make sure that the FRONT labeled sides of
the compeonents are mounted in the direction of the front panel of the scanning
head!
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Scanning head

Mounting plate

2 Allen screws M6 x 16

Pan-tiit stage

Connector box
Adapter plate

N\ Tripod

Figure 3.21: Mounting the scanning head on the pan-tilt stage

14. Keep the assembly instructions for the fripod and the pan-tilt stage in a
safe place.

For cabling the pan-tilt stage, refer to SECTION 3.4.2,
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System cahinet
PSV-A-010
(optional)

3 First Steps

You receive the system cabinet PSV-A-010 with all system components ready
assembled and cabled. To unpack the system cabinet, please proceed as
follows:

1. Remove the ramp from the packaging and place it in front of the pallet.

2. Open the packaging, remove the whole damping material from inside and
pull carefully the packaging upward away.

You can now roll the system cabinet of the pallet via the ramp and move
of to the measurement location.

For the assembly of the system cabinet you proceed as follows:

3. Set up the system cabinet at the measurement location.

CAUTION !

Danger from mishandling! - Do not split up the two component parts without
removing the cabling inside !

Inside the front cover of the PSV-A-010, there are holding devices for the
keyboard and the mouse. Inside the rear cover, there are holding devices for
one umbilical cable.

4. Demount the front cover of the PSV-A-010 with great care by turning up
the wing screws and unfixing the locking hooks.

5. Open the velcro strips inside the front cover and put the keyboard and the
mouse onio the table top.

6. Demount the rear cover of the PSV-A-010 with great care by turning up
the wing screws and unfixing the locking hooks.

7. Open the velcro strips inside the rear cover and take out the umbilical
cable.

Demount the front and the rear cover of the PSV-A-010 system cabinet
extension by turning up the wing screws and unfixing the locking hooks.

CAUTION !

Danger from heat accumulation! - The PSV may only be opegrated in the
system cabinet if the cover of the system cabinets are removed. Otherwise
generation of heat can cause damages in the instruments!

The position of the individual system components in the cabinet is shown in
FIGURE 3.22,
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Monitor
Keyboard Mouse
Junction Box = |ef Hitd
, il i
Controller 3§ ]
:
PC [

Figure 3.22:Position of the PSV components in the system cabinet

if you order the system cabinet, you have to build in the components yourself
into the system cabinet. To do so, proceed as follows:

1. Undo the housing feet of the system components and keep the housing
feet and the screws in a safe place.

2. Place the PC at the botiom.
3. Insert the controlier above the PC.

4. If applicable, insert the optional junction box PSV-E-408 instead of the
ventilation sheet above the controller {only PSV-400-H4).

5. Insert the junction box PSV-E-401 above the coniroller.
6. Fix ali front panels with the screws provided.

7. Place the other system components on the system cabinet as shown in
FIGURE 3.22.

All system components should be mounted correctly now. Carry out the
cabling of the system components as described in SECTION 3.4.2,
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3.4.2 Cabling

Controller <=>
junction
hoxPSV-E-401

Reference
signal

3 First Steps

CAUTION |

Danger from electrical current! - Always unplug all BNC cables from the
front panel before you close the system cabinet with the cover!

The individuals steps on cabling the PSV are described in the following. The
complete cabling is also shown in FIGURE 3.23 to FIGURE 3.29. All connections
must be easy to plug in. If not, check the plugs for bent contact pins to avoid
serious damage being incurred. Secure the connections correspondingly.
Should any problems occur in cabling, please contact your local Polytec
representative.

CAUTION !

Danger from mishandling! - Always connect all components to each other
before plugging in the mains cables!

1. To operate the controller via the software, plug the R8-232(X) cable into
the Sub-D connector RS 232 on the back of the controller and into the
Sub-D connector RS 232 on the back of the junction box.

2. Plug the interferometer cable into the Sub-D jack SENSOR on the back
of the controller and into the Sub-D jack OFV-5000 on the back of the
junction box.

3. For transmission of the velocity signal, plug the BNC cable into the BNC
jack VELOCITY QUTPUT on the front of the controller and into BNC jack
VELO on the front of the junction box.

4. If required, connect the reference signal to the BNC jack REF 1 on the
front of the junction box.

5. PSV-400-H4, -M4: You can connect up to two additional reference signal
to the BNC jack REF 2 and REF 3 on the front of the junction box. Digital
function generators, for example the HP 33120, should be preferably
connected to REF 1 to prevent Alias effects.
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@

If required, connect the external trigger signal to the BNC jack TRIG IN on
the front of the junction box.

External trigger

Internalfunction 7. If required, the signal of the internal function generator is available at the
generator BNC jack SIGNAL 1 on the front of the junction box (optional for PSV-400-
B .

).

8. PSV-400-H4: If required, three additional signals of the internal function
generator are available at the BNC jacks SIGNAL 2 to SIGNAL4 on the
front of the junction box.

9. If required, the synchronization puise of the generator signal is available

at the BNC jack SYNC on the front of the junction box (optional for PSV-
400-B).

Acoustic gate 10. If applicable, connect the as an option acoustic gate unit PSV-A-430 to
unit the BNC jack GATE IN on the back of the junction box.
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JUNGTION BOX ACOUSTIC GATE UNIT

PSV-E-401
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Figure 3.23:Cabling of the controlier
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Junction box
PSV-E-401 <=>
scanning head

Junction box
PSV-E-401 <=>
PC
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1.

12.

13.

The umbilical cable has both a jack with a straight cable exit and a jack
with a cable exit on the side. The cabling can be selected freely
depending on the way the scanning head has been mounted. Plug the
Umbilical cable into the industrial-style connector SCANNING HEAD on
the back of the junction box and into the industrial-style connector on the
back of the scanning head.

To control the PSV via the software, piug the USB cable into the USB
interface on the back of the junction box and into the USB interface on the
back of the PC.

Plug the $-Video cable into the BNC jack S-VIDEO on the back of the
junction box and via the adapter cable into the circular jack AV on the
back of the PC.

CAUTION !

Danger from mounting error| - Plug in the SCSI connector with great care
at the right angles so as not to damage them!!

14.

15.

16.

17.

18.

PSV-400-H4: Plug the acquisition cable Acquisition into the SCSI
connector ACQUISITION BOARD on the back panel of the junction box
and into the appropriate BNC jacks ACQUISITION (A1_3, Al_2, Al_1 and
Al_0) and SMB jack (PFI_0)} on the back of the PC.

PSV-400-B: Plug the acquisition cable Acquisition into the SCSI
connector ACQUISITION BOARD on the back panel of the junction box
and into the appropriate BNC jacks ACQUISITION (AO_1, AO_Q, Al_1
and Al_0) and SMB jack (PF1_0) on the back of the PC.

PSV-400-H4, -B: Plug the Generator cable into the connector
GENERATOR IN on the back of the junction box and into the SCSI
connector GENERATOR on the back of the PC.

PSV-400-M2, -M4: Plug the acquisition cable Acqguisition into the SCSI
connector ACQUISITION BOARD on the back panel of the junction box
and into the SCSI connector ACQUISITION on the back of the PC.

PSV-400-M2-M20: Plug the acquisition and generator cable ACQ/GEN
20 MHz into the connector GENERATOR [N on the back of the junction
box and into the corresponding SMB connectors ACQUISITION and
GENERATOR on the back of the PC.

NOTE !

When cabling, pay atiention to the designations of the cable ends of the
acquisition and generator cable ACQ/GEN 20MHz! Thereby the cable end
ACQ-CHO is plugged into the CHO jack of the data acquisition board and the
GEN-CHO is plugged Into the CHO jack of the genarator board.




PC

3 First Steps

19. Connect the keyboard fo the circular jack KEYBOARD on the back of the
PC.

20. Connect the mouse to the circular jack MOUSE on the back of the PC.

21. Connect the monitor cable to the monitor and to the jack MONITOR on the
back of the PC,
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22. PSV-400-M2-20: Plug the SMB-SMB connecting cable into both SMB
connectors Ck of the data acquisition board ACQUISITION and of the
generator board GENERATOR on the back of the PC.

23. PSV-400-H4: Plug the optional acquisition cable Acquisition into the
SCSI connector ACQUISITION BOARD on the back panel of the optional
junction box PSV-E-408 and into the appropriate BNC jacks
ACQUISITION PSV-E-408 (Al_3, Al_2, Al_1 and Al_0) and SMB jack
(PFI1_0) on the back of the PC.

NOTE !

Please pay attention that there are two data acquisition board installed in your
PC. Connect the junction box PSV-E-408 only to the connectors
ACQUISITION PSV-E-408 as you obtain unusable data!

24, Plug the USB cable into the USB interface on the back of the junction box
and into a USB interface on the back of the PC.
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Figure 3.28: Cabling of the junction box PSV-E-408

25, If required, connect the hand set PSV-Z-051 on the circular jack REMOTE
CONTROL on the front of the scanning head.

. CAUTION !
Danger from mishandling! - Connect the hand set PSV-Z-051 only when the

controller is swilched off.

28. If applicable, plug the network cable of the WLAN Access Faint into the
left of the two jacks NETWORK on the back of the PC to operate the
optional hand set PSV-A-PDA.
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27. If applicable, plug the Scanning Head cable of the connector box of the
optional pan-tilt stage PSV-A-T11 into the circular jack PAN-TILT on the
underside of the scanning head.

28. Plug the Pan-Tilt connecting cable from the connector box of the pan-ilt
stage into the circular jack on the pan-tilt stage.
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¥

——+®i

o3

)
5o

Figure 3.29: Cabling of the scanning head

Mains
connection

To prevent ground loops, connect all mains cables of the measurement
system to the same earthed socket.

29. Connect up all components (controller, junction box, PC and monitor) with
the mains cables to a muliiple socket.

30. Connect up the multiple socket with the extension cable to an earthed
socket.

31. If applicable, connect the plug-in power supply to the junction box PSV-E-
408 and to the same multipie socket.

32. if applicable, connect the mains cable to the back of the WLAN Access
Point of the optional hand set PSV-A-PDA and to the same muitiple
socket.

33. If applicable, connect up the mains cable on the connector box of the pan-
tilt stage and to the same muitiple socket.

CAUTION !

Danger from mishandling I- Always check the setiing of the voltage selector
on the connector box of the pan-tilt stage before connecting to the mains!

The PSV is installed completely now. Carry out a functional test as described
in SECTION 3.5.
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3.5 Functional Test

Preparing

Switching on

3-46

For an initial functional test of the PSV, you proceed as follows:

1.
2.

Install and cable the PS5V as described in SECTION 3.4.

Please ensure that the key swiich on the controller is in position O and
that the beam shutter on the scanning head is closed (positions OFF).

Position the scanning head roughly such as that its laser beam aperture
points to the test surface.

Switch the controller on by turning the key switch to position |.

The LED POWER on the front of the confrolfer lights up. Providing all
connecting cables have been installed correctly, the LED POWER on the
front of the junction box and the Lep LASER on the scanning head light
up. Laser light is not yet emitted as the beam shutter is stilf closed.

Switch on the PC, start the PSV software and change to the Acquisition
Mode as described in your software manual.

On changing to the Acquisition Mode, controf of the system by the
software is activated. If you want change the seltings on the front panel
of the controller, you receive an appropriate message on the controller
{keyboard is locked by interface control).

Before now opening the beam shutter, remember the information on laser
safety provided in SECTION 1.2!

Open the beam shutter on the scanning head.
The laser beam is now emitted from the scanning head.



Test

Direction
convention
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8. Test the function of the scanning head {position and focus of the laser
beam, zoom and focus of the video camera, optional movement of the
pan-tilt stage}, as described in your software manual.

9. Put a matt white test surface such as a piece of paper, at approximately
50cm from the front panel of the scanning head in the heam path.

10. Focus the laser beam on the test surface.

The signal level display will light up to show that the scanning head and
the input section of the controller are working correctly.

if this functional test was successful, you can now make measurements with
the PSV as described in CHAPTER 4 and CHAPTER 5. Remember that the PSV
reaches its optimal properties after a warm-up period of approx. 20 minutes.

If your PSV does not perform as described above, read through the

information on fault diagnosis provided in CHAPTER 6, if necessary, contact
your local Polytec representative.

The following direction convention applies to the oufput signals:
A movement towards the scanning head is seen as being positive. In this

case the velocity output supplies a positive voltage and the displacement
output an increasing voltage.
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4 Making Measurements

Data acquisition and storage for the PSV is fully controlled via the software. A
live video image of the object is displayed on the monitor and automatic scan
sequences are defined directly on the live video image of the object. All
acquisition properties are set in the software. For evaluation, the acquired
data is overlaid directly onto recorded video image. Data can also be exported
to various software packages e.g. for modal analysis.

4.1 Start-up the PSV

To make a measurement with the PSV you proceed as follows:

Setup 1. Please ensure that the key switch on the controller is in position O and
that the beam shutter on the scanning head is closed.

2. Position the scanning head roughly such as that its laser beam aperture
points in the direclion of to the object to be measured. If possible set the
scanning head up at an optimal stand-off distance to the object to be
measured. You will find information about the optimal stand-off distance in
SECTION 4.3.

Switching on 3. Switch the controller on by turning the key switch to position I,

The LED POWER on the front of the controller lights up. Providing all
connecting cables have been installed correctly, the LED POWER on the
front of the junction box and the LED LASER on the scanning head light
up. Laser light is not yet emitted as the beam shutter is still closed.

NOTE [

Remember that the PSV reaches its optimal properties after a warm-up period
of the laser of approx. 30 minutes.

4. Switch on ali optional peripheral device.

5. Switch on the PC, start the PSV software and change to the Acquisition
Mode as described in your software manual.

On changing the Acquisition Mode, control of the PSV via the software
is activated. Making changes on the settings of the controller are now
only possible via the software.

6. Before now opening the beam shutter, remember the information on laser
safety provided in SEcTiON 1.2,

7. Open the beam shutter on the front of the scanning head.
The laser beam is now emifted from the scanning head.
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Measuring

8. Data acquisition is now fully controlled by the software. Once the laser
has warmed up you can setup the software, set the optics, define the scan
points and make measurements as described in your software manual.

4.2 Selecting Suitable Settings

4.2.1 Measurement Range

4-2

When selecting the measurement range, first of all take the expected
maximum values on the measurement for the velocity and vibration frequency
or acceleration into account. The respective values are given in the
specifications (refer to SECTION 7.2.4).

many applications are covered by the 10"V measurement range of the
decoder VD-03 or VD-04 respectively. It should therefore be selected for
initial measurements with the PSV. A higher measurement range only has to
be selected in the LED OVER on the front of the controller lights up
permanently at scan pcints to high amplitude.

Generally it is advisable to use the lowest possible measurement range for
minimizing the noise and maximizing the optical sensitivity.

If either the positive or the negative limit of a measurement range has been
reached, the overrange is indicated in the software and the LEp OVER in the
field VELOCITY lights up on the front of the controller. As a general rule, you
should then select the next highest measurement range. However please
note that this LED is activated even by very brief overloading which can also
be caused by noise spikes. In such cases you can continue to use the velocity
measurement range as long as it is suitable for the ampiitude of the wanted
signatl. Observing the signal in the time domain will provide clarification on
this.

With extremely weak optical signal, permanently lighting up of the LEpD OVER
can be caused by noise due to the system. If switching on the tracking filter
(refer to SECTION 4.2.3) can not eliminate this problem, you should check
whether

» the laser is focused optimally
» the surface can be treated for optimizing the reflectivity or
» the stand-off distance can be changed.
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4.2.2 Description of the Decoders

VD-03

VD-08

VvD-09

VD-07

In contrast to the OFV-5000 controller used as a single point measurement
device, with the PSV properties of the decoder are limited by the data
acquisition. In the following sections only the standard PSV configurations are
described. If you are using other decoders in the controller, please see your
OFV-5000 controller manual on this.

With its frequency range between 0.5Hz and 1.5MHz and a maximum velocity
of 10m/s, the VD-03 has got the largest operating range and can be used
universally.

The digital velocity decoder VD-08 offers in addition to the broadband
decoder VD-03 eight high-resolution measurement ranges for the frequency
range of OHz to 25kHz. With its lower cutoff frequency of 0Hz, the VD-08 is
also suitable for acquiring uniform or intermitted movements, or extremely
low-frequency vibrations respectively.

The decoder is optimized for the highest optical sensitivity. Therefors, if can
detect signal from the surface with low backscattering. This applies especially
for three lower measurement ranges.

In the case of measurement task with analysis of the vibration phase,
attention should be paid to the signal delay (frequency-dependent phase
shift). Due to the digital signal processing {(DSP technology) the signal delay
is longer than for analog decoders. The phase error caused by the time delay
will be corrected automatically in the frequency spectra by the PSV software
(not in the time domain).

Out of all avaitable velocity decoder, the digital decoder VD-09 has with its
frequency range of O0Hz to 2.5MHz and a maximal velocity of 10m/s the
largest operating range and can be used universal. As its lower cutoff
frequency is OHz, the VD-09 is also suitable in all measurement ranges for
acquiring uniform or intermittent movements or extremely low-frequency
vibrations respectively.

The digital velocity decoder VD-07 offers in addition to the broadband
decoder VD-09 six high-resolution measurement ranges for the frequency
range of OHz to 350kHz. With its lower cutoff frequency of OHz, the VD-07 is
also suitable for acquiring uniform or intermitted movements, or extremely
low-frequency vibrations respectively.

The decoder is optimized for the highest optical sensitivity, Therefore, it can
detect signal from the surface with low backscattering. This applies especially

to the measurement range 1%%/V.

In the case of measurement task with analysis of the vibration phase,
attention should be paid to the signal delay (frequency-dependent phase
shift). Due to the digital signal processing (DSP technology) the signal delay
is longer than for analog decoders. The phase error caused by the time delay
will be corrected automatically in the frequency spectra by the PSV software
{not in the time domain).
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VD-04

VD-05

4-4

With its frequency range from 0.5Hz to 250kHz and a maximum velocity of
10m/s, the velocity decoder VD-04 covers the whole operating range of the
PSV-400-B and reaches excellent resolution values of the measurement

range of 107%/V.

The VD-05 is designed for high-frequency applications up to 10MHz using the
PSV-400-M2-20 and is instalied optionally as an auxiliary decoder. Bacause
of its slightly inferior properties due to the principle it works on, it shouid only
be used when the frequency range of the main decoder is insufficient.

Output signal: The output signal of the VD-05 is available at the BNC jack
QUTPUT in the field AUXILIARY on the front of the controller. The oufput
voltage swing of the decoder is nominal +5V according to the full scale values
+0.5m/s or £2.5m/s respectively of the two measurement ranges. However,
there is a headroom of about 20% so that peak values up to 3m/s can be
acquired without distortions.

With signal frequencies in the megahertz range, the load connected to the
signal output can have great influence on the frequency response and the
signal shape. The signal output of the VD-05 is designed for connecting high-
impedance inputs of oscilloscopes or other signal acquisition systems (mostly
TMQ || 47 pF) via a BNC cable with a maximum length of approx. 1.5m. If you
attach considerably longer cables, it is recommended to use a 50Q-
termination at the input of the subsequent instrument. In this case, the scaling
factors of the measurement ranges change to 200™%/V or 1000/
respectively, while the oufput swing decreases to £3V.

Measurement range: Two measurement ranges with scaling factors of

1007%/V and 500%"/V are available for adapting to the vibration amplitude. If
either the positive or the negative boundary of a measurement range has
heen reached, the LED OVER in the field AUXILIARY lights up on the front
panel of the controller. Due to the headroom of about 20% you can also make
measurements as long as no clipping is observed in the output signal.

Filter: The filters installed in the controller (tracking filter, low pass filter, and
high pass filter} do not have any effect on the signals of the VD-05.

Noise: Due {o the wide frequency bandwidth of the VD-05 you can observe,
even with good backscattering properties of the object, relatively high
background noise in the time domain. This background noise limits the
amplitude resolution for transient motions. it can only be reduced by using
average procedures in the subsequent signal processing. With signal
evaluation in the frequency range, spectral resolutions of some %/Jﬁ; can

be reached. For physical reasons, the noise power density increases with
frequency on velocity decoding. For technical reasons, single noise peaks
can occur at determined frequencies in the specified limits of the spurious
free dynamic range.

Impulse acquisition: The velocity decoder VD-05 can also be used for
acquiring pulse-shaped signals. As in al systems with limited bandwidth,
typical waveform distortions are generated which should be taken into
consideration when evaluating the measurement results. In particular, rise
time limitations for signals with a short ramp response and amplitude decay
for square wave signals due to the absent DC capability of the decoder can
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be expected. For signals with a steep rising edge, transient effects with
overshooting of the amplitude up to 20% are also induced by technical
reasons. As a ruie of thumb, square wave signals should not exceed a
repetition rate of about 2MHz.

The displacement decoder DD-300 can be installed instead of the velocity
decoder VD-05. The displacement decoder DD-300 is designed especially for
ultrasonic applications. Using this decoder you can measure vibrations and
pulse-shaped motions in a frequency range of 30kHz to 24 MHz with
amplitudes up to 75nm (peak to peak). Thus the DD-300 is particularly
suitable for amplitude measurements on ultrasonic transducers, for acquiring
ultrasonic pulses or acquiring transient motion in the area of microsystems
technology.

Furthermore, a special technique which suppresses vibrations in the acoustic
range allows you to make measurements in a normal technical environment.
Thus the measurement object under investigation does not have to be
vibration-isolated.

NOTE |

Background vibration that exceed a velocity amplitude of approx. 10mm/s
{peak) can result in interferences in the measurement signal.

To use the displacement decoder DD-300 for scanning, you need specific
experience and therefore it is not designated for the PSV-400-M2-20 by
default.

Output signal: The output signal of the DD-300 is available at the BNC jack
OUTPUT in the field AUXILIARY on the front of the controller. The input
impedance of the system connected has to be 50Q.

Measurement range: Selecting a suitable measurement range is not
necessary for the DD-300, as this decoder has only one measurement range
available (50nm/{V},

Low pass filter: The filtered output signal of the DD-300 is available at the
BNC jack UNIVERSAL in the field AUXILIARY on the front of the controller.
The bandwidth of this signal is limited to 2MHz. Using the filtered signal is
recommended during signal analysis in the time domain {o suppress noise if
the signal bandwidth allows this.

Tracking filter: The tracking filter has no influence on measurements with the
DD-300.

Noise: The displacement resoclution which can be obtained in the time domain
depends directly on the RMS value of white noise. The noise voltage,
however, is generally relative high caused by the broad bandwidth of the DD-
300. Therefore accurate focusing of the laser in the scanning head is very
important when measuring amplitudes in the nanometer range. We
recommend observing the displacement signai on an oscilioscope while
optimizing the focus to attain a noise level as low as possible. On highly
reflecting surfaces the signal level display is not sufficient to find the optimal
focus position.
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Two noise peaks with an amplitude of some millivolts can be observed in the
spectrum of the measurement signai in the frequency range from 8 MHz to
25MHz when making measurements on reflective surfaces These noise
peaks come from the high-frequency fluctuation of the laser power and can
not be suppressed electronically. Their exact frequency depends on the
scanning head but it is almost constant. It can thus be easily distinguished
from the proper ultrasonic signal.

Plsase note that in a 20MHz bandwidth the noise level is a few millivolts,
even in optimal measurement conditions. As a result, when using an
oscilloscope, it is not possible to detect amplitudes below a threshold of
approx. 0.2nm.

Otherwise, with good optical signal quality and a resolution bandwidth of just
10kHz, the noise level will not exceed 0.2mV (RMS), which is equivalent to
an amplitude of 0.01nm. it is thus evident that in order to detect very small
amplitudes it is always useful to limit the bandwidth, e.g. by using narrow-
band filters, a spectrum analyzer or a lock-in amplifier. Using a spectrum
analyzer, amplitudes of less than 1pm can be measured in optimum
conditions.



4 Making Measurements

4.2.3 Tracking Filter

The tracking filter can be used to improve the signal-to-noise ratio of the input
signal of the scanning head. This filter bridges brief dropouts, which always
occur due to the speckle nature of the light scattered back from the object.

When using the digital velocity decoder VD-07/VD-08, the tracking filter does
not have any effect.

To reduce noise, the tracking filter works best with a high time constant
(corresponds to the tracking filter mode Slow in the software and on the
display of the controller). With a high time constant however, it may not he
possible to track highly dynamic signals. In such cases, the tracking filter
either needs to be switched to the mode fast (Fast) or needs to be switched
off (Off). You will need to ascertain the most favorable setting for the tracking
filter from case to case or estimate it based on the range diagram in

FIGURE 4.1. The range diagram shows the performance data with the dynamic
limits for both settings of the tracking filter, plotted over the frequency.
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Figure 4.1: Schematic range diagram of the tracking filter

It is characteristic for the maximum velocity to decrease with increasing
frequency. The maximum velocity of 10m/s can only be processed up fo a
cutoff frequency of 160Hz or 940Hz respectively. Above that, the velocity limit
transforms into an acceleration limit, i.e. the cufoff velocity decreases
inversely proportionally to the frequency. For velocities below 150mm/s or
300mm/s, acceleration no longer have to be taken into account.

For the setting of the tracking filter, the range diagram in FIGURE 4.1 can be
summarized with the following rules of thumb:

* Use the tracking filter in connection with analog velocity decoders to
improve the signal noise if the optical signal is weak. If you have a good
optical signal, it is not possible for the tracking filter to improve the signal-
to-noise ratio for physical reasons. It should be switched off if detrimental
effects can be identified.
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o Select the mode slow (Slow) or fast {(Fast) depending in the signal
dynamics. Below a certain velocity, no dynamic limits need fo be
observed. For this reason, In the lower measurement ranges to 10%5%/V
as a general rule you can set the tracking filter mode slow (Slow).

* For average velocities and frequencies, the acceleration limits of the
tracking filter have to be taken into account. The optimum setting has to
be found using the range diagram. If the velocity or acceleration limit of
the tracking filter is exceeded, then the internal phase-locked loop loses
lock. The signal is then distorted roughly. In FIGURE 4.2 you can see an
example of an oscillogram showing a distorted signal. Signal A shows a
sinusoidal velocity signal with the tracking filter switched off. Signal B
shows the same signal with the tracking filter switched on in mode slow
{Slow). Here the tracking filter is at the limit of losing lock and the signal is
partially being distorted.
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Figure 4.2: True velocity signal {A) and signal when the tracking filter loses lock {B)

« For particularly precise measurements, the tracking filter should be
switched off because it can cause amplitude errors of up to 0.5dB. For
measured frequencies which are above 300kHz, as a general rule the
tracking filter should always be switched off (Off).
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4.2.4 Low Pass Filter

The controller is equipped with adjustable, analog low pass filters so that the
measurement bandwidth of velocity acquisition can be adapted to suit the
respective application. When presenting the measurement signals in the fime
domain, the signal-to-noise ratio can be improved by limiting the bandwidth to
the necessary measure. For analysis in the frequency domain using PSV
software, low pass filters only play a secondary role. Here you can reduce
overloading the data acquisition system which has been caused by noise
effacts.

You can select analog low pass filters with the cutoff frequencies 5kHz,
20kHz, 100kHz or 1.5MHz for the output signal of each selected velocity
decoder, Using the setting Off the filter will be switched off, so that the
frequency bandwidth is only determined by the velocity decoder.

Apart from that, the digital decoders VD-07 and VD-09 offer you the possibility
of limiting the bandwidth with a digital low pass filter. Some measurement
ranges are available twice (refer to SECTION 7.2.4): Once with the maximal
frequency and once with the reduced frequency (labeling "LP"). As digital
filters have significantly better properties than analog filters, a bandwidth
limitation should always be carried out with this digital low pass filter first
when using this digital decoder. For further bandwidth limitations you can then
use the analog low pass filters in addition.

For precise measurements, you must pay attention to the frequency response
of the analog low pass filter. The corresponding diagrams for amplitude
frequency response, amplitude error and phase frequency response of the
low pass filter used can be found in SecTiON C.1. The frequency response of
the digital low pass filter in the VD-07 and VD-09 can be ignored as digital
filters have got almost ideal properties. If you do not wish any additional
bandwidth limitation, set the low pass filter in connection with the broadband
decoder VD-09 in position Off, with all other decoders in position 1.5MHz.
Under these condition the specifications for amplitude and phase frequency
response of the respective decoder are valid and the automatic phase
correction attains their complete accuracy.

NOTE |

The PSV software corrects the time delay of the velocity decoder, but not that
of the analog low pass filter. Therefore, switch off the high pass filter when
scanning, if you use the broadband decoder VD-09. In connection with all
other decoders please choose the setting 1.5MHz.

The analog low pass filters have got third order Bessel characteristics. The
phase linearity from the frequency zero to the cutoff frequency is
characteristic for this filter type, i.e. the phase shift increases in proportion to
the frequency. However these filters cause amplitude errors in the pass band
which can be roughly estimated:

+ Up to 40% of the cutoff frequency, the amplitude error is less than —5%.

* In the range up to 70% of the cutoff frequency, the amplitude error
increases to approx. —15%.

» The upper 30% of the pass band should only be used for orientation
purposes. At the cutoff frequency set for the filter, the amplitude error is —
3dB (approx. —30%).
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The phase shift increases in proportion to the frequency from close to zero
degrees at a few hertz to approx. —100 degrees at the cutoff frequency (refer
to FIGURE C.3). Due to the linear phase frequency response, the filter
transmits pulses optimally, as all frequencies in a complex wave are subjected
to the same time delay. The shape of the pulse is thus not distorted, but
merely subjected to a time delay.

An additional time delay is caused by the velocity decoder. This depends on
the velocity decoder used and also on the velocity measurement range and is
several micro seconds long. The resulting phase shift A® can be estimated
using the following simple equation:

AD = 100D-ff~+pD~f Equation 4.1

f...frequency in kHz
f....cutoff frequency of the low pass filter in kHz
Pp..-frequency-dependent phase shift of the decoder in °/kHz
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4,2.5 High Pass Filter
The high pass filter is the type 4th order Butterworth. Here it can be said:

o At 150Hz (1.5 times cutoff frequency f,} the amplitude error is approx.
-5%.

+ The high pass filter generates a frequency-dependent phase shift (refer to
SECTION C.2). Switch off the high pass filter if this phase shift is not
desired.

NOTE |

The high pass filter is only suitable for single point measurements. During
scanning, the high pass fiiter causes signal distortion due to the longer
settling time after moving the mirrors. Therefore, switch off the high pass
fliter when scanning!

Apart from that you should note that when the high pass filter is switched on,
it may no longer be possible to identify in the measurement signal when the
decoder has heen overloaded as the corresponding frequency is filtered out.
Measurement tasks in which a small measurement signal is superimposed by
a low-frequency machine vibration with a large amplitude are particularly
critical. The measurement signal is then significantly distorted and the LED
OVER in the field VELOCITY on the front of the controller is continuously lit
up, even though overloading is not apparent in the measurement signal. In
such cases, you should proceed as follows:

1. First of all, switch the high pass filter off and set the smallest
measurement range which is not overioaded for the decoder you have
selected.

2. Then switch on the high pass filter for the actual measurement.

Please note that the LED OVER can also be lit up due to brief noise spikes
resulting from inferior optical signal quality. This effect does not yet lead to
signal distortions by overloading the decoder.

The complete amplitude frequency response of a 4th order Butterworth high

pass filter as well as the corresponding amplitude error and phase frequency
response are shown in SECTION C.2,
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4.3 Setting Optimal Stand-off Distances

4.3.1 Coherency between Stand-off Distance and Visibility Maximum

Visibility
maxima

Stand-off
distance

The light source of the PSV is a helium neon laser. These are multi-mode
lasers in which, depending on the laser cavity length, one or a maximum of
two modes can exist. The laser cavity length can vary caused by small
changes in temperature. Thus the laser changes between the one-mode state
and the two-mode state. If two modes exist, interference effects cause the
intensity of the resulting optical signais varying periodically with the stand-off
distance.

The diagram in FIGURE 4.3 shows the signal level depending on the stand-off
distance. In this special case of having two modes with equal magnitude
(black line), you have the strongest loss of signal level if the object is located
inside a visibility minimum. Buf generally there are two modes of different
magnitudes. In this case the signal level is hardly fluctuating (gray line). if
only one mode exists, the signal level is always maximum, independent from
the stand-off distance (dashed gray line).

The stand-off distance at which the signal level is maximal are called visibility
maxima. The visibility maxima recur every 204 mm (1 mm} corresponding to
the laser cavity length.

Generally it is not necessary to search for the visibility maximum as the PSV
is sensitive enough to make measurements even close to the minimum. A
visibility minimum is indicated during the warm-up phase by periodic
fluctuation of the optical signal level. If you need an optimal resolution and
sensitivity for small objects, you should select a stand-off distance close to
the visibility maximum for each scanning head. As a rule of thumb, that the
resolution and the sensitivity just degrades insignificantly in the range of
+90mm around the visibility maximum,

The stand-off distance is measured from the front panel of the scanning head
(refer to FIGURE 4.3).

/\ﬁsibility minimum
7/ 7

Visibility maxirmum

Signal level

wa 7 modes wih equal mageuds  Stand-off distance
= 2 modes with different magnitude

/1

S ven i mede
7 / Laser heam

G MNifles Psv-400
SCANNING HEAD
o

:I Stand-off distance

: |

Objact

Figure 4.3: Measuring the stand-off distance
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4.3.2 Stand-off Distance for the Scanning Head

The optimal stand-off distance for the scanning heads are shown in
FIGURE 4.4.

,Visibili(y minimum VVisibiIity maximtm

BERRROO0000D

1) 303 507 .. +204

Stand cein
w2 modes with equal magnitude -off distan mm

w2 modes with different magnitude
« 1mode

Figure 4.4; Optimal stand-off distance for the scanning heads
The optimal stand-off distance are:

Optimal stand-off distance = 99mm +(n: mm
n=0,1,2, .. 1=204mm+1mm

i.e. for | = 204 mm the optimal stand-off distances are:
99mm, 303mm, 507 mm, 711t mm, 915 mm etc.

Front lens Depending on the front lens model which is installed in your scanning head,
models the following meaningful stand-off distances results (refer also to
SECTION 7.6.2).

Front lens model Stand-off distances
Long Range (LR)" 507 mm, 711 mm, 915mm, 1119mm etc.
Mid Range (MR) 303mm, 507mm, 711 mm, 915mm etc.

Vinstalled as standard

413
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5 Operating the PSV

5 Operating the PSV

5.1 Switching On and Off

Controller

PC

Software

The confroller is switched on by turning the key switch on the front panel to
position 1. The Lep POWER above the key switch lights up and shows that the
controller is ready to operate.

Is the PSV cabled correctly as described in SECTION 3.4.2, the LED POWER on
the front of the junction box also lights up and shows that the junction box is
ready to operate. Also the LED LASER on the scanning head lights up and
shows that the scanning head is ready to cperate and the laser is active, even
if the beam shutter is closed (refer to SECTION 5.2 and SECTION 5.3).

To switch on the PC, first set the mains switch on the back to position I. Then
open the front flap using the key and press the black POWER key.

If the PSV is cabled completely and all instruments are switched on, start the
software. See your software manual on this.

5.2 Blocking the Laser Beam

The scanning head is equipped with a beam shutter. This can be used to
block the laser beam without switching off the laser. Thus keeping the system
in thermal equilibrium.

The rotary knob for the beam shutter is on the front of the scanning head and
is labeled EMISSION ON/OFF, To block the laser beam, turn the knob
counterclockwise until the mark points at OFF.

WARNING |

Danger from laser light I- Only open the beam shutter when you are making
measurements!

WARNING !

Danger from laser Hght! - To position the scanning head, always close the
beam shutter. Only when the scanning head is roughly in place and has bes
fixed in a stable position, open the beam shutter for precise adjustment!

5.3 Indicating Laser Activity

On the back of the scanning head the 1.ep LASER indicates the laser activity.
The LED is lit while the laser is active (key switch on the front of the controller
in position 1). The LED is lit regardless of whether the beam shutter is open or
closed.
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5.4 Setting up the Scanning Head

Fluid stage If your PSV is equipped with a tripod and fluid stage, you can manually set up
the scanning head using the three hand-grips as described in the assembly
instruction providing by the manufacturer MANFROTTO.

Pan-tilt stage If your PSV is equipped with a heavy duty tripod and a motorized pan-tilt
(optional) stage, it is easier to set up the scanning head. You can control the pan-tiit
stage via the software (refer to the software manual).

Using the icons in the scanning head control in the software, the scanning
head can be panned to the left or right by +90° and can be tilted upward or
downward by £84°,

CAUTION I

Danger from overload! - Avoid any additional weight on the pan-tilt stage by
placing the heavy objects on top of the scanning head as this can put strain cn
the pan-tilt stage!

Stand-off Please pay also attention to the information on optimal stand-off distance for
distance the scanning head provided in SECTION 4.3.

5.5 Positioning the Laser Beam
There are different ways to position the laser beam:

+ In the software (refer to the software manual)
+ With the hand set PSV-Z-051

Software When the PSV is controlied via the software, you can use the icons Position in
the software to position the laser beam. See your software manual on this.

Hand set The hand set PSV-Z-051 is connected to the circular jack REMOTE
PSV-Z-051 CONTROL on the front of the scanning head. You can position the laser beam
using the emphasized part of the hand set shown in SECTION 5.1,
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Figure 5.1: Positioning the laser beam using the hand set PSV-Z-051

For positioning the laser beam, proceed as follows:
1. Switch on the PSV (at least the PC) and start the PSV software.
2. Change to the Acquisition Mode as described in your software manual.

3. Press the MODE key on the hand set to select the kind of movement.

The laser beam can be positioned in the GRID mode or in the FREE
mode

GRID mode (LEb GRID is lit up)

You move the laser beam on already defined alignment points or scan points
using the arrow key. The order in which the software approaches the points is
determined by an internal algorithm. Using the key —, you move the laser
beam forwards along the points and backwards with the key «.

FREE mode (LED FREE is lit up)

You move the laser beam freely using the four arrow keys. To do so, press the
arrow key for the direction you require. If you press the HOME key, then the
faser beam is positioned so that it is emitted from the scanning head
perpendicular to the front panel (position (0;0), is indicated in the software).
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5.6 Focusing

the Laser Beam

To get the highest possible quality of the measurement signal, the laser beam
has to be optimally focused. The laser beam is optimally focused when the
diameter of the laser beam target area on the object is as small as possible.
Due to blooming effects in the focus point, it is often difficult to ascertain when
the smallest diameter has been reached. For this reason you can alternatively
observe the signal level display in the software, on the scanning head or on
the contreller. The more signal level is shown, the better the focus of the laser
beam.

As the actual aim of focusing is to minimize the undesired noise signals, you
can also orientate yourself directly towards the output signal from the
controller when focusing. Observe the output signal in the software while
focusing the laser beam on the unmoved object. The better the focus of the
laser beam, the smaller the amplitude of the noise.

There are different ways to focus the laser beam:

+ Remote or automatic focusing via the software (refer to software manual)

» Remote or automatic focusing using the hand set PSV-Z-051 (refer to
SECTION 5.6.2

» Remote or automatic focusing via the display of the controller (refer to

SECTION 5.6.3 Remote Focus or Auto Focus, only without using the
software)

5.6.1 Focusing the Laser Beam via the Software

When the P8V is controlled via the software, you can remotely and
automatically focus the laser beam using the icons in the software. See your
software manual on this.

5.6.2 Focusing the Laser Beam using the Hand Set PSV-Z-051

Focus manually

5.4

The hand set PSV-Z-051 is connected to the circular jack REMOTE
CONTROL on the front of the scanning head. You can focus remotely

(manually) the laser beam using the emphasized part of the hand set shown
in FIGURE 5.2.



Focus
automatically
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Figure 5.2; Focusing the laser beam manually using the hand set PSV-Z-051

For manual focusing the faser beam, proceed as follows:
1. Switch on the PSV (at least the PC) and start the PSV software.
2. Change to the Acquisition Mode as described in your software manual.

3. Focus the laser beam using the two arrow keys FAR and NEAR as
follows:

- Focusing on infinity: Key T FAR
- Focusing on close-up: Key ¥ NEAR

If you press the keys for more the approximately one second, the motor
switches over to fast mode. For fine positioning, the keys can be repeatedly
pressed briefly. At the end of the adjustment range, the motor stops
automatically and the respective LED FAR or NEAR respectively light up.

Beside the keys for focusing, there is a signal level display which helps you to
optimize the focus. The signal shown is identical to that in the software and on
the scanning head.

The hand set PSV-Z-051 is connected to the circular jack REMOTE
CONTROL on the front of the scanning head. You can focus automatically the
laser beam using the emphasized part of the hand set shown in FIGURE 5.3.
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Figure 5.3: Automatically focusing the laser beam using the hand set PSV-Z-051

For automatically focusing the laser beam, proceed as follows:

1.
2.
3.

Switch on the PSV (at least the PC) and start the PSV software.
Change to the Acquisition Mode as described in your software manual.

Change to the GRID mode by pressing the MODE key on the hand set
(LED GRID is lit up).

Press the HOME key.
Now the laser beam will be focused aufomatically.

5.6.3 Focusing the Laser Beam using the Controller

When the controller is operated without the software, you can focus the laser
beam via the menu Auto & Remote Focus (refer to SECTION 5.15.3).

5.7 Using the Signal Level Display

58

The signal level display helps you to optimize the focus of the laser beam.
The signal levels shown as a bar display:

9

On the back of the scanning head

In the software (refer to your software manual)

On the hand set PSV-Z-051 (refer to SECTION 5.6.2)

On the display of the controller (only without using the software)
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5.8 Changing Settings

Software

Controller

When the PSV is controlled via the software, all settings are adjusted via the
software. See your software manual on this. [n this case the function keys on
the front of the controller do not have a function,

You will find information on setting the measurement range and the filters in
SECTION 4.2,

When the controlier is operated without the software, you can set the
measurement range and the filter via the menus on its display using the
function keys (refer to SECTION 5.15.4).

5.9 Indicating Overrange

Software

Controller

Overranging the measurement range is indicated in the software. See your
software manual on this,

If the LED OVER in the field VELOCITY on the front of the controller is lit up
continuously, it means that the measurement range set is exceeded. in this
case the next highest measurement range must be selected. You will find
further information on setting the measurement range in SECTION 4.2.1.

5.10 Defining Alignment Points

Software

Hand set
PSV-Z-051

There are different ways to define, check and delete alignment points for the
2D alignment and the 3D alignment:

o In the software (refer to the software manual)
e With the hand set PSV-Z-051

When the PSV is controlled via the software, you can use the software to
define and delete alignment points. See your software manual on this.

The hand set PSV-Z-051 is connected to the circular jack REMOTE
CONTROL on the front of the scanning head. You can define and delete
individual alignment points using the emphasized part of the hand set shown
in FIGURE 5.4. To do so, proceed as follows:

1. Switch on the PSV (at least the PC) and start the PSV software.

2. 2D alignment: Change to the Acquisition Mode and select Setup > 2D
Alignment as described in your software manual.

3D alignment: Change to the Acquisition Mode, then select Setup >
Align 3D Coordinates and select Set new alignment point at laser spot as
well as unit {(m or mm) as described in your software manual.

3. to define alignment points, change to the FREE mode by pressing the
MGODE Key on the hand set (LED FREE is lit up).
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Figure 5.4; Defining alignment points using the hand set PSV-Z-051

4. Using the four arrow keys, move the laser beam to the desired position.

NOTE !

The more precisely the alignment is carried out, the better the measurement
resuit will be. So please take your time setling the alignment points!

5. Press the TEACH key and the alignment point is defined.
The newly defined alignment point is shown in the software.

NOTE !

Pay attention that there are no persons or moving objects within the field of
vision of the video camera and in the beam path of the laser as otherwise it is
not possible to set an alignment point.

NOTE !

Pay attention that there are no multiple reflections on the object under
investigation caused by reflections of the laser beam as otherwise it is not
possible to set the alignment point on the desired position.

6. Repeat steps 4 and 5 until all desired alignment points are defined.

NOTE !

Pay attention to the number of alignment points on the object! in principle for
an alignment, it is enough to define four alignment points. For the best
possible result however, you should align at feast five poinis.
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For detailed information on how to carry out the 3D alignment, refer to your
software manual.

5.11 Checking Alignment Points using the Hand Set PSV-Z-051

5.11.1 2D Alignment

If you have calculated 2D alignment, you can select and check the existing
alignment points using the hand set as described in the following:

1. Change to the GRID mode by pressing the MODE key on the hand set
{LeD GRID is {it up).

PEV-Z-051

>
3
a0
T
)
DEL

O ()

GRO

& Polytec

=

Figure 5.5: Checking alignment points using the hand set PSV-Z-051

— — e ———

L/

2. Use the arrow keys « (former) and — (next) fo move the laser beam to
the desired alignment point.

If you want to delete an alignment point, proceed as described in
SECTION 5.12.
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5.11.2 3D Alignment

If you have calculated 3D alignment, you can select and check the existing
alignment points using the hand set as described in the following:

1. In the software in the dialog 3D Alignment, tick the box Select and check
existing point.

2. Change the GRID mode by pressing the MODE key on the hand set (LED
GRID is lit up, refer to FIGURE 5.5).

3. Use the arrow keys « (former) and — {next) to move the laser beam to
the desired alignment point.

If you want to delete an alignment point, proceed as described in
SECTION 5.12.

NOTE !

Once you delete an alignment point, the calculated 3D alignment becomes
invalid. Then you can not toggle the alignment points any more using the hand
set!

5.12 Deleting Alignment Points using the Hand Set PSV-Z-051

5.12.1 2D Alignment

Manually
positioning

510

To delete defined alignment points in the 2D alignment using the hand set,
you have two possibilities:

e Manually position the laser beam on the alignment points and delete the
alignment points.

« Toggle the alignment points with the laser beam and delete the alignment
points.

To manually position the laser beam on an alignment point and to delete the
alignment point, you proceed as follows:

1. Change the FREE mode by pressing the MODE key on the hand set (LED
FREE is lit up, refer to FIGURE 5.4).

2. Using the four arrow keys, move the laser beam to the alignment point
you want to delete.

3. Change to the GRID mode by pressing the MODE key on the hand set
{Lep GRID is lit up).

The TEACH key now functions as the DEL key (for deleting).
4. Press the DEL key and the selected alignment point is deleted.

5. Repeat steps 1 to 4 until all desired alignment points are deleted.



Toggle
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To toggle the alignment points with the laser beam and to delta them, remove
as follows:

1. Change the GRID mode by pressing the MODE key on the hand set (LED
GRID is lit up, refer to FIGURE 5.5).

2. Use the arrow keys « (former) and — (next) to move the laser beam fo
the desired alignment point.

3. If you want to delete this alignment point, press the DEL key on the hand
sef.

4. Repeat steps 2 and 3 until all desired alignment points are deleted.

5.12.2 3D Alighment

To delete defined alignment points in the 3D alignment using the hand set,
you have got only the possibility to manually position the laser beam on the
alignment point and to delete the alignment point. To do so, proceed as
follows:

1. Change the FREE mode by pressing the MODE key on the hand set (LED
FREE is lit up, refer to FIGURE 5.4).

2. Using the four arrow keys, move the laser beam to the alignment point
you want to delete.

3. Change to the GRID mode by pressing the MODE key on the hand set
(LED GRID is lit up).

The TEACH key now functions as the DEL key (for deleting).
4. Press the DEL key and the selected alignment point is delsted.

5. Repeat steps 1 to 4 until all desired alignment points are deleted.

NOTE !

Toggling the alignment peints is only available for a calculated 3D alignment.
Once you delete an alignment point, the calculated 3D alignment becomes
invalid. Then you can not toggle the alignment points any more using the hand
setl
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5.13 Defining and Deleting Scan Points (APS)
There are different ways to define and deiete scan points:

» In the software (refer to the software manual)
o Using the hand set PSV-Z-051

NOTE I

defining and deleting individual scan points Is only possible if you have the
software option APS Professional PSV-3-APS|

Software When the PSV is controlled via the software, you can use the software to
define and delete single scan points. See your software manual on this.

Hand set The hand set PSV-Z-051 is connected to the circular jack REMOTE

PSV-Z-051 CONTROL on the front of the scanning head. You can define and delete
single scan points using the emphasized part of the hand set shown in
FIGURE 5.6. To do so0, proceed as follows:

1. Switch on the PSV (at least the PC) and start the PSV software.

2. Change to the Acquisition Mode, then select Setup > Define Scan Points
and here select the Point Mode as described in your software manual.

NOTE !

Make sure that you have carried out a valid 2D and 3D alignment before!

3. To define scan points, change to the FREE mode by pressing the MODE
key on the hand set (LED FREE is lit up).
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Figure 5.6: Defining and deleting scan points using the hand set PSV-Z-051

4. Using the four arrow keys, move the laser beam to the desired position.

5. Press the TEACH key and the scan point is defined.
The newly defined scan point is shown in the software.

NOTE !

Pay aitention that there are no persons or moving objects within the field of
vision of the scanning head's video camera as otherwise it is not possible to
set a scan point.

NOTE |

Pay attention that there are no multiple reflections an the object under
investigation caused by reflections of the lager beam as otherwise it Is not
possible to set the scan polnt on the desired position.

6. Repeat steps 4 and 5 until all desired scan points are defined.

NOTE !

To get a 3D view of the measurement data, you have to define connections in
the software. See your software manual on this!

7. To delete defined scan points, change to the GRID mode by pressing
the MODE key on the hand set {LED GRID is lit up).

The TEACH key now functions as the DEL key (for deleling).

8. Press the DEL key and the selected scan point is deleted.
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9. For deleting further scan points, select them using the arrow keys <- or —»
and delete them by pressing the DEL key.

5.14 Overview above the Functions of the Hand Set PSV-Z-051

The following table contains an overview of the individual functions which you
¢an carry out using the hand set PSV-Z-051. You can carry out the individual
functions repeatedly.

F("’LZ?J;} Key Video window De:)i:ienf:an 2D alignment 3D alignment
FREE ) Move the laser beam up
FREE 1 Move the laser beam down
FREE +— Move the laser beam to the left
FREE - Mave the laser beam down to the right
FREE | HOME Center the laser beam (position 0°;0° within the software)
FREE | TEACH | Without functioﬂ Set scan point | Set alignment point
GRID T Without function
GRID \ Without function
GRID « Toggle last scan point Toggle last alignment point’
GRID -3 Toggle next scan point Toggle next alignment point’
GRID | HOME Automatically focus the laser beam
GRID T(Epéf? Without function De!sitaens:(!)eigtted Dalste selected alignment point
7 (FAR) Manually focus the laser beam of the scanning head
I (NEAR)|(An LED at the respective key lights up, if the end of the focusing range is reached.)

'In 3D alignment: At first you need a calculated 30 alignment and then you have to select Select and check existing paint in the
dialog 3D Alignment in the software.
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5.15 Operating the Controller without the Software

5.15.1 Operating Concept

The controller is operated via a menu shown on the display. The contents of
this menu control automatically adapt to the existing hardware configuration
of the controller. You select the menus and the individual settings using the
function keys next to the display. The function of these keys changes and
depends on the page currently being shown on the display. The respective
current function of the key can be seen by the icon displayed directly next to
the function key.

The adjustable parameters of the controller have been assigned to the
following three menus:

» The menu Settings contains all parameters which can be set individually
for a particular measurement,

» The menu Sensor contains all parameters which concern the scanning
head.

¢ The menu Setup contains all basic parameters for the controller which are
not assigned to a particular measurement.

i _ =
VELOCITY e
- il

AUXILIARY
—— Il

DISPLACEMENT
]

Figure 5.7: Page Seltings on the display of the controller

Three settings can be saved in a flash memory. Before switching off the
controller you can then select whether one of these three saved settings is
loaded automatically next time you switch on, or aiternatively, the settings
selected last are loaded (refer also to SECTION 5.15.5).

You will be informed of malfunction of the system, operating errors {such as

the scanning head accidentally not being connected) and advice by various
messages on the display (refer also to SECTION 5.15.6 and SECTION 6.4).
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5.15.2 Moving within the Menus

5-16

You can call up the main menu of the controller at any time by pressing the

key El From these menus you can access all sub-menus and parameters of

the controller. You move through the menus using the keys I The
respective menu item you have selected is then marked on the left by a
selection point. Once you have selected the required menu item, confirm your

selection by pressing the key . The page for the menu you have selected is
displayed.

The main menu of the controller is made up of the following four menu items:

Back - If you select the menu item Back, you will always go back up a menu
level. If selecting this menu item has no effect on the display, then you are
already at the highest menu level (Settings, Sensor or Setup).

Settings - The menu Settings contains all settings for the controller which are
relevant for a measurement (decoder selection, measurement ranges, filter
settings etc.).

Sensor - The menu Sensor contains all seftings which concern the scanning
head (e.g. the focusing), if the scanning head connected can be controlled
remotely from the controller.

Setup - The menu Setup contains the configuration of the controller and other
settings which are not directly associated with a particular measurement (e.g.
saving the settings, interface configuration).

In the sub-menus you also move around using the keys It and confirm your

selection by pressing the key . For orientation purposes, the top line of each
page shows you the path of exactly which point in the menu structure you are
currently at {e.g. Settings [Velocity CUTPUT] is the page with the settings for
the analog velocity signal in the menu Settings).
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5.15.3 Focusing the Laser Beam

There are different ways to focus the laser beam via the display of the
controller:

* Focus remotely (Remote Focus)
* Focus automatically (Auto Focus)

Apart from that, you can save a focus position set on the controller in the flash
memory and load it again.

Remote Focus  Using the function Remote Focus you can focus the scanning head remotely
via the display on the controller. To do so, proceed as follows:

1. Open the main menu by pressing .

2. Use ﬂvﬁ to select the menu Sensor and confirm with .
The page Sensor is displayed.

3. On this page use 3 to select the menu item Auto & Remote Focus and
confirm with 1.
The page Sensor [Auto&Remote Focus] is displayed.

4. On this page use {lﬂ to select the parameter Remote Focus and activate
it by pressing .

5. Now change the position of the optics by using ‘!&. tf you just press the
keys briefly, the position of the optics is changed step by step. If you hold
the keys pressed, the optics quickly moves longer distances. The internal
position of the optics is aiways shown in the graphics in the upper part of

the display, e.g. (> 11234, while in the field Remote Focus the direction is
displayed. The following readouts are possible here:

If near is displayed, the focus point is moving towards the scanning
head, with far the focus point is moving away from the scanning head.

«p limit [0] (st;;gfgf’ep) move limit [3300]
Remots Focus: near< near<<
<npear> or or <far>
far> far>>
Meaning: Start point Key briefly ermi;enyentl End point
reached pressed P pressed y reached

6. When focusing, orientate yourself towards the signal level or the noise
amplitude as also described in SECTION 4.2.

7. As soon as you have optimally focused the laser beam, confirm the
position with ¥4,

§17
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Auto Focus
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The function Auto Focus available for the scanning head traverses the
adjustment range of the optics and ascertains the position at which the
intensity of the reflected light received reaches its maximum.

NOTE |

The function Auto Focus only provides a meaningful result if the faser beam is
pointed at an unmoving object while focusing!

To start the Auto Focus, proceed as follows:
1. Open the main menu by pressing .

2. Use llﬂ to select the menu Sensar and confirm with .
The page Sensor is displayed.

3. On this page use {4 to select the menu item Auto & Remote Focus and
confirm with .
The page Sensor [Auto&Remote Focus] is displayed.

4. On this page use I to select the parameter Start Auto Focus and
activate it by pressing .

The controller starts focusing the laser beam automatically. This
changes the diameter of the target area of the laser beam on the object
which makes the signal level display on the scanning head or
respectively the display of the coniroller fluctuate, depending on this
diameter.

5. Automatic focusing is completed once the focus range of the scanning
head has been traversed twice. The internal position of the optics is
shown in the graphics in the upper part of the display, e.g. AF: 1234.

The laser beam is now focused and ready to make measurements. If the
laser beam should not be focused or there is no numerical value in the
field AF., then Auto Focus was not successful (refer to subsequent
section).

Problems can occur with Auto Focus particularly if

» the object under investigation has got an optically irregular surface

e or a very small object is to be measured in front of a reflective
background,

In such cases, the signal level with a badly focused laser beam may be higher
than with an optimally focused laser beam. The function Auto Focus then
identifies out of focus as the supposedly optimal setting.

You may be able to solve the problem by:

» increasing the reflectivity of the surface to be measured with refiective film
or similar material,

* or making measurements on small objects in front of a beam absorbing
background, e.g. black felt.
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A focus position for the scanning head set using the controller can be saved
in a flash memory in the controller and can be loaded again. To do so,
proceed as follows:

1.

2.

Open the main menu by pressing .

Use @ﬁ to select the menu Sensor and confirm with E
The page Sensor is displayed.

On this page use llﬂ fo select the menu item Auto & Remote Focus and
confirm with 1el

The page Sensor [Auto&Remote Focus] is displayed.

On this page use ﬂ‘ﬁ to select the parameter Save Focus Position and
activate it by pressing .

The current focus position is saved in a flash memory in the controller.

NOTE !

The focus position Is only saved while the controller is switched on. If you
want the focus position to be saved permanently, you have to save the focus
position and then the complete settings of the controller as described in
APPENDIX 5.15.6.

To load a saved focus position again, on the same page Sensor
[Auto&Remote Focus] select the parameter Load Focus Position and

activate it by pressing.

The most recently saved focus position is read from the memory and the
optics fravel to the corresponding position.
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5.15.4 Changing Settings

Set the velocity
decoder

5-20

To change a setting, first of all you have to activate the corresponding
parameter on the display. After that you can change the value and confirm the
change. To do so, proceed as follows:

1. Press the keys ﬂﬁ until the selection point is next to the parameter you
want to change.

2. Press the key H to activate the parameter.

The parameter is given a dark background, the arrows on the middle
keys change to f& and the icon Y is replaced by #4.

3. Now change the parameter by pressing the keys ‘!i

4. When the parameter has the required value, confirm the changing by
pressing the key % .
The background of the parameter and the arrows turn white again and
the icon ¥4 is replaced again by l The change is now effective.

NOTE !

If after activating a parameter you do not press any key on the controller for a
while, then the activation is automatically reversed again after approx. five
seconds!

To select the most suitabie velocity decoder, please proceed as foliows:
1. Open the main menu by pressing .

2. Use ﬂ,ﬂ to select the menu Settings and confirm with .

The page Settings is displayed. This page shows a graphic
representation of the panel of connectors on the front panel of the
controller,

3. Use l]vﬂ to move the selection point to be next to the jack OUTPUT in the
field VELOCITY or next to the jack OUTPUT in the field AUXILIARY if an

auxiliary velocity decoder is installed, and confirm with 1l

The page Settings [Velocity OUTPUT] or Settings [Auxiliary] respectively
is displayed.

4. On this page, use ll‘ﬁ to select the parameter Decoder and activate it by
pressing .

5. Now press ﬁi to select the desired velocity decoder and confirm with .

This selection does not exist for the page Settings [Velocity DSP QUT], as itis
only active if both the digital velocity decoder VD-07/VD-08 and the optional
adaptive DSP filter are installed.
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Set the fracking
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NOTE !

Only for PSV-400-H4: When the VD-03 is activated, you should switch off the

digital decoder VD-08, as otherwise high-frequency noise peaks can oceur in

the spectrum of the velocily signal. Please see the section Switch of the VD-
07/VD-08 on this.

To select the measurement range for velocity acquisition, proceed as follows:

1.

2.

Open the main menu by pressing .

Use @ﬁ to select the menu Settings and confirm with rlﬁ-l

The page Setlings is displayed. This page shows a graphic
representation of the panel of connectors on the front panel of the
confroller.

Use {1} to move the selection point to be next to the jack OUTPUT in the
field VELOCITY or next to the jack OUTPUT in the field AUXILIARY if an

auxiliary velocity decoder is installed, and confirm with .
The page Setlings [Velocity OUTPUT] or Settings [Auxiliary] respectively
is displayed.

On this page use {L‘ﬁ to select the parameter Range and activate it by

pressing .

Now use ‘!i to select the desired measurement range and confirm with N

To select the tracking filter mode for displacement acquisition, please proceed
as follows:

1.

2.

Open the main menu by pressing .

Use 417 to select the menu Settings and confirm with .

The page Settings is displayed. This page shows a graphic
representation of the panel of connectors on the front panel of the
controller.

Use {11 to move the selection point to be next to the jack OUTPUT in the
field VELOCITY and confirm with 1l

The page Settings [Velocity OUTPUT] is displayed.

On this page, use @ﬁ to select the parameter Tracking Filter and activate
it by pressing El

Now use ‘ﬁv to select the desired tracking filter mode and confirm with .
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fS:et the low pass To set the analog low pass filter, please proceed as follows:
iiter

1. Open the main menu by pressing .

2. Use {1 to select the menu Settings and confirm with .

The page Settings is displayed. This page shows a graphic
representation of the panel of connectors on the front panel of the
controller.

3. Use {1l to move the selection point to be next to the jack OUTPUT in the
field VELOCITY and confirm with .

The page Settings [Velocity OUTPUT] is displayed.

4. On this page, use ﬂ»ﬁ to select the parameter LowPass Filter and activate
it by pressing E

5. Now use B to select the desired cutoff frequency and confirm with E.

Set the high To switch the high pass filter on or off, please proceed as follows:
pass filter

1. Open the main menu by pressing .

2. Use @"LT to select the menu Settings and confirm with .

The page Settings is displayed. This page shows a graphic
representation of the panel of connectors on the front panel of the
controller.

3. Use {1 to move the selection point to be next to the jack OUTPUT in the
field VELOCITY and confirm with .
The page Settings [Velocity OUTPUT] is displayed.

4. On this page, use {4l to select the parameter HighPass Filter and activate
it by pressing E

5. Now use ‘!‘i to switch the high pass filter on {(100Hz) or off (Off) and
confirm with .

5.22



Deactivate
S/P-DIF data
{only VD-07/
VD-08)

Switch off the
VD-07/VD-08
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The output data from the digital velocity decoder VD-07/ VD-08 can be made
available as a digital data stream via the S/P-DIF interface on the back of the
controller. However, in unfavorable conditions, the high-frequency putses from
this digital data can cause distortions in the analog signal of the VD-07/ VD-
08. For this reason you should always deactivate making S/P-DIF data
available, if you do not use the S/P-DIF interface.

To deactivate the S/P-DIF data, proceed as follows:

1. Open the main menu by pressing .

2. Use I to select the menu Setup and confirm with .
The page Setup is displayed.

3. On this page use I to select the menu item Digital Out (rear) and
confirm with .
The page Setup [Digital Out] is displayed

4. On this page, use 3'{? to select the parameter Data Rate and activate it by

pressing .

5. Now press ﬁi to select the entry Off and confirm with .

Now no more S/P-DIF data is made available so that there is no danger
of high-frequency distortions in the analog signal of the VD-07/VD-08.

For measurements with the analog velocity decoder VD-03, you should not
only deactivate making the S/P-DIF data available, but should also switch off
the digital velocity decoder VD-08. If the VD-08 stays switched on during an
analog measurement, high-frequency noise peaks can appear in the
spectrum of the analog velocity signal.

To switch off the digital velocity decoder VD-08, please proceed as follows:
1. Open the main menu by pressing .

2. Use @1} to select the menu Settings and confirm with E

The page Setlings is displayed. This page shows a graphic
representation of the panel of connectors on the front panel of the
controller.

3. Use {1f to move the selection point to be next to the jack OUTPUT in the
field VELOCITY and confirm with 1.
The page Settings [Velocity OUTPUT] is displayed.

4. On this page use @ﬁ to select the parameter Range and activate it by
pressing .
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Use digital
output signals
(only VD-07/
VD-08)

Set the data rate
{(only VD-07/
VD-08)
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5. Now press !‘i to select the entry Off and confirm with M.
The digital velocity decoder VD-08 is now switched off.

6. You can switch the digital velocity decoder on again by selecting the
parameter Range and setting a measurement range.

The data from the digital velocity decoder VD-07/ VD-08 is emitted as a digital
data stream in S/P-DIF format on the back panel of the controller. The data is
available as an optical signal at the TOSLINK jack Optical and also as an
electrical signal at the TRIAX jack Electrical in the field DIGITAL QUT on the
back of the confroller.

Digital recording or analysis equipment connected to the digital output should
support 24 bit format to obtain an optimal signal-to-noise ratio. To evaluate the
digital velocity signal, you can for example use a commercially available PC
sound card with an S/P-DIF input. To avoid measurement errors, you should
make sure when choosing the PC sound card that the card does not
automatically carry out amplitude reduction.

If required, you can get recommendations for suitable PC sound cards and
software from your nearest Polytec representative.

As a general rule, the digital output signals of the VD-07/ VD-08 are available
with two different data rates (48kSa/s and 96kSa/s). The data rate you use
depends on which data rate the digital analysis systems you are using can
work with,

To set the data rate, please proceed as follows:
1. Open the main menu by pressing .

2. Use {1 to select the menu Setup and confirm with .
The page Setup is displayed.

3. On this page use {1 to select the menu item Digital Out {rear) and
confirm with el
The page Setup [Digital Out] is displayed.

4. On this page, use I to select the parameter Data Rate and activate it by
pressing .

5. Now use ‘!i to select the data rate and confirm with .

The S/P-DIF data of the VD-07/ VD-08 is now available af the data rate
you have selected at both jacks in the field DIGITAL OQUT on the back of
the controller. If you selected the entry Off, then the S/P-DIF interface is
not active.

Alternatively the data rate can also be set on the page Settings [Velocity DSP
OUT]. To do so, proceed as follows:

1. Open the main menu by pressing .
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2. Use {1 to select the menu Settings and confirm with .

The page Settings is displayed. This page shows a graphic
representation of the panel of connectors on the front panel of the
controller,

3. Use &1 to move the selection point to be next to the jack DSP OUT in the
field VELOCITY and confirm with 1ell.

The page Settings [Velocity DSP Output] is displayed.

4, On this page, use 14T to select the parameter Data Rate and activate it by
pressing r|§|

5. Now use T to select the data rate and confirm with Ei.

It makes no difference which of these two options you use to set the data rate
as they are automatically aligned.

5.15.5 Saving and Loading Settings

Save seftings

The controller provides you with the option of saving three different settings to
load them more quickly again later. Before switching off the controller you can
select which settings the controller should use when you start it again. If you
have operated the confroller via the software, next time the controller starts
always with the default settings.

To save settings, please proceed as follows:

1. Open the main menu by pressing the key E]

2. Use the keys 3T to select the menu Setup and confirm by pressing the
key .
The page Setup is displayed.

3. On this page use the keys I to select the menu item PowerUp Mode
and confirm by pressing the key .
The page Setup [PowerUp Mode] is displayed.

4. On this page use the keys @ﬁ to select the parameter PowerUp Settings
and activate it by pressing the key .

5. Now by pressing the keys ‘!i select a name it is to be saved under
(User1, User2 or User3) and confirm the name by pressing the key M.

6. Now use the keys {1 to select the parameter Save User Settings and
activate it by pressing the key .
The current settings are now saved under the name you have selected.
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Load seltings

Default settings

Settings last
used

526

To load settings you have already saved, proceed as follows:

1.

2.

Open the main menu by pressing the key .

Use the keys 3t to select the menu Setup and confirm by pressing the
key .

The page Setup is displayed.

On this page use the keys Il to select the menu item PowerlUp Mode
and confirm by pressing the key .
The page Setup [PowerUp Mode] is displayed.

On this page use the keys @ﬁ to select the parameter PowerUp Settings
and activate it by pressing the key .

Now press the keys ‘!@ to select the name the settings were saved under
(Usert, User2 or User3) and confirm the name by pressing the key 4.

The next time you switch it on, the controller will start up with the
settings you saved under the selected name.

The controller can also be started with the default settings instead of the
settings you have saved under a particular name. To do s0, you proceed in
exactly the same way as you would for loading saved settings, but instead of
selecting one of the three names you have saved under, select the entry
Default.

The controller can also be started with the settings you last used instead of
the settings you have saved under a particular name. To do so, you proceed
in exactly the same way as you would for loading saved settings, but instead
of selecting one of the three names you have saved under, select the entry
Last.
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5.15.6 Messages on the Display

Note

Warning

Error

Messages which appear on the display of the controller are divided into three
categories:

Messages in the category Note are identified by (i). These messages provide
information on activities of the controller as a consequence of the settings just
made.

Messages in the category Warning are identified by (1). These messages are
errors which you can rectify yourself, such as the scanning head accidentally
not being connected up.

InSECTION 6.4 you will find all error messages, their possible causes and tips
on how to rectify them.

Messages in the category Error are identified by (x). These messages inform
you about serious instrument errors. If such an error occurs, please make a
note of the contents of the message and contact your nearest Polytec
representative.

All messages on the display are closed again by pressing any of the function
keys.

5.15.7 Displaying the Configuration and the Firmware Version of the Controller

Firmware
version

Configuration

The current firmware version is shown on the display shortly after switching
the controller on. After a few seconds the displayed information disappears
again.

You can show the configuration of the controller on the display. To do so,
proceed as follows:

1. Open the main menu by pressing .

2. Use @/IT to select the menu Setup and confirm with .
The page Setup is displayed.

3. On this page use {1 to select the menu item Service and confirm with .
The page Setup [Service] is displayed.

4. Now use Ilﬁ to select the parameter Obligatory Components for the
standard components of the controller and confirm with r@

The page [...Obligatories} with the standard components is displayed.

5. Go back to the page Setup [Service] by selecting the menu item Back
from the main menu (key ) and confirm (key ).
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6. Now use @ﬂ to select the parameter Optional Components for the

optional components and confirm with .

The page [...Options] with the optional components installed is
displayed.

5.16 Configuring the R§-232 Interface of the Controller
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You can use the display to configure the RS-232 interface on the back of the
controller, To do so, proceed as follows:

1.

2.

Open the main menu by pressing .

Use {!-ﬁ‘ to select the menu Setup and confirm with .
The page Setup is displayed.

On this page use {1 to select the menu item Interface (rear) and confirm
with .

The page Setup [Interface] is displayed.

On this page, use I to select the parameter Baud Rate and activate it by
pressing el

Now use ‘!i to select the transfer rate and confirm with .

On the page Setup [Interface] use {Lﬁ to select the parameter Echo Mode
and activate it by pressing .

Now use B to switch the echo off (Off) or on {On) and confirm with J)

NOTE !

For ail PSV models, here the transfer rate must be set to 115200 Baud!
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6 Fault Diagnosis

Simple tests are described in the following for you to carry out yourself in the
case of malfunction. In the case of more difficult problems with the individual
functions, please contact our service personnel. The tests described here are
not meant to lead you to carry out maintenance work yourself, but to provide
our service personnel with information which is as accurate as possible.

Testing the PSV is limited to such tests in which the housing do not have ti be
opened. Opening the housings without authorization will invalidate the
warranty.

If required, please contact our service department. Based on your fault
description, further procedure will be determined.

if the PSV has to be sent back for repair, always use the original packaging
and enclose an exact description of the fault.

6.1 General Tests

Controller

If any system component of the PSV does not function properly, please first
check the following:

1. lIs the PSV cabled correctly as described in SECTION 3.4.27

2. Is there only the original RS-232(X) cable (cross-wired) from Polytec
used?

3. Is the transfer rate set to 115200 Baud (refer to SECTION 5.16)?

NOTE !
For all PSV models, here the {ransfer rate must be set to 115200 Baud!

4, Is the key switch on the front of the controller in position [?

5. Is the LED POWER on the front of the controller lit up?

If the LED is not lit up, it can be assumed that there is a fault in the mains
supply. Disconnect the mains plug and check the fuses on the back of
the controller. Please note that there are two aclive fuses which can
both bead to Failure.

WARNING !

Danger from electrical current! - Working on an open housing can lead to
personal injury!

NOTE !

Before checking the fuses, the mains plug must be disconnected!
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6.

Is the LED POWER on the front of the junction box lit up?

The junction box will be automatically switched on with the controller,
assuming the interferometer cable is installed correctly. If the LED is not
lit up, it can be assumed that there is a fault in the mains supply.
Disconnect the mains plug and check the fuses on the back of the
junction box. Please note that there are two acfive fuses which can both
bead to failure.

Check whether the data acquisition board is instalied correctly. To do so,
proceed as follows:

7.

Switch the PC on.

Data acquisition 8. Double-click the icon Measurement&Automation on the desktop.

hoard for
models
-H4, -M2, -M4, -B

8. Change into the directory Devices and Interfaces.

The dala acquisition board is installed correctly, if in the directory
according to the model PCI-4461, PCI-4462, PCI-6110 or PCI-6111 is
listed. If not, there is a problem with the data acquisition board.

If you operate the PSV-400-H4 with the optional junction box PSV-E-
408, your PC is equipped with two data acquisition boards. These are
shown twice as PCI-4462 in the directory Devices and Interfaces.

NOTE!

The data acquisition board and the generator board are shown in a defined
order {Value), which never has fo be changed!

Generatorboard The generator board is installed correctly, if in the directory according to the
model PCI-6711 is listed. If not, there is a problem with the generator board.

for model -H4

Data acquisition 10. Open the Device Manager of your operating system. You will find detailed

board for model
-M2-20
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information on this in the manual of the operating system.

The data acquisition board and the generator board are installed
correctly if they are listed in the Device Manager. if not, please press the
key F5 on your keyboard to refresh your display. If the data acquisition
board and the generator board are not yel listed, please check whether
the boards are properly inserted into their slots in the PC.
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6.2 Problems with the Laser

6.2.1 No Laser Beam

If no laser beam is emitted, check the following:

1. Is the P8V cabled correctly as described in secTioN 3.4.27
2. Is the key switch on the front of the controller in position 1?
3. Is the beam shutter on the front of the scanning head open (position ON)?
4. |s the LeD LASER on the back of the scanning head lit up?

If the LED is not lit up, it can be assumed that there is a fault in the mains
supply of the controller. In this case disconnect the mains plug and
check the fuses on the back panel. Please note that there are two active
fuses which can both bead (o failure.

WARNING [

Danger from electrical currentl - Working on an open housing can lead to
personal injury!

NOTE !

Before checking the fuses, the mains plug must be disconnected!

5. Is the LED POWER on the front of the junction box lit up?

If not, it can be assumed that there is a fault with the power supply of the
junction box. In this case disconnect the mains plug and check the fuses
on the back panel. Please note that there are two active fuses which can
both bead to failure.

WARNING !

Danger from electrical current! - Working on an open housing can lead to
personal injury!

NOTE |

Before checking the fuses, the mains plug must be disconnected!

6.2.2 Great Fluctuation of the Signal Level Display

if the signal level display on the back of the scanning head or in the software
fluctuates a lot periodically, please check the foliowing:

Is the object positioned unfavorably in a visibility minimum of the laser?
Change the distance between the scanning head and the object. You will find

detailed information on optimal stand-off distance and visibility maxima of the
scanning head in SECTION 4.3 or SECTION 7.6.2.
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6.2.3 Laser can not be Focusad using the Hand Set PSV-Z-051

If the laser beam can not be focused remotely with the hand set PSV-Z-051,
please check the following:

Has the controller the firmware version V1.2 (refer to SECTION 5.15.7} and at
least the PSV software 8.1 installed on the PC?

If not, you have to update your PSV software and the firmware of the
controller, Please contact Polytec on this.

6.3 No Measurement Signal or Implausible Measurement Signals

Data acquisition

Output signal

6-4

If the laser beam is emitted but there is no measurement signal, please check
the following:

1. Is the PSV cabled correctly as described in SECTION 3.4.27

2. Put a matt white test surface such as a piece of paper at approximatesly
50cm from the front panel of the scanning head in the beam path. Does
the signal level display lit up?

if the signal level display does not light up, then the input section of the
controller is fauity.

Check the correct function of the data acquisition board and the software as
follows:

1. Disconnect the BNC cable for the measurement signal from the BNC jack
VELO on the front of the junction box.

2. Feed the signal of a function generator to this BNC jack.

3. Display the time signal in an analyzer as described in your software
manual.

The data acquisition board and the software work properly, if the signal
of the function generator is displayed correctly. In this case there is a
problem in the controller.

Now check the output signal of the controller as follows:

4. Display the time signal in an analyzer as described in your software
manual.

5. Set the measurement range to 10™%/V. Does the output signal react to
the test surface moving?

6. If the output signal does not react, check if a significant offset is indicated.
Normally a DC voltage less than £50mV can be measured.
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6.4 Messages on the Display of the Controller

Messages which appear on the display of the controller are divided into three
categories:

Messages in the category Note are identified by (i}). These messages provide
information on activities of the controller as a consequence of the settings just

You will find a list of all notes with explanations in SECTION 6.4.1.

Messages in the category Warning are identified by (!). These messages are
errors which you can rectify yourself, such as the scanning head accidentally

You will find a list of all warnings with explanations in SECTION 6.4.2,

Note

made.
Warning

not being connected up.
Error

Messages in the category Error are identified by(x). These messages inform
you about serious instrument errors. If such an error occurs, please make a
note of the contents of the message and contact your nearest Polytec
representative.

You will find a list of all errors with explanations in SECTION 6.4.3.

All messages on the display are closed again by pressing any of the function
keys.

6.4.1 List for Notes @

Message

Explanation

(i} Last settings cannot be saved. This
is done automatically.

The current settings on the controller are saved permanently.
They therefore do not have to be saved before switching off.

(i) Default settings are predefined and
cannof be saved.

The default settings can not be overwritten.

(i) Settings saved successfully as
UserX

The current settings have now been saved under the name
you have selected.

(i) Keyboard is locked by Interface
Control.

The keys on the front panel of the controiler are locked when
controller is remotely operating via the software.

(i) Filter Response Saved. Use
Range 'Load Response’ to recall.

The current frequency response is saved with the frequency
range set in the flash memory of the DSP filter. You can recall
the saved settings via Range 'Load Response’.

(i} Focus Position Saved

The actual focus position is saved.
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6.4.2 List for Warnings é\_)

Message

Explanation

{1} Component is not installed.

The selected menu item is not available as the necessary
hardware component has not been installed, e.g. Save Filter
Coefficients with the DSP filter is not installed.

(1) No Sensor Head found.

Scanning headPSV-1-400: The scanning head has not been
connected or is connected wrongly or the connecting cable is
defective. Check that the connecting cable between the
controller and the scanning head is connected up correctly.
Other sensor heads: All other sensor heads can not yet be
remotely controlled from the controller. So the controller can
not recognize them vyet either.

(1) Hardware has changed. PowsrlUp
Mode and all settings are now set to
defaults!

This message appears after installing new components in the
controller. After such an installation, the whole instrument is
set back to the default settings. The message only appears
the first time you switch on after the instailation.

(1) Non-volatile storage is only possible
with PowerUp Settings 'Last’

The current focus position can only be saved in the Power-Up
mode Last. First of all, save the focus position in the Power-
Up mode Last. Then change the Power-Up mode to Usert,
User2 or User3 and save the settings (refer to

SECTION 5.15.6).

(1) Saving is not possible in this range.

To save frequency response with the frequency range set of
the DSP filter ('Save Response’), you have to select one of the
three frequency ranges (Range '< 20kHz’, '< 2kHz' or

"< 0.3kHz").

6.4.3 List for Error

Message

Explanation

(x) Error @ 12C address:0xXX

After insialling a new hardware component a hardware conflict
has occurred. It is possible that the new hardware component
has not been configured correctly.

Please contact our service department!

{x)}Error on SCI 0
(x) Error on SCI 1
(x) Error on SCI 2
(x} Error on |12C Bus
(x) Errer on ADC

An internal error has cccurred.

Please contact our service department!
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7 Technical Specifications

7.1 Standards Applied

Laser safety:

Electrical safety:

EMC;

7.2 Controller OFV-5000
7.2.1 General Data

Mains Connection

Mains voltage:
Power consumption:
Fuses:

Safety class:

Ambient Conditions

Operating temperature:
Storage temperature:
Operating allituds:
Relative humidity:

Housing

Dimensions:
Waight:

Calibration

Calibration recommended:

7 Technical Specifications

IEC/EN 80825-1:2003-10

(safeiy of laser products, complies to US 21 CFR
1040.10 and 1040.11 except for deviations pursuant
to laser notice no. 50, dated 26 July 2001)

IEC/EN 61010-1:2002-08
{(safety requirements for elsctrical equipment for
measurement, control and laboratory use)

IEC/EN 61326-1:2006-10

(EMC requirements on Emission and Immunity -
electrical equipment for measurement, contro! and
laboratory use)

Emission: FCC Class B
|IEC/EN 61000-3-2 and 61000-3-3
Immunity: IEC/EN 61000-4-2 to 61000-4-6

and [EC/EN 61000-4-11

100...240VAC £10%, 50/60Hz
max. 100VA

2.0A/slow-blow

| {protective grounding)

+5°C...+40°C (41°F... 104°F)
—10°C...+65°C (14°F...149°F)
0m...3048m (0ft...100001t)
max. 80%, non-condensing

450mm x 360mm x 150mm (19", 84HE/3U)
10kg

every 2 years
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7.2.2 Digital Interfaces

RS-232: 8 data bit, 1 stop bit, no parity;
Baud rate: 115200Baud (for PSV);
RS8-232(X) cable to the junction box:
2 x 9 pin Sub-D jack, null modem cable {cross-wired)

DIGITAL OUT Optical: TOSLINK output with S/P-DIF standard

{not active for PSV-400-B and PSV-400-M2-20)
DIGITAL QUT Electrical: TRIAX output with S/P-DIF standard

{not active for PSV-400-B and PSV-400-M2-20)
External Decoder: Special interface for an external digital displacement

decoder

7.2.3 Analog Signal Inputs and Outputs

7-2

VELOCITY OUTPUT

Volitage output for the velocity signal

Output swing: max. 20V,

Output impedance: nom. 500

l.oad resistance: min. 1002 (-0.5% additional error)
Overrange indicator threshold: typ. 90% of full scale

DC offset: max. 20mV

VELOCITY DSP OUT

Voltage output for the velocity signal after adaptive DSP filtering (only for a
connection along with the adaptive DSP filter LF-02)

Output swing: max. 20V,

Output impsdance: nom, 500

Load resistance: min. 10Q {-0.5% additional error)
DC offset: max. 10mVv

AUXILIARY OUTPUT

Voltage output of the signal of the optional auxiliary decoder (displacement or
velocity signal depending on the decoder)

Electrical properties: Depending on the decoder installed
(refer 1o SECTION 7.2.4)

AUXILIARY UNIVERSAL

Input or output for special functions of the optional auxiliary decoders
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DISPLACEMENT OUTPUT

Voltage output for the displacement signal {only with a displacement decoder
installed)

Qutput swing: max. 20V, (depending on the displacement
decoder)

Output impedance: nom. 50Q

Load resistance: min. 10 (~0.5% additional error)

DISPLACEMENT TRIG IN

Trigger input to set the DC offset of the displacement signal back to zero (only
with a displacement decoder installed)

input voltage: max. £15V
Sensitivily threshold: < 25mV {rising edge)
Input impedance: min. 10k

Pulse width: min. 2us

Pulse frequency: max. 100kHz
Trigger delay: < 10us (typ. 5us)
SIGNAL

Signal output for a DC voltage signal proportional to the logarithm of the
optical signal {evel

Voltage range: 0v...3Vv,DC
Load resistance: 210k
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7.2.4 Decoder Specified Properties

Velocity Decoder VD-03 (PSV-400-H4)

Measurement range 10 100 1000 A
Full scale (peak) 0.1 1 10 m/s
Frequency range
fm 0.5 0.5 0.5 Hz
frnax 250 1500 1500 kHz
Max. acceleration 16000 260000 9600000 g
Frequency response’
0.5Hz...20Hz +0.5 +0.5 +0.5 dB
20Hz...100Hz +0.1 +0.1 +0.1 dB
100Hz...250kHz +0.2/-1 +0.1 +0.1 dB
250kHz...1.5MHz - +0.5/-2 +0.5/-2 dB
Resolution?
frequency-dependent® 0.1...1 0.3..3 2.5 %/fﬂfz
typicalty* 0.2 0.5 2.5 bR/ iz
E;?f?‘;i“(f;;j)epe"de”t phase ~2.12 -0.41 ~0.36 °IkHz
Signal delay t, (typ.) 5.89 1.15 0.99 us
Calibration error®
= +3)°
LG ie " “ . "
(T;:;f;o?::: :32:; 15 £2.5 2.5 %
Linearity error® 1 1 1 %
Harmonic distortions < -52 <-50 <-50 dBc
Spurious signals (non-harmonic)” < -B6 < -86 <-86 dBFS

! The frequency response defines the frequency-dependent amplitude error, referred to the reference fraquency of tkHz.

2The noise-limited resolution is defined as the signal amplitude (rms) at which the signal-to-noise ratio is 0dB with 1Hz speclral
resolution, measured on 3M ScotchliteTape® (reflective film).

3The attalnable resolution Is frequency-dependent and is specified for frequencies above 10Hz.
*The typical value refers to the center of the aperating frequency range.
¥ Conditions: sinusoidal vibration, f = 1kHz, amplitude 70% of full scale range, load resistance > 1MQ

5The linearity error is defined as the amplitude-dependent, relative deviation of the scaling factor, referred to the scaling factor

under calibration conditions (refer to footnote®).
? The maximum amplitude of the distortion refers to the full scale. An exception of which is a single peak, generated by the

optical sensor, in the frequency region 20...26kHz, whose amplitude depends on the stand-off distance.
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Velocity Decoder VD-04 (PSV-400-B)

7 Technlcal Specifications

Measurement range 10 100 1000 S LAY
Full scale (peak) 0.1 1 10 m/s
Frequency range
fo 0.5 0.5 0.5 Hz
fnax 250 250 250 kHz
Max. acceleration 16000 160000 1800000 g
Frequency response’
0.5Hz...20Hz +0.5 +{(.5 +0.5 dB
20Hz...100Hz +0.1 +0.1 +0.1 dB
100Hz...200kHz 0.2 +0.2 +0.2 dB
200kHz...250kHz +0.2/-1 +0.1/-1 +0.1/-1 dB
Resolution?
frequency-dependent® 0.1...1 03..3 2..5 b/ bz
typically* 0.2 0.5 2.0 CUVAT:
gﬁ?‘;ﬁ"gjﬁepe”de“t phase 2,11 ~1.52 ~1.46 */kHz
Signal delay t, (typ.) 5.85 4.21 4.05 ys
Calibration error®
= +3)°
(11:2 - ((33 ;?}f;) *1 +1 +1 %
;;’8==+451°.$:::::§2:FC) 1.5 +2.5 +2.5 %
Linearity error® 1 1 1 %
Harmonic distortions < -52 <-50 < -50 dBc
Spurious signals (non-harmonic)’ < -86 <-86 <-86 dBFS

1 The frequency response defines the frequency-dependent amplitude error, referred to the reference frequency of 1kHz.
2The noise-limited resolution Is defined as the signal amplitude {rms) at which the signal-to-noise ratio is 0dB with tHz spectral

resolution, measured on 3M ScolchliteTape® (reflective flim}.

% The attainable resolution is frequency-dependent and is specified for frequencies above 10Hz.
4 The typical value refers to the center of the operating frequency range.
5 Conditions: sinusoidal vibration, f = 1kHz, amplitude 70% of full scale range, load resistance = 1MQ

5 The linearity error Is defined as the amplitude-depsndent, relative deviation of the scaling factor, referred to the scaling factor
under calibration conditions (refer to footnote®).

7 The maximum amplitude of the distortion refers to the full scale, An exceplion of which is a single peak, generated by the
optical sensor, in the frequency region 20..,25kHz, whose amplifude depends on the stand-off distance.
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Velocity Decoder VD-07 (Part 1 of 2, only P§V-400-M2, -M4 and -M2-20)

Measurement range 1 2 5 (LP) 5  AY
Full scale (peak) 0.01 0.02 0.05 0.05 m/s
Frequency range
f. 0 0 0 0 Hz
fo 20 20 20 100 kHz
Max. acceleration 128 256 640 3200 g
Frequency response’
0.05Hz...10kHz +0.05 +0.05 +0.05 - dB
10kHz...14kHz +0.1/-0.3 +0.1/-0.3 +0.1/-0.3 - dB
14kHz...20kHz +0.1/-1 +0.1/-1 +0.1/-1 -
0.05Hz...40kHz - - - +0.05
40kHz...75kHz - - - +0.1/-0.3
75kHz...100kHz - “ - +0.1/-1
Resolution?
frequency-dependent® <0.02 <0.02 < 0.02 0.01..0.04 | B/ /mz
typically* 0.01 0.01 0.01 0.02 Bz
:;ﬁ?:ir}wfpe"dem phase ~46.3 -45.8 ~45.0 4.6 °IkHz
Signal delay t, {typ.) 128 127 125 12.7 us
Calibration error®
= 0a) - -1 ao ||
Linearity error® <0.1 < 0.1 < 0.1 < 0.1 %
Harmoenic disfortions < -54 < -54 <-54 <-44 dBc
Spurious signals {non-harmonic)’ <-74 <-80 <-83 <-83 dBFS

' The frequency response defines the frequency-dependent amplitude error, referred to the reference frequency of 1kHz.

2The noise-limited resolution is defined as the signal amplitude {rms) at which the signal-to-noise ratio is 0dB with 1Mz spectral
resolution, measured on 3M ScolchliteTape® {reflective film).

3The altainable resolution is frequency-dependent and Is specified for frequencies above 10Hz, In the frequency range from
10Hz to 5kHz the specified decoder noise Is superimposed by scanner noise. The resolution is then between 0.1 and 1um/s

with 1Hz spectral resolution.

*The typical value refers to the center of the operating frequency range.
5 Conditions: sinusoidal vibration, f = 1kHz, amplitude 70% of full scale range, joad resistance = 1MQ
5The linearily error is defined as the amplitude-dependent, refative deviation of the scaling factor, referred to the scafing factor

under calibration conditions (refer to footnote®).

I The maximum amplitude of the distortion refers to the full scale. An exception of which is a single peak, generated by the
optical sensor, in the frequency region 20...25kHz, whose amplitude depends on the stand-off distance.
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Velocity Decoder VD-07 (Part 2 of 2, only PSV-400-M2, -M4 and -M2-20)

Measurement range 10 {LP) 10 20 50 2N
Full scale (peak) 0.1 0.1 0.2 0.5 m/s
Frequency range
frin 0 0 0 0 Hz
fnax 100 350 350 350 kHz
Max. acceleration 6400 22000 44000 110000 g
Frequency response’
0.05Hz...40kHz +0.05 - - - dB
40kHz...75kHz +0.1/-0.3 - - - dB
75kHz...100kHz +0.1/-1 - - -
0.05Hz...200kHz - + 0.05 4+ 0.05 + 0.05
200kHz...300kHz - +0.1/-0.3 +0.1/-0.3 +0.1/-0.3
300kHz...350kHz - +0.1/-1 +0.1/-1 +0.1/-1
Resolution?
frequency-dependent® 0.01..0.04 | 0.01..01 | 0.02..04 | 0.04..02 | E//mz
typically* 0.02 0.05 0,06 0.06 BT iz
E;ﬁ?:j’}f;;’)epe"de”t Phase -4.6 -3.9 -3.9 -3.9 * fkHz
Signal delay t, (typ.) 12.7 10.9 10.9 10.9 us
Calibration error®
(= 41 104 1 - 1 0|
Linearity error® <0.1 < 0.1 < 0.1 < 0.1 %
Harmonic distortions <-50 < -50 <-52 < -52 dBc
Spurious signals {non-harmonic)’ < -86 < -86 <-90 <-90 dBFS

' The frequency response defines the frequency-dependent amplitude error, referred to the raference frequency of 1kHz,

2The nolse-limited resolution is defined as the signal amplitude (rms) at which the signal-to-noise ratio is 0dB with 1Hz spectral
resolution, measured on 3M ScotchliteTape® (reflective film).

3The atfainable resolution is frequency-dependent and is specified for frequencies above 10Hz. In the frequency range from
10Hz to SkHz the specified decoder noise is superimposed by scanner noise. The resolution [s then between 0.1 and 1pm/s

with 1Hz spectral resclution,

*The typical value refers to the center of the operating frequency range.
% Conditions: sinuscidal vibration, f = 1kHz, amplitude 70% of full scale range, load resistance 2 1MQ

The linearily error is defined as the amplitude-dependent, relative deviation of the scaling factor, referred to the scaling factor
under cafibration conditlons (refer to foolnote® ).

" The maximum ampiitude of the distortion refers to the full scale. An exception of which is a single peak, generated by the
optical sensor, in the frequency region 20...25kHz, whose amptlitude depends on the stand-off distance.
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Velocity Decoder VD-08 (Part 1 of 2, only PSV-400-H4)

Measurement range 0.2 0.5 1 2 LY4Y
Full scale {peak) 0.002 0.005 0.01 0.02 m/s
Frequency range
fin 0 0 Hz
frnox 10 20 kHz
Max. acceleration 6.4 16 64 256 g
Frequency response’
0.05Hz...3kHz +0.05 +0.05 - - dB
3kHz...4kHz +0.1/-0.3 +0.1/-0.3 - - dB
4kHz...5kHz +0.1/-1 +0.1/-1 - - dB
0.05Hz...7kHz - - +0.05 - dB
7kHz...8kHz - - +0.1/-0.3 - dB
8kHz... 10kHz - - +0.1/-1 - dB
0.05Hz...10kHz - - - +0.05 dB
10kHz... 14kHz - - - +0.1/-0.3 dB
14kHz...20kHz - - - +0.1/-1 dB
Resolution?
frequency-dependent® <0.01 <0.01 <0.02 < 0.02 *‘?m/JH_Z
typically* <0.005 < 0.005 <0.01 <0.01 B e
z;?f?::"(f;’f)epe”de"t phase -107 -107 ~105 ~49.3 *fkHz
Signal detay {; (typ.) 297 297 290 137 s
Calibration error®
(.= 417104 S R e B
Linearity error® <0.1 < 0.1 <0.1 <0.1 %
Harmonic distortions < -50 <-50 <-b4 <-54 dB¢
Spurious signals (non-harmonic)’ <—-60 < -68 <-74 < —80 dBFS

*The frequency response defines the freguency-dependent amplitude error, referred to the reference frequency of 1kHz.

2 The noise-limited resolution is defined as the signal amplitude (rms) at which the signal-to-noise ratio is 0dB with tHz spectral
resolution, measured on 3M ScotchliteTape® (reflective film).

3 The attainable resolution is frequency-dependent and is specified for freguencies above 10Hz, In the frequency range from
10Hz to 5kHz the specified decoder noise is superimposed by scanner noise. The resolution is then between 0.1 and fum/s

with 1Hz spectral resolution,

* The typical value refers to the center of the operating frequency range.

5 Conditions: sinusoidal vibration, f = 1kHz, amplitude 70% of full scale range, load resistance » 1MQ

%The linearily error is defined as the amplitude-dependent, relative deviation of the scaling factor, referred to the scaling factor
under calibration conditions (refer to footnote®),

?The maximum amplitude of the distortion refers to the full scale. An exception of which is a single peak, generated by the
optical sensor, in the frequency region 20...25kHz, whose amplitude depends on the stand-off distance.

7-8




7 Technical Specifications

Velocity Decoder VD-08 (Part 2 of 2, only PSV-400-H4)

Spurious signals (non-harmonic)’

Measurement range 5 10 20 50 B0/
Full scale (peak) 0.08 0.1 0.2 0.5 m/s
Frequency range
i 0 0 0 0 Hz
£ 20 20 25 25 kHz
Max, acceleration 640 1280 3200 8000 g
Frequency response!
0.05Hz...10kHz +0.05 +0.05 - - dB
10kHz...14kHz +0.1/-0.3 +0.1/-0.3 - - dB
14kHz...20kHz +0.1/-1 +0.1/-1 - - dB
0.05Hz...11kHz - - +0.1 +0.1 dB
11kHz...16kHz - - +0.1/-0.3 +0.1/-0.3 dB
16kHz...25kHz - - +0.1/-1 +0.1/-1 dB
Resolution?
frequency-dependent® <0.02 0.01..0.04 | 02..0.08 | 004..02 | E//p
typically* 0.01 0.02 0.03 0,05 bz
:;%?‘;j"(f;’ff)epe”de“t phase -33.8 -33.8 8.7 8,7 °[kHz
Signal delay t; (typ.) 94 94 243 24.3 us
Calibration error®
(= 41 108F) T
Linearity error® <01 < Q.1 < 0.1 < 0.1 %
Harmonic distortions <54 < -54 <-54 < .54 dBc
<-83 < --86 < -90 < -90 dBFS

' The frequency response defines the frequency-dependent amplitude error, referred to the reference frequency of 1kHz.

2The noise-limited resolution is defined as the signal amplitude (rms) at which the signal-to-noise ratio is 0dB with 1Hz spectral
resolution, measured on 3M ScotchliteTape® (reflective film).

3The attainable resolution is frequency-dependent and is specified for frequencies above 10Hz. In the frequency range from

10Hz to 5kHz the specified decoder noise is superimposed by scanner noise. The resolution is then between 0.1 and 1pm/s

with 1 Hz spectral resolution.

4The typical value refers to the center of the operating frequency range.
5 Conditions: sinusoldal vibration, f = 1kHz, amplitude 70% of full scale range, toad resistance = 1MQ
5 The linearity error is defined as the amplitude-dependent, relative deviation of the scaling factor, referred to the scaling factor

under calibration conditions (refer to footnote® ).

! The maximum amplitude of the distortion refers lo the full scale, An exception of which is a single peak, generated by the
aptical sensor, in the frequency region 20...25kHz, whose amplitude depends on the stand-off distance.
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Velocity Decoder VD-09 (Part 1 of 4, only PSV-400-M2, -M4 and -M2-20)

Measurement range 5 10 20 (LP) 20 A
Full scale (peak) 0.05 0.1 0.2 0.2 m/s
Frequency range
fon 0 0 0 0 Hz
fnax 100 250 250 1000 kHz
Max. acceleration 3200 16000 32000 128000 g
Freguency response’
0.05Hz...50kHz 0.1 0.1 +0.1 +0.1 dB
50kHz...100kHz +0.1/-1 +0.1/-0.2 +0.1 +0.1 dB
100kHz...250kHz - +0.1/-1 +0.1/-1 +0.1 dB
250kHz...1MHz - - - +0.2/-0.5 dB
Resolution?
frequency-dependent® 0.01...0.04 | 0,01..0.07 | 0.2..0.08 | 0.02..0.25 ”?m/JFiE
typically* 0.02 0.04 0.05 0.12 LR iz

Frequency-dependent phase

shift p, (typ.) —7.45 -5.54 -58 -3.2 °IkHz

Signal delay {, (typ.) 20,7 15.4 16.1 8.9 VE;

Calibration error®
T, = (25¢3)°C

(T = (77£5)°F) +1 +1 +1 +1 %
(-I-T‘“a==+4‘rf;f;:::32:g 1 +1 +1 +1.5 %
Linearity error® 0.5 0.5 %
Harmonic distortions’
0.05Hz...100kHz < 44 <-52 <-52 <-52 dBc
100kHz...250kHz - < —-46 < -46 <46 dBc
>250kHz - - - <-38 dBc
Spurious signals (non-harmonic)®] <-83 < -86 <-90 <-90 dBFS

'The frequency response defines the frequency-dependent amplitude error, referred to the reference frequency of 1kHz.

2The noise-limited resclution is defined as the signal amplitude {rms} at which the signal-to-noise ratio is 0dB with 1Hz spectral
resolution, measured on 3M ScolchliteTape® {reflective film}).

3 The attainable resolution Is frequency-dependent and is specified for frequencies above 10Hz. In the frequency range from
10Hz to 5kHz the specifled decoder nolse is superimpesed by scanner noise. The resolution Is then between 0.1 and 1ym/is
with 1 Hz spectral resolution.

*The typical value refers to the center of the operating frequency range.
5 Condilions: sinusoidal vibration, f = 1kHz, amplitude 70% of full scale range, load resistance > 1MQ

5The linearily error is defined as the amplitude-dependent, relative devialion of the scaling factor, referred to the scaling factor
under calibration conditions (refer to footnote®).

" Harmonic distortions are defined 70% of full scale for the wanted signal. In each case the bandwidth is specified, in which the
distortion can occur.

3 The maximum amplitude of the distortion refers to the full scale. An exception of which is a single peak, generated by the
optical sensor, in the frequency region 20...25kHz, whose amplitude depends on the stand-off distance.
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Velocity Decoder VD-09 (Part 2 of 4, only PSV-400-M2, -M4 and -M2-20)

Measurement range 50 (LP) 50 100 (LP) 100 ans
Full scale (peak) 0.5 0.5 1 1 m/s
Frequency range
fin 0 0 0 0 Hz
frnax 250 1500 250 1500 kHz
Max. acceleration 80000 480000 160000 960000 g
Frequency response’
0.05Hz...100kHz 0.1 +0.1 +0.1 +0.1 dB
100kHz...250kHz +0.1/-1 +0.1 +0.1/-1 +0.1 dB
250kHz... 1 MHz ~ +0.2 - +0.2 dB
1MHz...1.5MHz - +0.2/-0.5 - +0.2/-0.5 dB
Resolution?
frequency-dependent? 0.04..0.2 | 0.04..0.35 | 0.07..0.4 | 0.06..04 | /77
typically* 0.06 0.18 0.1 0.2 LA
g;?f?;j‘zg‘,’;’)epe"dem phase -5.4 ~2.94 ~4.54 -2.94 °IkHz
Signal delay t; (typ.) 15.0 8.16 12.6 8,16 Hs
Calibration error®
(E : ((27322;";;) 1 +1 +1 +1 %
:T"::goc,;:: :gf:g +1 +1.5 +1 +1.5 %
Linearity error® 5 0.5 %
Harmonic distortions’
0.05Hz...100kHz <52 < -52 < -54 < -54 dBce
100kHz...250kHz < —-46 <-46 < --54 <54 dBc¢
>250kHz - <-36 - <-38 dBc
Spurious signals (non-harmonic)®| < -90 <-90 <-90 <-90 dBFS

' The frequency response defines the frequency-dependent amplitude error, referred to the reference frequency of 1kHz.

2The noise-limited resolution is defined as the signal amplitude (rms) at which the signal-to-noise ratio is 0dB with 1Hz spectral
resolution, measured on 3M ScotchliteTape® (reflective film).

3The aftainable resolution Is frequency-dependent and is specified for frequencies above 10Hz, In the frequency range from
10Hz to 5kHz the specified decoder noise is superimposed by scanner noise, The resolulion is then between 0.1 and 1pm/s

with 1 Hz spectral resolution,

*The typical value refers to the center of the operating frequency range.

5 Conditions: sinusoidat vibration, f = 1kHz, amplitude 70% of full scale range, Joad resistance > 1MQ

¢ The linearity error is defined as the amplitude-dependent, relative deviation of the scaling factor, referred to the scaling factor
under calibration conditions (refer to footnote® ).

T Harmonic distortions are defined 70% of full scale for the wanted signal. In each case the bandwidth is specified, in which the

distortion can occur.

8The maximum amplitude of the distortion refers to the full scale, An exception of which is a single peak, generated by the
optical sensor, in the frequency region 20...25kHz, whose amplitude depends on the stand-off distance.
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Velocity Decoder VD-09 {Part 3 of 4, only PSV-400-M2, -M4 and -M2-20)

Measurement range 200 (LP) 200 500 (LP) 500 VA%
Full scale (peak) 2 2 5 5 m/s
Frequency range
foin 0 0 0 0 Hz
foox 250 2500 250 2500 kHz
Max. acceleration 320000 3200000 800000 8000000 g
Frequency response’
0.05Hz...100kHz +0.1 +0.1 +0.1 +0.1 dB
100kHz...250kHz +0.1/-1 +0.1 +0.1/-1 £0.1 dB
250kHz...1MHz - +0.2 - +0.2 dB
1MHz...1.5MHz - +0.2 - +0.2 dB
1.6MHz...2.5MHz - +0.5/-1.5 - +0.5/-1.5 dB
Resolution?
frequency-dependent® 0.13...0.8 0.1...1 0.25...2 0.25...2 %m'/,jl-t_z
typically® 0.15 0.5 0.25 0.6 LUVALET:
:;;?‘;j'}g’;’)epe"de”t phase 475 ~1.35 ~2.10 ~1.34 */kHz
Signal delay t, (typ.) 13.2 3.76 5.83 3.73 Us
Calibration error®
(Tr B ((27322;% 1 1 £1 1 %
(TTE’;;S;O%:: :gg:g £1 1.5 £t £1.5 %
Linearity error® %
Harmonic distortions’
0.05Hz...100kHz <54 <54 <--54 <-54 dBc
100kHz...250kHz <-5H4 < -5H4 < -5H4 < -54 dBc
>250kHz - <-38 - <-36 dBc
Spurious signals {non-harmonic)®|  <-80 <-90 <-90 <90 dBFS

!"The frequency response defines the frequency-dependent amplitude error, referred to the reference frequency of tkHz.

2The noise-limiled resolution is defined as the signal amplitude {rms) at which the signal-to-noise ratio is 0dB with 1Hz spectral
resolution, measured on 3M ScotchliteTape® (reflective film),

3The attainable resolution is frequency-dependent and is specified for frequencies above 10Hz, In the frequency range from
10Hz to 5kHz the specified decoder noise is suparimposed by scanner noise. The resolution is then between 0.1 and 1pm/s

with 1Hz spectral resolution.

*The typical value refers to the center of the operating frequency range.

5 Conditions: sinuscidal vibration, f = 1kHz, amplitude 70% of full scale range, [oad resisiance > 1M

5The finearity error Is defined as the amplitude-dependent, relative deviation of the scaling faclor, referred to the scaling factor
under calibration conditions (refer to footnote®).

" Harmonic distortions are defined 70% of full scale for the wanted signal. In each case the bandwidth is specified, in which the

distartion can occur.

% The maximum amplitude of the distortion refers to the full scale. An exception of which is a single peak, generated by the
optical sensor, in the freguency region 20...25kHz, whose amplitude depends on the stand-off distance.

712




7 Technical Specifications

Velocity Decoder VD-09 (Part 4 of 4, only PSV-400-M2, -M4 and -M2-20)

Measurement range 1000 (LP) 1000 A
Full scale {peak) 10 10 m/s
Frequency range
frin 0 0 Hz
£ e 250 1500 kHz
Max. acceleration 1600000 9600000 g
Frequency response’
0.05Hz...100kHz +0.1 +0.1 dB
100kHz...250kHz +0.1/-1 +0.1 dB
250kHz... 1MHz - +0.2 dB
1MHz...1.5MHz - +0.2/-0.5 dB
Resolution?
frequency-dependent® 0.5..4 0.5..4 S VA
typicaliy® 0.5 0.7 CUVACT:
:;ief?::"(f;’piepe"dem phase 2,57 _2.14 °fkHz
Signal delay t; (typ.) 7.13 5.95 us
Calibration error®
= +3)°
(TT . ((?r?;,g;g) +1 +1 %
= +5°C...+40°
Linearity error® %
Harmonic distortions’
0.05Hz...100kHz <54 < -54 dBc
100kHz...250kHz <-54 <-50 dBc
>250kHz - <-38 dBec
Spurious signals (non-harmonic)® <-90 <-90 dBFS

' The frequency response defines the frequency-dependent amplitude error, refarred to the reference frequency of 1kHz.

2The noise-limited resolulion is defined as the signal amplitude {rms} at which the signal-to-noise ratio Is 0dB with 1Hz spectral
resolution, measured on 3M ScotchliteTape® (reftective film}.

3 The attainable resolution Is frequency-dependent and is specified for frequencies above 10Hz. In the frequency range from
10Hz to 5kHz the specified decoder noise is superimposed by scanner noise. The resolution is then between 0.1 and 1um/s

with 1Hz spectral resolution,
4 The typical value refers to the center of the operating frequency range.
5 Condltions: sinusoidal vibration, f = 1kHz, amplitude 70% of full scale range, load resistance = 1MQ

8 The linearity arror is defined as the amplitude-dependent, relative deviation of the scaling factor, referrad to the scaling factor
under calibration conditions (refer to footnote®).

? Harmonic distortions are defined 70% of full scale for the wanted signal. In each case the bandwidth is specified, in which the
distortion can occur,

8 The maximum amplitude of the distortion refers to the full scale. An exception of which is & single peak, generated by the
optical sensor, in the frequency region 20...25kHz, whose amplitude depends on the stand-off distance.
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Auxiliary Decoder VD-05 (Velocity Decoder, only PSV-400-M2-20)

Measurement range 100 500 A
Full scale {peak)
Nominal 0.5 2.5 m/s
Maximum 0.6 3 m/s
Frequency range m/s
fin 0.5 0.5 Hz
foax 10 10 MHz
Max. acceleration 320000 1600000 g
Frequency response’
0.5Hz...5MHz +0.2 +0.2 dB
5MHz... 10MHz +0.5 +0.5 dB
Resolution® <3 <3 %“/ iz
Puise response
Rise time tg4g <25 <25 ns
Signal delay t, <100 < 100 ns
QOvershoot <20 <20 %
Calibration error®
= +3)°
Linearity error* 2 2 %
Harmonic distortions <-35 <-35 dBc
Spurious signals (non-harmonic)® <-80 <-80 dBFS

' The frequency response defines the frequency-dependent amplitude error, referred fo the reference frequency of tkHz,

2The noise-limited resolution is defined as the signal amplitude (rms) at which the signal-to-noise ratio is 0dB with 1Hz spectral
resolution, measured on 3M ScotchliteTape® (reflective film). The attainable resolution is frequency-dependent. The typical
value refers to the center of the operating frequency range.

3 Conditions: sinuseidal vibration, f = 100kHz, amplitude 70% of full scale range, load resistance > 1MQ
4 The Hnearity error is defined as the amplitude-dependent, relative deviation of the scaling factor, referred to the scaling factor
under calibration conditions (refer to footnote®).

The maximum amplitude of the distortion refers to the full scale. The only exception to this is an individual peak generated by
the optical signal in the frequency range §... 10MHz, which can attain an amplitude of up to —60dBFS.
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Auxiliary Decoder DD-300 (Displacement Decoder, only PSV-400-M2-20)

Measurement range:
Frequency range:

Noise-limited
resolution:

Scaling factor:
Output swing:

Output impedance:
Load resistance:

NF suppression:

Pulse response:

Calibration error:

Amplitude frequency response:

Linearity error;

Spurious signals (non-
harmonic)?®

+75nm
30kHz...24MHz (-3d8)

< 0.02 pm/.J/Hz at 100% reflectivity

< 0.05 pm/.fHz when measuring on reflective film
{corresponding to 0.25nm (rms) at 20MHz analysis
bandwidth)

50nm/V at load resistance 50Q +1%
{(25nm/V at load resistance >10kQ)

+1.5V at load resistance 500
(£3V at load resistance >10k()

500

500 +1%"

Crossover freguency: typ. 30 kHz (-3dB)
Fraquency roll-off: -12dB/oct.
Propagation delay t;: < 140ns

Rise time tyg.g4° <25ns

Overshoot: < 20%

<+5%

{(sinusoidal vibration, frequency 500kHz, amplitude
50nm, load resistance 500)

refer also to FIGURE 7.1

BNC jack

AUXILIARY OUTPUT: +1dB
(50kHz...20MHz)

BNC jack

AUXILIARY UNIVERSAL:  +0.5/~1dB
(50kHz...2MHz)

<%2% to 60nm Peak, refer to FIGURE 7.2
<100pV (rms)

! The specifications apply for a load resistance of 50Q.With frequencies of less than 5MHz or if the pulse
has a slow steep rising edge respectively, the outputs can also be terminated with high impedance. in
this case the data given in brackets is for infermation purposes.

*Non-harmonic interference signals are independent of the wanted signal. When making measurements
on mirror-like surfaces two more peaks in the frequency range from 8MHz to 25MHMz with higher
amplitudes can occur, whose frequencies depend on the optical sensor.
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Harmonic Distortions

7 Technlcal Specifications

Vibration frequency

Vibration amplitude’

0..25nm; 25...50nm:
1MHz < -50dBc < -40dBc
5MHz <-50dBc < -37dBc
10MHz < -34dBc < -30dBc

'Harmonic distortions are produced from multiptes of vibration frequencies. They depend on the
frequency and the amplitude of the wanted signal. The maximum amplitude in dBc corresponds to the

amplitude of the base frequency.

7.2.5 Analog Low Pass and High Pass Filter

Low Pass Filter

For a typical amplitude and phase frequency response, refer to SECTION B.1

Filter type.

Cutoff frequencies:
Frequency roll-off:
Stop band attenuation:

High Pass Filter

Bessel 3rd order

5kHz, 20kHz, 100kHz {adjustable)
-60dB/dec = --18dB/oct

>70dB

For a typical amplitude and phase frequency response, refer to SECTION B.2

Filter type:

Cutoff frequency:
Frequency roll-off:
Stop band attenuation;

Butterworth 4th order
100Hz

—-80dB/dec = -24dB/oct
> 7048
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7.3 Junction Box PSV-E-401
7.3.1 General Data

Mains Connection

Mains voltage:: 100...240VAC +10%, 50/60Hz
Power consumption: max. 100VA

Fuses: 3.15A/slow-blow

Safety class: | {protective grounding)

Ambient Conditions

Operating temperature; +5°C...+40°C (41°F... 104°F)

Storage temperature; —10°C...+65°C {14°F... 149°F)

Relative humidity: max. 80%, non-condensing

Housing

Dimensions: 450 mm x 360mm x 135mm (19", 84HE/3U)
Weight: kg

7.3.2 Digital Interfaces

RS-232: 8 data bit, 1 stop bit, no parity;
Transfer rate: 115200Baud;
RS-232 (X) cable to the controller:
2 X 9-pin Sub-D jack, nuil modem cable {cross-wired)

Uss: Universal Serial Bus Type B;
Cable to the PC: 1 x USB Type A, 1 x USB Type B
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7.3.3 Analog Signal Inputs and Outputs

7 Technical Specifications

VELO, REF1 (REF2 and REF3 only PSV-400-H4 and M4)

PSV-400-H4/-B

PSV-400-M2/-M4

PSV-400-M2-20

Input voitage range
{adjustable in the software):

+100mV...£31.6V

+200mV.. . £10V

+200mV.. 210V

input impedance: 1TMQ TMQ 500 1MQ

parallel with 100pF |parallel with 100pF parallel with 100pF
Input coupling: AC/DC, adjustable in the software DC DC

AC -3dB cutoff frequency: 3.4Hz

Overvoltage protection: +42V (against damage) 5V .o +20V
Operaling modes:
Initial state Single-ended Single-ended Single-ended
(adjustable in the software) Differential Differential -

IEPE Mode (ICP®) REF1 (REF2 and REF3 only PSV-400-H4 and -M4):

Sensor supply:
Lower cutoff frequency:
Time constant:

Noise in the IEPE mode (ICP®) with PSY-400-H4 or -B:

nom. 4mA/24V, IEPE compatible {ICP®)
0.02Hz (-3dB), with DC coupling of the REF inputs
10s

Input voltage range Frequency Noise! (typ.}

1  Hz 39.8uV/fHz (—88dBV/./Hz)

10 Hz 10.0pV/J/Hz (-100dBV/J/Hz)

10V 100 Hz 6.3uV/JHz (—104dBV/J/Hz)
1  kHz 4.4uV/ifHz (-107dBV//Hz)

10  kHz 4.4uV/Hz (-107dBV/./Hz)

1 Hz 10uV//Hz (-100dBV/./Hz)

10 Hz 3.1pV/iHz (-110dBV//Hz)

1V 100 Hz 0.89uV/JHz (—121dBV//Hz)
1 kHz 0.70uV/J/Az (-123dBV//Hz)

10 kHz 0.70uV/JHz (-123dBV//Hz)

1  Hz 17.7uVIfHz  (-956dBV/.Hz)

10 Hz 2.8uV/iMHz (-111dBV//Az)

+100mV 100 Hz 0.56pV/MHz (~125dBV//Hz)
1 kHz 0.31uV//Hz (-130dBV//Hz}

10 kHz 0.31uV//Hz (-130dBV//Hz)

'The noise measurements were carried out with the ICP® sensor M352C65 connected.
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TRIG IN

PS8V -400-H4/-M2/-M4/-B PSV.400-M2-20
Compatibility: TTL TTL
Input voltage: max. +5.5V max. +7.0V
GATE IN

PSV-400-H4/-M2/-M4/-B PSV-400-M2-20
Compatibility: TTL -
Input voltage: max. +7.0V -
AUXIN

PSV-400-H4/-M2/-M4/-B PSV-400-M2-20
Compatibility: TTL TTL
Input voltage: max. +7.0V max. +7.0V

SIGNAL1, SIGNAL2, SIGNAL3 and SIGNAL4

PSV-400-H4/-M2/-M4/-B

PSV-400-M2-20

Output voltage swing: max. +5.5V max. £3V
Output current: max. 5 mA max. £50mA
Qutput impedance: 500 +10% 500 +10%

Short-circuit protection:

Permanently short-circuit proof

SYNC

PSV-400-H4/-M2/-M4/-B

PSV-400-M2-20

Compatibility:

TTL

TTL

Output voltage HIGH:

min. 4.35V (I, = 3.5mA)}

min. 3.8V (I, = 8MA)

Output voltage LOW:

max. 0.4V {l,,, = 5mA)

max. 0.4V (l,, = 8mA)

AUX OUT

PSV-400-H4/-M2/-M4/-B

PSV-400-M2-20

Compatibility:

TTL

TTL

Output voltage HIGH:

min. 2.4V (I, = 15mA)

min. 2.4V (I, = 15mA)

Qutput voltage LOW:

max. 0.5V (I, = 64mA)

max. 0.5V {l,,, = 64 mA)

S-VIDEO OUT

Video signat (Y/C:)

1V,, 750
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7.4 Junction Box PSV-E-408 (optional, only PSV-400-H4)
7.4.1 General Data

Ambient Conditions

Operating temperature:; +5°C...+40°C (41°F... 104°F)
Storage temperature: -10°C...+65°C (14°F... 149°F)
Relative humidity: max. 80%, non-condensing
Housing

Dimensions: 482m x 303mm x 23mm
Weight: 1.5kg

7.4.2 Analog Signal Inputs

REF 21, REF 22, REF 23 and REF 24

Input voitage range: +100mV...£31.6V, adjustable in the software
Input impedance: 1 MQ paraliel with 100pF
Input coupling: AC/DC, adjustable in the software

AC -3dB cutoff frequency: 3.4Hz
Overvoltage protection: +42V (against damage)
Operating modes: Singte-ended (initial state)

Differential {adjustable in the software)

IEPE Mode (ICP®) REF 21, REF 22, REF 23 and REF 24:

Sensor supply: nom. 4mAJ/24V, IEPE compatible (ICP®)
Lower cutoff frequency: 0.02Hz (-3dB), with DC coupling of the REF inpuis
Time constant; 10s

Noise in the [EPE mode {ICP®):

Input voltage range Frequency Noise' {typ.)
1 Hz 30.8UV//Hz  (-88dBV/JHz)
10 Hz 10.0uV//Hz (-100dBV/J/Az)
£10V 100 Hz 6.3uV/Jfz (~104dBV//Az)
1 kHz 4.4uV/MHz (—107dBV/./Hz)
10 kHz 4.4V /JHz (-107dBV//Hz)
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Input voltage range Frequency Noise' (typ.)

1 Hz 10pV/.fHz (-100dBV/./Hz)

10 Hz 3.1uVI/Az (-110dBV//Hz)

1V 100 Hz 0.89uV/yHz (-121dBV/./Hz)
1  kHz 0.70uV/yHz (-123dBV/./Hz)

10 kHz 0.70pV//Hz (-123dBV/./Hz)

1 Hz 17.7uV//Hz  (-95dBV//Hz)

10 Hz 2.8uVifHz (-111dBV/./Hz)

+100mV 100 Hz 0.56uV//Hz (-125dBV/J/Hz)
1 kHz 0.31uV/IMHz (-130dBV/J/Hz)

10 kHz 0.31uV//MHz (-130dBV//Hz)

*The noise measurements were carried out with the ICP® sensor M352C65 connected.

7.5 PC PSV-W-401

7.5.1 General Data

Mains Connection

Mains voltage::
Power consumption:
Safety class:

Ambient Conditions

Operating temperature:
Storage temperature:
Relative humidity:

Housing

Dimensions:
Weight:

7.5.2 PC Configuration

7-22

Industrial PC

Processor;

Hard disk drive (HDD);
Operating system:
Network connector:
DVD recorder:

100...240VAC £10%, 50/60Hz
max. 350VA
| {protective grounding)

+5°C...+40°C (41°F... 104°F)
—10°C...+65°C (14°F... 149°F)
max. 80%, non-condensing

450mm x 550mm x 190mm (19", 84HE/4 U}
18kg

min. AMD Athlon™ XP3000+; 2.6 GHz; 1 GByte RAM
> 120GB

Microsoft® Windows® XP or 2000

Ethernet

Refer to manual of the manufacturer




7.5.3 Data Acquisition

7 Technical Specificatlons

PSV-400-H4

PSV model High frequency model BF;SS}::-4rgg-ciii
4 (8) channels
Data acquisition hoard PCl-4462 (+PCl-4462)' PCI-4461
input channels (simultaneous) 4 (8) 2
Resolution 24 bit 24 bit
Maximum bandwidth 80kHz 40kHz
Internal function generator PCI-67 11 (integrated)
Output channels 4 {1)
Resolution 12bit (24 bit)
Maximum bandwidth 80kHz {20kHz}
" The designations in brackels are available as an option.
PSV-400-M2 PSV-400-M4
PSV model High frequency model High frequency model
2 channels 4 channels
Data acquisition board PCi-6111 PCI-6110
Input channels (simuitaneous) 2 4

Resolution

12... 16bit effectively
{depending on the bandwidth)

12...16bit effectively
(depending on the bandwidth)

Maximum bandwidth 1MHz (2MHz)' 1MHz (2MHz)
Internal function generator integrated integrated
Qutput channels 1 1
Resolution 16bit 16bit
Maximum bandwidth 500kHz 500kHz

T The designations in brackets are availabl

e as an oplion

PSV-400-M2-20

PSV model High frequency model 2
channels (max. 20 MHz)

Data acquisition board ML3025
Input channels (simultaneous) 2
Reselution 12bit
Maximum bandwidth 40MHz
Internal function generator M1.6030
Output channels 1
Resolution 14 bit
Maxtmum bandwidth 40MHz

You will find detailed information in the manual of the data acquisition board
or the generator board respectively which is installed on the PC.
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7.6 Scanning Head PSV-1-400

7.6.1 General Data

7-24

Laser

Laser type::
Wavelength:
Cavity length:
Laser class:
Laser power:

Electrical Data

Power consumption:;
Carrier frequency:

Ambient Conditions

Operating temperature:
Storage temperaiure:
Relative humidity:

Housing

Dimensions:
Weight:

Helium neon
633nm
204mm £1mm
2

<1mwW

approx. 256W (average value)
40MHz

+5°C...+40°C {(41°F... 104°F)
—10°C...+65°C (14°F... 149°F)
max. 80 %, non-condensing

Refer to FIGURE 7.3
T7kg
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Dimensions
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Figure 7.3: Views of the scanning head PSV-I-400 (Dimensions not specified are given in mm.)
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7.6.2 Optics

7-26

Front lens model!

Long Range (LR)

Mid Range {(MR)

Focal length [mm] 100 60
Minimum stand-off distance [mm] 350 40
Aperture diameter (1/e?) [mm] 10...1 2..66
Spot diameter (typ.) [um}
@ 100 mm - 31
@ 200 mm . 41
@ 500 mm 33 73
@ 1000 mm 74 132
@ 2000 mm 147 255
@ 3000 mm 222 376
@ 5000 mm 368 624
@ each additional meter plus 74 126

Visibility maxima?

99mm + (n - 1);
n=01,2..;1=20dmmt1mm

* A label shows the front fens madels which is fitted. The label for the front lens modet is affixed on the
bottom side of the scanning head (refer to FIGURE 7.4}

2 Measured from the front panel of the scanning head {refer to FIGURE 7.3}

Label for the
front lens model

O
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Figure 7.4: Position of the labe! for the front lens modet




7 Technical Specifications

Table of the Visibility Maxima

Visibility Maxima (in mm) for | = 204mm

99 1731 3363 4995 6627 8259
303 1935 3567 5199 6831 8463
507 2139 3771 5403 7035 8667
711 2343 3975 5607 7239 8871
915 2547 4179 5811 7443 9075
119 2751 4383 6015 7647 8279
1323 2955 4587 6219 7851 9483
1627 3159 4791 6423 8055

7.6.3 Scanner

Type: Servo-controlled galvo motor
Maximum deflection: Horizontal: +20°
Vertical: +20°
Anguiar resolution: < (0.002°
Point stability: < 0.01°/hour {after warm-up)

7.6.4 Video Camera

Video system: CCIR/PAL
Sensor: Color CCD 1/4", 752x582 pixel
Signal-to-noise ratio: > 50dB
Zoom: 72 x {4x digital zoom)
Lens: F1,4/f=41..73mm, auto focus, aufo iris
18-fold motor-driven zoom
Angle of view {(horizontal):. @ wide end: approx. 48°
@ max. tele end: approx, 2.7°
Minimum stand-off distance: @ wide end: 10mm
@ max. tele end: 800mm
Minimum illumination: 3 Lux
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7.7 System Cabinet PSV-A-010

Housing

Dimensions:
Weight:

600m x 900 mm x 750mm

102kg {including all instruments and cables, without
scanning head and monitor)

7.8 Motorized Pan-Tilt Stage PSV-A-T11 (optional)

7.8.1 General Data

Mains Connection

Mains voltage:

Power consumption:
Safety class:

Ambient Conditions

Operating temperature:
Relative humidity:

Housing

Dimensions:
Weight:

7.8.2 Movement

Maximum angte of rotation:

Backlash:
Rotation velacily:

Max. load:

7-28

115/230VAC, 50/60Hz,

adjustable on the connection box
approx. 30W (temporary)

| {protective grounding)

—20°C...+50°C (-4°F...122°F)
max. 95%, non-condensing

Top mount: 276 mm x 149mm x 286 mm

12kg

Pan (horizontal):
Tilt {vertical}:

+90°
+84° (limited by limit switch)

+0.5° (testing moment 10Nm)

Horizontal:
Vertical:
18kg

6°/sec.
5°/sec.



A Optional Accessory for the Scanning Head PSV-1-400

Appendix A: Optional Accessory for the Scanning Head PSV-1-400

A.1 Scanning Head with Geometry Scan Unit PSV-A-420

A.1.1 Safety Information

Laser warning
labels

Before using the scanning head with scan unit, please pay also attention to
the advice on laser safety and electrical safety in CHAPTER 1.

The laser warning labels for the scanning head with geometry scan unit are
shown in FIGURE A.1. In the countries of the European Union (EU), label 2 is
affixed in the language of the customer's country (refer to the right).

Laser Radiation
Do not stare into beam
1 Class 2 Laser Product
2 i According to IEC/EN 60825-1 (2001)

Laserstrahlung

Nicht in den Strahl blicken
Laser Klasse 2

Nach EN 60825-1 (2001)

| P <tmwiow; 2 =620-700 nm

E| Complies with 21 CFR 1040.10 and 1040.11 [
; except for devialions pursuant to ;
Laser Notice no, 50, dated 26 Juty 2001

Figure A.1: laser warning labels for the scanning head with geometry scan unit
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A Optlonal Accessory for the Scanning Head PSV-I-400

Position of the  The position of the laser warning labels on the scanning head with geometry

Eageg warning scan unit is shown in FIGURE A.2.
ahels

Figure A.2; Position of the lager warning labels on the scanning head with geometry scan
unit

A.1.2 Introduction

With the aid of the geometry of the geometry scan unit you can determine
exactly the distance to the object under investigation. If you want {o make a
geometric scan, the vibrometer laser is switched to the geometry laser and
the position of the object under investigation will be determined. The
geometry scan unit is shown in FIGURE A.3. In case of a signal overrange you
can reduce the laser power via a filter. This filter is only controlied via the PSV
software.

Figure A.3: Scanning head with geometry scan unit PSV-A-420
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A.1.3 Control Elements

The control elements of the scanning head with geometry scan unit are shown
in FIGURE A.4.
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Figure A.4: Bottom view of the scanning head with geometry scan unit

1 Label for the front lens model
On this labal, it is marked which front lens model is instailed.

2 ldentification label

On the identification 1abel you will find, among other things, the serial
number of the scanning head.

3 Mounting thread M6

With the two mounting threads the scanning head can be assembled on
an adapter plate. You will find the dimensions of the mounting threads in
the technical drawing in 7.6.

NOTE |

The mounting screws of the scanning head have to be tighten only with
maximal 1,5Nm olherwise the laser beam Interference of the scanning head
with the geometry scan unit can be disturbed!

4 Mounting thread 1/4"-20UNC

Using the mounting thread, the scanning head can be mounted on stable
camera tripods with thread basing on inch-system.
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5

Mounting thread for hexagonal quick release plate

Using these mounting threads, the hexagonal quick release plate can be
mounted on the scanning head, e.g. for mounting the scanning head on a
tripod with fluid stage.

PAN-TILT connector for the optional pan-tilt stage (7-pin circular jack)

Connector for the connecting cable to the optional pan-tilt stage PSV-A-
T11 to control the pan-tilt stage via the software

Identification label

On the identification fabel you will find, among other things, the serial
number of the instrument

Label for geo offset distance

On the label the difference between the theoretic and real beam path in
the scanning head is entered. The value is in the area of max. 3 mm. You
must enter this value in the PSV software under Offset Distance. See your
software manual on this.

A.1.4 Functional Test

A-4

For an initial functional test of the scanning head with geometry scan unit, you
proceed as follows:

1.
2.

First carry out a functional test with your PSV as described in SECTION 3.5.

Now make a distance measurement with the scanning head with scan
unit, as described in your software manual.

Use a measuring tape to measure the stand-off distance (distance
between scanning head and object, refer also to FIGURE 7.3) and compare
it with the distance determined by the software.

If the functional test has been successful you can now make measurements
with the PSV as described in CHAPTER 4, CHAPTER 5 and your software
manual. Remember that the PSV reaches its optimal properties after a warm-
up period of approx. 20 minutes.

If your PSV does not perform as described above, read through the
information on fault diagnosis provided in CHAPTER 8, if necessary, contact
your focal Polytec representative.



A.1.5 Technical Specifications

General Data

Laser

Laser type:
Wavslength:
Laser class:
Laser power:

Accuracy of the measurement
distance:

Max. distance between the
focal points of the two laser
beams:

Ambient Conditions

Operating temperature:
Storage temperature:
Relative humidity:

Housing

Dimensions:
Weight:

A Optional Accessory for the Scanning Head PSV-1-400

Laser diode
620...680nm
2

<1mW

+2.5mm

<5mm (20)
it will not be necessarily measured in the focal points
of the laser beams,

+5°C...+40°C (41°F... 104°F)
—10°C...+65°C (14°F... 149°F)
max. 80%, non-condensing

Refer to FIGURE A.5
7.6kg
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Dimensions
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Figure A.5: Views of the scanning head with geomeiry scan unit {dimensions not specified are given in mm)}

Filter The intensity of the laser beam is reduced to 1% by switching on the filter of
(neutral filter)  the geometry scan unit. The filter is required in the case of the signal
overrange on high-reflective surface.

NOTE !

Switching on the filter occurs only via the PSV software {refer to software
manual}!

Laser power (FILTER OFF). <imWw
(FILTER ON):  approx. 10pW
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A.2 Close-up Unit PSV-A-410 with Appropriate Accessory

A.2.1 Close-up Unit PSV-A-410-97 or PSV-A-410-99

You can scan small objects at short distance using the close-up unit shown in
FIGURE A.B. Thereby the beam path of the laser is overiaid to the video image
to equalize the parallax error.

410
ghins ﬂ,’k

s S @CWW '
Ll

Figure A.8: Close-up unit PSV-A-410

To ensure a clearly visible laser spot on the video image, only small part of the
laser light is used for the video camera. The size of the that part depends on
the backscattering properties of the surface. Two modeis of the close-up unit
are available which have different special coated beam splitters:

+ PSV-A-410-97 for mat surfaces (reduced the intensity of the laser light by
97%)

*  PSV-A-410-99 for highly reflective surfaces (reduced the intensity of the
laser light by 99,8%)

Assembly of the Close-up Unit

For transportation the close-up unit is secured on the back with the a
transparent perspex plate. For mounting the close-up unit, you proceed as
follows:

1. Before mounting, undo the perspex plate and keep it in a safe place.

2. If required first screw the close-up unit lenses or the block filter (refer to
SECTION A.2.2) to the camera aperture of the scanning head.

3. Fix the close-up unit on the front of the scanning head using the two
knurled screws.

CAUTION !
PBanger from mounting error! - Pay attention to the correct fit of the

precision pins and only hand-tighten the knurled screws!

AT



A Optional Accessory for the Scanning Head PSV-1-400

NOTE |

Hand-tighten means: Tighten the screw firmly that it can not loosen itseli. Do
not use excessive force and avoid serious damage of thread.

Figure A.7: Mounting the close-up-unit

Close-up Lenses

Together with the close-up unit set of close-up lenses with different focal
distance (1, 2 and 4 diopters) is delivered. A maximum of fwo close-up lenses
or one close-up lens and the block filter can be mounted. The close-up lenses
are also screwed directly to the camera aperture of the scanning head before
mounting the close-up unit. The stand-off distance and the scan fields of the
close-up lenses and of combinations of the lenses are shown in TABLE A.1.

Table A.1: Stand-off distance and scan fields of the close-up lenses

Lens or | Stand-off | Min.scan | Nom.scan | Max. scan Fo.cus pOi;‘t
combination | distance' | field (X x Y) | field? (Xx Y) [ field (xx v} [ dlamefer LR
Diopters mm mm mm mm um
2 320...450 x4 20 x 16 70 x 55 67 25
2+1 250...350 4%x3 16x8 60 x 45 56 -
4 200...260 3x24 12 x 10 50 x 40 49 -
4+ 1 175...215 25x2 10x8 45 x 34 45 -
4+2 152...175 2x16 3x6.4 40 x 30 41 -
' Measured from the froni panel of the scanning head
2 At 18 x opticat zoom
SWith front tens MR
Technical Specifications
Max, scan angle in x direction: +5°
Max. scan angle in y direction: +4°
Dimensions: 124 mm x 90mm x 75mm and FIGURE A.8

A-8

Weight: 0.35kg
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A Optional Accessory for the Scanning Head PSV-1-400

A.2.2 Block Filter PSV-A-HNeBF

If the intensity of the laser light is still too high the supplied helium neon block
filter should be mounted additionally. The block filter is screwed directly to the
camera aperture of the scanning head and reduces once more the intensity of
the laser light back scattered to the video camera by 98%.

A.2.3 Micro Scan Lenses PSV-A-CL-xxx

A-10

By attaching the micro scan lenses, scan fields down to 1mm x 1.2mm are
achieved at a fixed stand-off distance. The specialty of the micro scan lenses
is that the laser beam nearly perpendicular meets the measurement surface
as also shown in FIGURE A.9 for the PSV-A-CL-150, Without loss of signal
quality, mirror like objects can be scanned up to a tilt of £4°.

Scanner mirrors Micro scan lense Object

Figure A.9: Function principle of the micro scan lenses

Assembly

Undo the protective cap of the objective of the close-up unit and screw the
micro scan lens onto the objective.
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Technical Specifications

The stand-off distance and scan field of the different micro scan lenses are
shown in TABLE A.2. The nominal scan field values are suitable for orientation.
Stronger zoom is achieved by interpolation which might reduce the quality of
the video image.

Table A.2: Stand-off distance and scan field of the micro scan lenses

Micro scan | Stand-off ’Min. scan Nom. scan !\hax. scan Spot Depth of field
lens distance’ | field (X x Y) | field* (X x Y) | field (Xx Y) | diameter®
PSV-A- mm mm mm mm pm
CL-80 160 1.2x1.0 5x4 14 x 10 7 0.4
CL-150 230 1.8x1.3 7x5 23 x 17 13 1.3
CL-~300 380 26x3.5 10x 14 46 x 35 25 5.0

! Measured from the front panel of the scanning head

2 At 18 x optical zoom

3With front lens MR

A.2.4 Fiber-Optic Ring Light PSV-A-RLight

To enhance the quality of the video image the optional fiber-optic ring-light
can be mounted on the micro scan lenses PSV-A-CL-80 and PSV-A-CL-150.

Assembly
For mounting the ring-light, you proceed as follows:

1. Mount the ring light on the micro scan lens and hand-tighten the knurled
screw.

NOTE |

Hand-tighten means: Tighten the screw firmly that it can not loosen itself, Do
not use excessive force and avoid serious damage of thread.

2. Undo the protective cap from the another end of the fiber cable.

3. Insert the fiber cable into the "Modulamp’ receptacle of the light source
and tighten the fiber optic positioning thumbscrew.

WARNING |

banger from high intense lightl - Never tock directly at the ring light when
the fight source is switched on !

For more information above the light source, please refer to the user manual
of the manufacturer.

A-11
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A.3 Test Stand PSV-A-T18

You can adjust the stand-off distance of the mounted scanning head precisely
using the test stand. The test stand is especially suitable for scanning very
small parts with the close-up unit on the scanning head. The vertical and the
horizontal test stand are shown in FIGURE A.10 and FIGURE A.11.

The test stand PSV-A-T18 is made up of:

* Motorized 3-stage telescope drive

* Adapter plate for the PSV-1-400 scanning head
¢ Drive control

¢ Hand set

Figure A.10:Vertical test stand with scanning head and close-up unit mounted
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Figure A.11:Horizontal test stand with scanning head and close-up unit mounted

Assembly of the Vertical Test Stand

For mounting the scanning head at the telescope drive, you proceed as
follows:

1. Fix the telescope drive at the measurement location using 7 screws of the
assembly kit (refer to FIGURE A.12, picture 1).
Use either the metric screws or the separately packed screws with
thread basing on inch-system (1/4-20x 1/2" UNC),

2. If applicable, undo the quick release hexagonal plate or the mounting
plate for the pan-tilt stage from the scanning head.



A Optional Accessory for the Scanning Head PSV-1-400

l

® ®

@

Figure A.12:Mounting the scanning head to the telescope drive of the vertical test stand

3. Attach the adapter plate on the underside of the scanning head as shown

in FIGURE A.12, picture 2.

4, Hang up the scanning head with the adapter plate above at the telescope

drive (refer to FIGURE A.12, picture 3).

5. Secure the scanning head by fixing the adapter plate to the telescope
drive using 2 Allen screws (refer to FIGURE A.12, picture 4).

Assembly of the Horizontal Test Stand

For mounting the scanning head at the telescope drive, you proceed as

follows (refer to FIGURE A.13):

1. Fix the telescope drive at the measurement location using 7 screws of the

assembiy kit.

Use either the metric screws or the separately packed screws with

thread basing on inch-system (1/4-20x 1/2" UNC).

2. If applicable, undo the quick release hexagonal plate or the mounting

plate for the pan-tilt stage from the scanning head.
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Adapler plate\

Salfety screws-._

LY

Telescopa drive..

" Fixing screws

Figure A.13:Assembly of the horizontal test stand

3. Attach the adapter plate on the underside of the scanning head using the
2 fixing screws.

4. Hang up the scanning head with the adapter plate above the telescope
drive.

5. Secure the scanning head by fixing the adapter plate to the telescope
drive using 2 safety screws.

Cabling
For the electrical connection of the test stand, you proceed as follows:

1. Connect the cable of the telescope drive to the motor connection 3 of the
drive control in FIGURE A.14.

2. Plug the hand set cable into the Sub-D jack 2 in FIGURE A.14.

3. Plug the mains cable into connection 1 of the drive coniroi and into an
earthed sockst.

PP
Y A
) & 90000

— -

Figure A.14:Connection of the drive control
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4, To move the scanning head upstairs, press the arrow key T on the hand
set. Move the scanning head downstairs by pressing the arrow key 4 on

the hand set.

5. If you press the arrow key for more the approximately 2 seconds, the
motor switches over to fast mode. Afier approximately 3 seconds the
motor reaches its maximum velocity. For fine positioning, the arrow key
can be repeatedly pressed briefly.

Technical Specifications

Drive Control

Mains voltage:

Output power:
Protection rating:
Operating temperature:
Dimensions:

Weight:

Telescope Drive

Protection rating:

Operating temperature:
Operating time - intermittent:
Operating time - continuous:
Velocity stages:

Max. velocity:

Min. travel:

Max. travel:

Dimensions:

Weight:

240V/50Hz or 115V/50-60Hz
24V DC/5A

IP66

0°C...+40°C (32°F... 104°F)
130m x 80mm x 360mm
2.9kg

IP30

+10°C...+40°C (580°F... 104°F)
max. tmin. (9min. break)
max. 2.5min.

3

5.5mm/s

approx. 0.1mm

300mm

180mm X 180mm x 520 mm (+ 300mm throw),
refer also to FIGURE A.15 and FIGURE A.16

13.8kg vertical test stand
16 kg horizontal test stand



Dimensions of the Vertical Test Stand
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Do not bring any parts of the body
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Dimensions of the Horizontal Test Stand
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Figure A.16:View of the horizontal test stand with scanning head {Dimensions not specified are given in mm)
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Appendix B: Basics of the Measurement Procedure

B.1 Theory of Interferometric Velocity and Displacement Measurement

Optical interference can be ohserved when two coherent light beams are
made coincide. The resulting intensity e.g. on a photo detector varies with the
phase difference ¢ between the two beams according to the equation

(@) = Iﬂz‘i'i‘ -(1+cose) Equation B.1

The phase difference ¢ is a function of the optical path difference L between
the two beams according to

@ = 2n-}kL Equation B.2

where A is the laser wavelength.

if one of the two beams is scattered back from a moving object (the object
beam), the path difference becomes a function of time L = L(t). The
interference fringe pattern moves on the detector and the displacement of the
object can be determined using directionally sensitive counting of the passing
fringe pattern.

The velocity component in the direction of the object beam is a function of the
path difference L according to

CMEHD = y(t) 2 Equation B.3

For a constant movement v applies

'dLgt! - X lde| - fo-A =V -2 Equation B.4
dt | 27 |dt
with

fy =2 I%l Equation B.5

Thus a movement of the object causes a frequency shift at the object beam
which is called Doppler shift f,. Superimposing object beam and internal
reference beam, i.e, two electromagnetic waves with slightly different
frequencies, generates a beat frequency at the detector which is equal to the
Doppler shift. The equation B.5 to determine the velocity is, however
independent of its sign. The direction of the velocity can be determined by
introducing an additional fixed frequency shift fg in the interferometer to which
the Doppler shift is added with the correct sign.

Thus the resulting frequency at the detector f_,, is given by

v

med = fB+2.K

Equation B.6

B-1



B Basics of the Measurement Proceture

Interferometers of this type which are directionally sensitive are described as
heterodyne.

B.2 Optical Configuration in the PSV-1-400 Scanning Head

In Polytec’s vibrometers, the velocity and displacement measurement is
carried out using a modified Mach-Zehnder interferometer.

The optical configuration of the scanning head is shown in FIGURE B.1.

Laser BSA1 BS 2 A4 Lens ((( )
(j} Object Beam @
Reference | Scanner Object
Beam Mirrors
Bragg Cell
Prism BS 3

9 Petector

Figure B.1: Optical configuration in the scanning head

The light source is a helium neon laser which provides a linear polarized
beam. The polarized beam splitter BS1 splits the beam into the object heam
and the reference beam.

The object beam passes through the polarizing beam splitter BS2 as well as a
A4 plate, is then focused by the lens on the objects and scattered back from
there. The polarizing beam splitter BS2 then functions as an optical
directional coupler together with the A/4 plate, and deflects the object beam to
the beam splitter BS3. The interference signal occur out of the optical path
difference between reference and laser beam. The distance to the object goes
into the optical path difference with a factor of 2. Optional the objective
displays the object at the camera. If the spot diameter on the object is
minimal, the video image is sharply focused,

The Bragg cell in the reference arm of the interferometer generates the
additional frequency offset to determine the sign of the velocity.

The resulting interference signal of the object beam and the reference beam
is converted into an electrical sign in the photo detector and subsequently
decoded in the controller.
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Appendix C: Filter Diagrams of the OFV-5000 Controller

C.1 Low Pass Filter with 3rd Order Bessel Characteristics

The frequency is normalized to the cutoff frequency f..
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Figure C.1: Ampliiude frequency response of a 3rd order Bessel fow pass filter
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Figure G.2: Amplitude error of the low pass filter in the pass band
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Figure C.3: Phase frequency response of the low pass filter in the pass band
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C.2 High Pass Filter of the Type 4th Order Butterworth

The frequency is normalized to the cutoff frequency f..
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Figure C.4: Amplitude frequency response of a 4th order Butterworth high pass filter
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Figure C.5: Amplitude error of the high pass filter in the pass band
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Figure C.6: Phase frequency response of the high pass filter in the pass band
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Appendix D: Declaration of Conformity

Konformitédtsbescheinigung / Declaration of Conformity

fir { for

Goegenstand / Object : Scanning Vibrometer
PSV 400-B / PSV 400-H4 [ PSV 400-M2 / PSV 400-M4

Scanning Head Typ { Mode! ; PSV-1-400

Geometry Scan Unit Typ / Model: PSV-A-420

Controlier Typ / Mode! : QFV-5000
Junction Box Typ / Model : PSV-E-401
Data Management System ! P3V.W.402

Der Hersteller f The manufaciurer
Polytec GmbH
Polyteo Platz 1-7
76337 Waldbronn / Germany

hastétigt das Einhalten der Richtiinlen 2004/108/EG und 2006/95/EG
confirms tho compliance with the directives 2004/108/EC and 2006/95/EC.

Das Gerdt stimmt dbsrein mit den folgenden Narmen f The unit complies to the following standards:

EN 60826-1:2003-10 Sicherhell von Laser-Einrichtungen / Safely of laser producls

EN §1010-1:2002-08 Sicherhaitshestimmungen {lir elekirische Mess-, Steuer-, Regel- und Laborgerite /
Safety requirements for electrical eguipment for meastrement, conlrol an!
laboratory use

EN 613268-1:2006-10 EMV-Anforderungen an die Storaussendung und Stérfestigkeit -
Elekirische Betrisbamitte! fir Messtechnlk, Leiltechnik und Laborcinsatz /
EMC requirements on the Emission and Immunity —
Elecirical equipment for measurement, control and laboratory use

Stdraussendung / Emission :
- Grenzwertklasse: Klasse B/ Class B
- EN 61000-3-2, EN 61000-3-3

Stdrfestigkelt / immunity
EN 61000-4-2, EN 61000-4-3, EN 81000-4-4, EN 61000-4-8, EN 61000-4-6,
EN 61000-4-11

Ausgestelit von / fssued by

od Stld

Dr. Helmut Selbach
Managing Director 23.01.2008
Polytec GmbH Daturm f Date

Figure D.1: Declaration of conformity for the PSV-400
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DD-300 7-15
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SIGNAL1, on the junction box 3-9
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assembly
close-up unit A-7
conditions for the scanning head 3-2
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fluid stage 3-29
horizontal test stand A-14
micro scan lenses A-10
pan-tilt stage 3-29
scanning head 3-28
vertical test stand A-13
Auto Focus, function on the controller 5-18
auxiliary decoder
DD-300, controller specifications 7-15
VD-05, controller specifications 7-14
AV connector
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an the PC model -M2-20 3-22
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PC model-M2/-M4, control elements 3-19
PC model-M2-20, control element 3-21
PC modsls -H4/-B, control element 3-15
scanning head, control etement 3-26
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selecting 5-28
specifications 7-2
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blocking the laser beam 5-1
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beating B-1
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Bessel characteristics 3rd order
description 4-9
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block filter, description A-10
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bottom view scanning head, control element 3-27
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brief description
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description 4-11
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cabling
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assembly A-7
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connecting cables, operating requiremants 3-2
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on ihe controller 3-7
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on the PC model -M2-20 3-22
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PC modals -H4/-B, back panel 3-15
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configuring RS-232 interface 5-28
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signal flow, schematic 2-2
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modifying 5-7
savefload 5-25
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analag low pass and high pass filter 7-17
auxiliary decoder DD-300 7-15
auxiliary decoder VD-05 7-14
AUXILIARY OUTPUT 7-2
AUXILIARY UNIVERSAL 7.2
Calibration 7-1
DISPLACEMENT OUTPUT 7-3
DISPLACEMENT TRIG IN 7-3
housing 7-1

mains connection 7-1

SIGNAL 7-3

velocity decoder VD-03 7-4
velocity decoder VD-04 7-5
velocity decoder VD-07 7-6
velocity decoder VD-08 7-8
velocity decoder VD-09 7-10
VELOCITY DSP QUT 7-2
VELOCITY OUTPUT 7-2



Index

cooling
air vents, on the junction box PSV-E-408 3-12
air vents, on the PC model -M2/-M4 3-20
air vents, on the PC model -M2-20 3-22
air vents, on the PC model-H4/-B 3-17
cooling fan, on the controller 3-6
cooling fan, on the junction box PSV-E-

401 3-10

cooling fan, on the PC front panel 3-14
cooling fan, on the PC model -H4/-B 3-17
cooling fan, on the PC model -M2/-M4 3-20
cooling fan, on the PC model -M2-20 3-23
system components 3-2

cooling fan
on the controller 3-6
on the junction box PSV-E-401 3-10
on the PC front pane!l 3-14
on the PC model -M2/-M4, back panel 3-20
on the PC model -M2-20, back panel 3-23
on the PC model-H4/-B, back panel 3-17

D
damage 3-2
data acquisition board
fault diagnosis, no measurement signal 6-4
MI.3025, connectors in detail 3-23
PCl1-4461, control elements 3-17
PCI-4462, control elemenis 3-18
specifications 7-23
data acquisition, PC specifications 7-23
data rate set, on the controlier 5-24
declaration of conformity
geometry scan unit D-1
PSV D-1
decoder
available 2-3
description 4-3
description
decoder 4-3
P3V models 2-4
system components 2-1
detergent solution 3-3
DIFF LED
on the junction box PSV-£-408 3-12
differential input
dispfay on the junction box PSV-E-401 3-8
disptay on the junction box PSV-E-408 3-12
DIFF-LED
on the junction box PSV-E-401 3-8
digital decoder
data rate set, on the controller 5-24
S/P-DIF data, deactivate on the controller 5-23
switch off, on the controlier 5-23
use output signals, on the controller 5-24

dimensions
close-up unit A9
controller 7-1
horizontal test stand A-18
junction box PSV-E-401 7-18
junction box PSV-E-408 7-21
pan-tit stage 7-28
PC 722
scanning head 7-25
scanning head with geometry scan unit A-6
system cabinet 7-28
vertical {est stand A-17
direction convention 3-47
disinfectant solutions 3-3
disk drive, on the PC 3-15
displacement acquisition
interferometric B8-1
displacement decoder
brief description 2-3
DD-300, controller specifications 7-15
description 4-5
low pass filter 4-5
noise 4-5
output signal 4-5
tracking filter 4-5
displacement signal, on the controller 3-5
display
description of the confroller 5-15
list for messages, on the controller 6-5
messages, on the controller 5-27
on the controller 3-4
display SIGNAL LEVEL, on the scanning
head 3-26
disposal of the instrument 1-1
doppter frequency B-1
drill holes, on the scanning head 3-25
drive
disk drive, on the PC 3-15
DVD recorder, on the PC 3-14
DVD recorder
on the PC 3-14
PC, specifications 7-22

E
electrical data, scanning head specifications 7-24
slectrical safety
safety information 1-56
standards applied 7-1
EMC, standards applied 7-1
emission, EMC standards 7-1
error messages
list for error 6-6
on the display of the controller 5-27
on the display, fauit diagnosis 6-5



ethernet network
connector, on the PC model -M2/-20 3-22
connector, on the PC model -M2/-M4 3-20
connector, on the PC models -H4/-B 3-16

EU countries
laser warning lahels on the scanning head 1-4
laser warning labels on the scanning head with

geometry scan unit A-2
EU directives, compliance D1

F
fastener for the geomeiry scan unit, on the
scanning head 3-26
fault description 6-1
fault diagnosis
general tests 6-1
hand set 6-4
information on 6-1
list for advice, on the controller 6-5
list for errors, on the controller 6-6
list for warnings, on the controller 6-6
messages on the display of the controller 6-5
no laser beam 6-3
no measurement signal 6-4
signal level display 6-3
filter diagram
high pass filter C-2
low pass filter C-1
filter, specifications
anatog high pass filter 7-17
analog low pass filter 7-17
firmware version, displaying on the controller 5-27
fluid stage
assembly 3-29
mounting threads, on the scanning head 3-27
setling up the scanning head 5-2
focal length, objective 7-26
focus position, save/toad 5-18
focusing
automatically, on the controller 5-18
automatically, using the hand set 5-5
laser beam 5-4
laser beam, on the controiler 5-17
remotely, on the contrelier 5-17
remotely, using the hand set 5-5
focusing automatically
on the controller 5-18
using the hand set 5-5
focusing remotely
on the controller 5-17
using the hand set 5-4
FREE mode, hand set 5-3
frequency offset B-2
frequency response
DD-300 7-15

index

frequency shift B-1
frequency, on the detector B-1
fringe pattern, count B-1
front lens mode!
label, on the scanning head 3-27, 7-26
scanning head 7-26
front lens of the video camera, on the scanning
head 3-25
front panel
controtler, control element 3-4
junction box PSV-E-401, control element 3-8
junction box PSV-E-408, control elements 3-12
PC, control element 3-14
scanning head, control element 3-25
function generator, specifications 7-23
function keys, on the controlier 3-4
functional test
first 3-46
scanning head with geometry scan unit A4
fuses
junction box PSV-E-401 7-18

G
gate signal, on the junction box 3-11
general safety, safety information 1-1
general tests, fault diagnosis 6-1
generator board MI.6030

cohnectors in detail 3-24
generator cable

connector, on the junction box 3-10

connector, on the PC models -H4/-B 3-16
GENERATOR connector

on the junction box 3-10

on the PC medel -M2-20 3-22

on the PC models -H4/-B 3-16
generator signal

SIGNAL 2 to 4, on the junction box 3-9

SIGNAL1, on the junction box 3-9
geometry scan unit

fastener, on the scanning head 3-26
GRID mode, hand sst 5-3
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H

hand set

check alignment points, in the 3D
alignment 5-10

checking alignment points, in the standard
alignment 5-9

connector, on the scanning head 3-26

define/dslete, scan points 5-12

defining alignment points 5-7

delete alignment poinis, in the 3D
alignment 5-11

delete alignment points, in the standard
alignment 5-10

fault diagnosis 6-4

Free mode 5-3

GRID mode 5-3

laser beam, focusing 5-4

positioning the laser beam 5-2

hard disk drive

aclivity display, on the PC 3-14
PC 7-22

HDD LED, on the PC 3-14
heterodyne interferometsr B-1
high pass filter

analog, specifications 7-17
controlier specifications 7-17
set, on the controller 5-22
velocity decoder 4-11

harizontal test stand, dimension A-18
housing

controller, specifications 7-1

junction box PSV-E-401, specifications 7-18

junction box PSV-E-408, specifications 7-21

pan-tilt stage, specifications 7-28

PC, specifications 7-22

scanning head with geometry scan unit,
specifications A-5

scanning head, specifications 7-24

system cabinet, spacifications 7-28

ICP LED

REF22, on the junction box 3-12
REF23, on the junction box 3-12
REF24, on the junction box 3-12
REF3, on the junction box 3-9

ICP-LED

vi

REF1, on the junction box 3-8
REF2, on the junction box 3-8
REF21, on the junction box 3-12

identification label 3-2
on the controller 3-6
on the junction box PSV-E-401 3-10
on the junction box PSY-E-408 3-12
on the PC model -M2/-M4 3-20
on the PC mode} -M2-20 3-22
on the PC models -H4/-B 3-17
on the scanning head 3-27
IEEE interface
on the PC model -M2/-M4 3-20
on the PC model -M2-20 3-22
on the PC models -H4/-B 3-17
immunity, EMC standards 7-1
industrial PC, specifications 7-22

input signal TRIG IN of the displacement decoder,

on the controller 3-5
inspection of the components 3-2
installation

assembly scanning head 3-28

cabling 3-35

other components 3-3
instrument warning label

on the coniroller 3-6

on the junction box 3-11

on the PC model -M2/-M4 3-20

on the PC model -M2-20 3-22

on the PC models -H4/-B 3-17
instruments, opening 3-3
intended use 1-1
intensity fluctuation B-1
interference fringe pattern B-1
interference, optical B-1
interferometer cable

connector, on the controller 3-7

coennector, on the junction box 3-11
interferometer, directicnally sensitive B-1
interferometric measurement B-1

internal function generator, specifications 7-23

J
junction box
brief description 2-1
switching on 5-1
junction box PSV-E-401
back panel, control elements 3-10
cabling, back panel 3-38
cabling, front panel 3-35
front panel, control elements 3-8
junction box PSV-E-408
back panel, control elements 3-13
cabling, back panel 3-44
front panel, control elements 3-12



junction box, specifications
PSV-E-401 {SIGNAL, SYNC, AUX OUT) 7-20
PSV-E-401 (S-VIDEO OUT) 7-20
PSV-E-401 (TRIG IN, GATE IN, AUX IN) 7-20
PSV-E-401, ambient conditions 7-18
P3V-E-401, housing 7-18
PSV-E-401, mains connection 7-18
PSV-E-401, REF (ICP) 7-19
PSV-E-401, VELQ (TOP, LEFT, RIGHT) 7-19
PSV-E-408, ambient conditions 7-21
PSV-E-408, housing 7-21
PSV-E-408, REF 21 - REF 24 (ICP) 7-21

K
key
function keys, on the controller 3-4
FOWER, on the PC 3-15
RESET, on the PC 3-14
key switch, on the controller 3-4
keyboard connector
on the PC model -M2/-M4 3-19
on the PC moedel -M2-20 3-21
on the PC models -H4/-B 3-16

L
label
identification label, controller 3-6
identification label, junction box
PSV-E-400 3-10
identification label, junction box
PSV-E-408 3-12
identification label, PC model -M2/-M4 3-20
identification label, PC modei -M2-20 3-22
identification label, scanning head 3-27
instrument warning label, controller 3-6
instrument warning label, junction box 3-11
instrument warning label, PC model -H4/-
B 3-17
instrument warning label, PC model -M2/-
M4 3-20
instrument warning label, PC model -M2-
20 3-22
instrument warning label, PC model-H4/-B 3-17
iabel for the front lens model, scanning
head 3-27
laser warning label on the scanning head 1-4
laser warning labels 1-4
laser warning labels on the scanning head with
geometry scan unit A-2
lambda/4 plate B-2
laser
scanning head with geometry scan unit,
specifications A-5
scanning head, specifications 7-24
warming-up 3-3

Index

laser activity, indicaling 5-1
laser beam
aperiure, on the scanning head 3-25
blocking 5-1
focusing, on the controller 5-17
focusing, using the hand set 5-4
no, fault diagnosis 6-3
optimizing focus 5-6
positioning 5-2
laser beam, basics of the measurement
procedure B-1
laser class
scanning head 7-24
scanning head with geometry scan unit A-5
LASER LED
indicating laser activity 5-1
on the scanning head 3-26
laser power
scanning head 7-24
scanning head with geometry scan unit A-5
laser safety
safety information 1-2
standards applied 7-1
laser type
geometry scan unit A-5
scanning head 7-24
laser warning labels 1-4
label for the scanning head with geometry scan
unit A-2
labels for the scanning head 1-4
position on the scanning head -4
position, on the scanning head with geometry
scan unit A-2
LCD display, on the controller 3-4
LED
AUXILIARY OVER, on the controiler 3-5
DIFF, on the junction box PSV-E-401 3-8
DIFF, on the junction box PSV-E-408 3-12
HDD, on the PC 3-14
ICP (REF 1), on the junction box 3-8
ICP (REF2}, on the junction box 3-8
ICP (REF21), on the junction box 3-12
ICP {REF22), on the junction box 3-12
ICP {REF23), on the junction box 3-12
ICP (REF24), on the junction box 3-12
ICP (REF3), on the junction box 3-9
LASER, on the scanning head 3-26
POWER, on the controller 3-4
POWER, on the junction box 3-9
POWER, on the PC 3-14
VELOCITY OVER, on the controller 3-5
fenses
close-up, close-up unit A-8
micro scan lenses, close-up unit A-10
light beam, coherent B-1

vii



Index

liquid crystal display, on the contraller 3-4
fock with key, on the PC 3-15
low pass filter
analog, specifications 7-17
controller specifications 7-17
displacement decoder 4-5
set, on the controlier 5-22
velocity decoder 4-9

M
Mach-Zehnder interferometer B-2
mains connection

cabling 3-45

condition 3-3

controller, specifications 7-1

junction box PSV-E-401, specifications 7-18

an the controller 3-6

on the junction box 3-11

on the PC modet -M2/-M4 3-19

on the PC model -M2-20 3-21

on the PC models -H4/-B 315

pan-tilt stage, specifications 7-28

PC, specifications 7-22
mains switch

on the controller 3-4

on the PC model -M2/-M4 3-19

on the PC model -M2-20 3-21

on the PC models -H4/-B 3-15
mains voltage

junction box PSV-E-401 7-18

pan-iilt stage 7-28

PC 7-22
mains voltage input

condition 3-3

on the controller 3-6

on the junction box 3-11

on the PC model -M2/-M4 3-19

on the PC model -M2-20 3-21

on the PC models -H4/-B 3-15
maintenance requirements 3-2
making measurements 4-1
malfunction, fault diagnosis 6-1
measurement procedure, basics B-1
measurement range

indicating overrange 5-7

sef, on the controller 5-21

suitable setting 4-2
measurement signal, fault diagnosis 6-4
menus

in the controller 5-15

move in the 5-16
messages

list for messages on the display 6-5

on the display of the controller 5-27

vili

micro scan lenses
assembly A-10
description A-10
specifications A-11
missing part 3-2
modular concept 2-2
moniter connector
on the PC model -M2/-M4 3-20
on the PC model -M2-20 3-22
on the PC models -H4/-B 3-17
mounting threads
adapter plate, on the scanning head 3-27
camera tripod, on the scanning head 3-27
close-up unit, on the scanning head 3-25

quick release plate, on the scanning head 3-27

mouse connector
on the PC model -M2/-M4 3-19
on the PC model -M2-20 3-21
on the PC models -H4/-B 3-16

N
network connector
on the PC model -M2/-M4 3-20
on the PC model -M2-20 3-22
on the PC models -H4/-B 3-16
PC, specifications 7-22
NF suppression, DD-300 7-15
noise reduction, using tracking filter 4-7
noise, displacement decoder 4-5
note messages
list for notes 6-5
on the display of the controller 5-27
on the display, fauit diagnosis 6-5

0]
OFV-5000 connector, on the junction box 3-11
opening, the instruments 3-3
operating concept, controller 5-15
operating requirements 3-2
operating state
display, on the controller 3-4
disptay, on the junction box 3-89
display, on the PC 3-14
display, on the scanning head 3-26
operating system, PC 7-22
operating temperature
controller 7-1
junction box PSV-E-411 7-18
junction box PSV-E-408 7-21
pan-tiit stage 7-28
PC 7-22
scanning head 7-24
scanning head with geometry scan unit A-5
optical interference B-1
optimizing focus 5-6



OPTION connection, on the junction box 3-11
output signal
direction convention 3-47
disptacement decoder 4-5
DSP QUT of the DSP filter, on the controller 3-5
electrical S/P-DIF, on the controller 3-6
fault diagnosis, no measurement signal 6-4
optical S/P-DIF, on the controller 3-6
optical signal level, on the controlier 3-6
QUTPUT of the auxiliary decoder, on the
controller 3-5
QUTPUT of the displacement decoder, on the
controller 3-5
OUTPUT of the velocity decoder, on the
controller 3-5
UNIVERSAL of the auxiliary decoder, on the
controlter 3-5
use digital, on the controller 5-24
OVER LED
AUXILIARY, on the controller 3-5
VELOCITY, on the confroller 3-5
ovarrange, display
auxiliary decoder, on the controller 3-5
velocily decoder, on the controller 3-5
overrange, indicating 5-7

P
pan-tilt stage
assembly 3-29
cabling 3-45
connector, on the scanning head 3-28
mounting threads, on the scanning head 3-27
operating requirements 3-3
setting up the scanning head 5-2
specifications, ambient conditions 7-28
specifications, housing 7-28
specifications, mains connection 7-28
path difference B-1
PC
brief description 2-1
cabling 3-39
switching on 51
PC, control element
front panel 3-14
model-M2/-M4 back panel 3-19
models -H4/-B back panel 3-15
PC model -M2-20 back panel 3-21
PC, specifications
ambient conditions 7-22
data acquisition 7-23
housing 7-22
industriai PC 7-22
mains connection 7-22
phase difference B-1

Index

phase frequency response
high pass filter, filter diagram C-2
low pass filter, filter diagram C-1
phase shift
high pass filter 4-11
low pass filter 4-10
photo receiver B-1
positioning, laser beam 5-2
power consumption
junction box PSV-E-401 7-18
pan-ilt stage 7-28
PC 7-22
scanning head 7-24
POWER key, on the PC 3-15
POWER LED
on the controller 3-4
on the junction box 3-9
on the PC 3-14
power supply
REF1, display on the junction box 3-8
REF2, display on the junction box 3-8
REF241, display on the junction box 3-12
REF22, display on the junction box 3-12
REF23, display an the junction box 3-12
REF24, disptay on the junction box 3-12
REF3, display on the junction box 3-9
precautions
electrical safety 1-5
laser safety 1-3
PRINTER connector
on the PC model -M2/-M4 3-19
on the PC model -M2-20 3-21
on the PC models -H4/-B 3-16
processor, PC specifications 7-22
properties, optimal 3-3
protection class
junction box PSV-E-401 7-18
pan-til{ stage 7-28
PC 7-22
PSV models, summary 2-4
pulse response, DD-300 7-15

Q

qualification of the user 1-1

quick release plate, mounting thread on the
scanning head 3-27

R

range diagram, tracking filter 4-7

reference beam, basics of the measurement
procedure B-1



Index

reference signal
REF1, on the junction box 3-8
REF2, on the junction box 3-8
REF21, on the junction box 3-13
REF22, on the junction box 3-13
REF23, on the junction box 3-13
REF24, on the junction box 3-13
REF3, on the junction box 3-9
relative humidity
controlter 7-1
junction box PSV-E-401 7-18
junction box PSV-E-408 7-21
pan-tilt stage 7-28
PC 7-22
scanning head 7-24
scanning head with geometry scan unit A-5
remote focus, function on the controller 5-17
RESET key, on the PC 3-14
return 3-2
ring light
assembly A-11
description A-11
rotary knob BEAM SHUTTER, on the scanning
head 3-25
RS-232 interface
configuring, on the controller 5-28
on the controller 3-7
on the junction box 3-11
RS-232(X) cable
connector, on the controller 3-7
connector, on the junction box 3-11
rute of thumb
high pass filter 4-11
low pass filter 4-9
tracking filter 4-7

S
S/P-DIF data, deactivate on the controller 5-23
safety
electrical, safety information 1-5
general safety information 1-1
laser, safety information 1-2
safety information
electrical safety 1-5
general safety 1-1
laser safety 1-2
scanning head with geometry scan unit A-1
safety precautions
electrical safety 1-5
laser safety 1-3
save/load
default settings, on the controlier 5-26
focus position 5-19
last used settings, on the controller 5-26
settings, on the controlter 5-25

scan points, defining/deleting 5-12
scanner, specifications 7-27
scanning head
assembly 3-28
assembly conditions 3-2
back panel, control elements 3-26
bottom view, control element 3-27
brief description 2-1
cabling 3-44
dimensions 7-25
front panel, controf elements 3-25
optical configuration B-2
sefting up 5-2
stand-off distance, optimal 4-12
warm-up period 3-3
SCANNING HEAD connector
on the junction box 3-11
on the scanning head 3-26
scanning head with geometry scan unit
control elements A-3
description A-2
scanning head with geometry scan unit,
specifications
ambient conditions A-5
housing A-5
laser A-5
scanning head, specifications
ambient conditions 7-24
electrical data 7-24
housing 7-24
lagser 7-24
scanner 7-27
Table of the Visibility Maxima 7-27
video camera 7-27
SENSOR connector, on the controller 3-7
serial number
inspection 3-2
on the controller 3-6
on the junction box PSV-E-401 3-10
on the junction box PSV-E-408 3-12
- on the PC model -M2/-M4 3-20
on the PC model -M2-20 3-22
on the PC models -H4/-B 317
on the scanning head 3-27
setting up, scanning head 5-2
settings
changing, on the controller 5-20
default, on the controller 5-26
last used, on the controlier 5-26
medifying 5-7
saving/loading, on the controller 5-25
selecting suitable 4-2
signal flow, in the controller 2-2



signal input
DISPLACEMENT TRIG IN, on the
controller 3-5
signal level display
great fluctuation, fault diagnosis 6-3
on the scanning head 3-26
using 5-6
signal level, cutput on the controller 3-8
signal output
AUXILIARY QUTPUT, on the controller 3-5
AUXILIARY UNIVERSAL, on the controller 3-5
DISPLACEMENT QUTPUT, on the
controller 3-5
electrical, on the controller 3-8
optical, on the controller 3-6
SIGNAL, on the controller 3-8
VELOCITY DSP OUT, on the controller 3-5
VELOCITY QUTPUT, on the controller 3-5
signal-to-noise ratio
improve using high pass filter 4-11
improve using low pass filter 4-9
improve using tracking filter 4-7
software
check alignment points, in the 3D
alignment 5-10
checking alignment peints, in the standard
alignment 5-9
define/delete, scan points 5-12
defining alignment points 5-7
delete alignment points, in the 3D
alignment 5-11
delete alignment points, in the standard
alignment 5-10
indicating overrange 5-7
laser beam, focusing 5-4
modifying the settings 5-7
positioning the laser beam 5-2
starting 5-1

Index

specifications
close-up unit A-8
controller, analog signal infoutput 7-2
controller, decoder specified properties 7-4
controller, digitai interfaces 7-2
controller, general data 7-1
geometry scan unit, filler A-6
junction box PSV-E-401, analog signal
inputsfoutputs 7-19
junction box PSV-E-401, general data 7-18
junction box PSV-E-401-3D, digital
interfaces 7-18
junction box PSV-E-408, analog signal
inputs 7-21
junction box PSV-E-408, generai data 7-21
micro scan lenses A-11
pan-ilt stage, general data 7-28
pan-tilt stage, movement 7-28
PC, data acquisition 7-23
PC, general data 7-22
scanning head with geometry scan unit, general
data A-5
scanning head, general data 7-24
scanning head, optics 7-26
scanning head, scanner 7-27
scanning head, video camera 7-27
standards applied 7-1
system cabinet 7-28
test stand A-16
standards applied
declaration of conformity D-1
technical specifications 7-1
stand-off distance
scanning head, optimal 4-12
scanning head, specifications 7-26
while setting up the scanning head 5-2
start, the PSV 4-1
storage temperature
controller 7-1
junction box PSV-E-401 7-18
junction box PSV-E-408 7-21
PC 7-22
scanning head 7-24
scanning head with geometry scan unit A-5
suitable settings, selecting 4-2
s-video cable
connector, on the junction box 3-10
S-VIDEO output, on the junction box 3-10
switching on
on measuring 4-1
system componenis 5-1
synchronization pulse
SYNC, on the junction box 3-9
systemn cabinet
specifications, housing 7-28
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system components 2-1
cleaning 3-3
cooling 3-2
inspection 3-2
switching on 5-1
unpacking 3-1
system summary 2-1

T
technical specificaticns
close-up unit A-8
controller, analog signal infoutput 7-2
controller, decoder specified properties 7-4
controller, digital interfaces 7-2
controller, general data 7-1
geometry scan unit, filter A-6
junction box PSV-E-401, analog signal
inputs/outputs 7-19
junction box PSV-E-401, general data 7-18
junction box PSV-E-401-3D, digital
interfaces 7-18
junction box PSV-E-408, analog signhal
inputs 7-21
junction box PSV-E-408, general data 7-21
micro scan lenses A-11
pan-tiit stage, general data 7-28
pan-tilt stage, movement 7-28
PC, data acquisition 7-23
PC, general data 7-22
scanning head with geometry scan unit, general
data A-5
scanning head, general data 7-24
scanning head, optics 7-26
scanning head, scanner 7-27
scanning head, video camera 7-27
standards applied 7-1
system cabinet 7-28
test stand A-16
test
for fault diagnosis 6-1
for fault diagnosis, fluctuating signal level
display 6-3
for fault diagnosis, general 6-1
for fault diagnosis, hand set 6-4
for fault diagnosis, no laser beam 6-3
for fault diagnosis, no measurement signal 6-4
initial functional test 3-46
test stand
assembly, horizontal A-14
assembly, vertical A-13
cabling A-15
description A-12
dimensions A-17
mounting threads, on the scanning head 3-27
specifications A-16

xii

theory B-1
tracking filter
displacement decoder 4-5
fast mode 4-7
loses lock 4-7
range diagram 4-7
set, on the controller 5-21
slow mode 4-7
velocity decoder 4-7
fransfer rate
on the controller 3-7
selecting 5-28
specifications 7-2
fransport handle, on the scanning head 3-26
transport packaging, check 3-2
trigger signal
on the junction box 3-9
tripod, assembly 3-29
TTL input
GATE IN, on the junction box 3-11
TRIG IN, on the junction box 3-9
TTL output
AUX OUT, on the junction box 3-9
SYNC, on the junction box 3-8

U
umbilical cable
coennector, on the junction box 3-11
connector, on the scanning head 3-26
unpacking, components 3-1
USB cable
connector, on the junction box 3-10
connector, on the PC model -M2/-20 3-22
connector, on the PC model -M2/-M4 3-19
connector, on the PC models -H4/-B 3-16, 3-20
USB interface
on the junction box 3-10
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1 Quick-start

1 Quick-start

Preparation

This introduction will quickly familiarize you with important functions of the
measurement system based on an FFT measurement. For this purpose, first
of all run a scan and then evaluate it using some of the software functions.
Use an object with simple geometry for the scan. If you have a function
generator, use it to excite the object and then use this signal as a reference
signal for the measurement. If you do not have a function generator, you can
also excite it by other means.

@~ Although you can also make a measurement without a reference signal, if
you do, you will not be able to animate the vibration during evaluation.

1. Connect up the measurement system and start it as described in the
hardware manual.

2. If available, connect the reference signal to the jack REF 1 on the front of
the junction box.

3. Start the software. To do so, double-click the icon “3ey on the desktop.
You will find more information on this in SECTION 2.4,

4. [f the software has not been started in Acquisition mode, go into

acquisition. To do so, in the toolbar of the application window, click % .
You will find more information on this in SEcTION 2.5, You will now see the
video window at the top and an analyzer at the bottom. On the left you will
see the project browser (refer also to SECTION 2.6.4 and on the right the
scanning head control (refer also to SEcTION 2.6.1).

5. Select Setup > Preferences. The dialog Preferences appears.

6. Display the page Devices.

7. From the list Junction Box, select the junction box which is connected to
the PC.

8. If you are using a function generator, then set the connection for
Generator {internal or GPIB}).

9. Display the page Scanning Head.

10. In the list Scanning Head, select the scanning head you have connected.
11. Click OK.

12. Only with the option VOD: Run test mode as described in SECTION 7.7.

You will find more information on seiting up the software in CHAPTER 3.
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1 Quick-start

Setting the Optics

You sei the optics using the scanning head control. See also SECTION 4.1 on
this.

13.

14,

15.

16.

17.

18.

19.

20.

21.

22.

Point the scanning head at the object, either manually or using the
optional pan-tilt stage.

Zoom in the video camera so that the object appears as large as possible
in the video window. To do so, use the slider Zoom in the field Camera.

Now focus the video camera. To do so, first of all point the laser beam at
the top left corner of the video image. Otherwise the light from the laser
beam prevents the video camera focusing automatically. Te adjust the
laser beam, use the icons Position. Then click Autofocus in the field
Camera.

Then point the taser beam at the object again.

Focus the laser beam with the icons N and F¥ . As an option, you can

automatically focus the laser beam using the icon @»R’E:. You will find more
information on this in SECTION 4.2,

Align the positions on the live video image with the position of the laser on

the measurement plane. To do so, click *% or select Setup > 2D
Alignment. The software will maximize the video window. Distribute the
alignment points evenly over the whole measurement surface. If, for
example, you want to scan a rectangular surface, it would make sense to
choose four alignment points near the carners.

Move the laser beam to an alignment point on the object using the icons
Position in the scanning head control.

In the live video image, point the mouse precisely at the laser beam and
click. You can now see a farget there. If the laser beam is not precisely in
the middle of the target, click again.

Repeat steps 19 and 20 for at least three more glignment points.

Once you have aligned all points, click % again or select Setup > 2D
Alignment.

You will find further information on 2D alignment in SECTION 4.4,

[

To be able to import 3D geometries in 3D point mode (optional), you also
have to carry out a 3D alignment. See SECTION 4.5 on this.



1 Quick-start

Defining Scan Points

23.

24.

25.

26.

27.

28.

29.

30.

Go to scan point definition. To do so, in the toolbar of the application
window, click %¥.. The software maximizes the video window and displays

a graphics toolbar (the icon s activated). The dialog Object Properties
appears.

First of all delete all scan points which may already be defined. To do so,
select Edit > Select All and then Edit > Delete.

First click ‘&3 in the graphics toolbar and then draw the largest possible
rectangie on the object.

You will see the rectangle you have drawn with a red edge and white
squares which mark the edge. You will see the scan points as blue points
inside the rectangle.

Please check whether the icon f in the dialog Rectangle Properties is

active. If yes, then click ‘ to display the scan points (refer also to
SECTION 5.1.7).

Point the mouse at the grid. The cursor becomes a cross. You can now
move the grid with the scan points by clicking the grid and moving it using
the mouse.

You have now finished defining scan peints. In the toolbar of the
application window, click o again to quit scan point definition.

Now point at the live video image and click a scan point. The taser beam
moves to this point on the object. Click additional scan points to check
and see if the laser beam is positioned precisely on the scan points.

You will find mare detailed information on scan point definilion in CHAPTER 5.
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Setting Parameters

31. In the toolbar of the application window, click #2, The dialog Acquisition

Settings appears.

32, Display the pages in the dialog from left to right and set the parameters

there. The suitable settings depend on the object. If you know suitable
settings, then set them. If not, use the settings in TABLE 1.1,

Table 1.1: Parameters for an example measurement

Page Settings
Measurement Mode: FFT
General Averaging: Off
Remeasure: Active
ch Is! Vibrometer: Active, Direction +Z, Range 10V, Coupling DC, Quantily Velocity
anneis Reference 1: Active, Direction +Z, Range 10V, Coupling DC, Quantity Voltage
Fiiter Channel Vibrometer: Filter Type No Filter, Int/Diff Quantity Velocity (0)
Channel Reference 1: Filter Type No Filter
Bandwidth: 10kHz
Froquenc From: OkHz
quency  \1o: 10kHz
FFT Lines: 400
Window Channel Vibrometer: Function Rectangle
Channel Reference 1: Function Rectangle
Trigger Source: Off
Channei Vibrometer: Active
SE Channel Reference 1: not Active
Speckie Tracking: Active
Slider: Fast
Velocily: lowest available measurement range
, Tracking Fitter: Slow {Slow)
Vibrometer ) oy pass Filter: Off (1.5MHz)
High Pass Filter: Off
Generator Active: Active

1 Only with option VRD: Some paramelers on the page Channels are not avaitable or are fixed.
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33. Click OK.

You will find detailed information on the parameters for data acquisition in
CHAPTER 6.
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Single Point Measurement

Scanning

34. If available, start signal output from the function generator. To do so, in the
toolbar of the application window, click ™.

35. Start a continuous measurement. To do so, in the toolbar of the
application window, click G The analyzer displays the measurement
signai on the vibrometer channel.

Autoscale the y-axis. To do so, in the toolbar of the analyzer, click 5

36. Click a scan point in the video window. The software will position the laser
beam on the object at this scan point. Check whether the display OVER in
the scanning head control is permanently red. If yes, then the
measurement range for the velocity is being exceeded at this scan point.

37. Repeat step 36 for a few additional scan points.

38. If the display OVER is red at several scan points, increase the

measurement range for the velocity. To do so, click AID; again, display the
page Vibrometer and select the next highest measurement range in the
list Velocity. Then click OK.

39. Repeat steps 37 to 38 until the measurement range for the velocity is no
longer exceeded.

40, Stop the continuous measurement. To do so, in the toolbar of the
application window, click &

You will find detailed information on making measurements in CHAPTER 7.

41. Start the scan. To do so, in the toolbar of the application window, click =3
The dialog Save As appears.

42. Navigate to the saving location and enter the file hame.

@ |f you have the project browser displayed (refer to SECTION 2,6.4), you will
then automatically be shown the directory marked there as saving
location.

43. Click Save. The scan starts. The software immediately saves every scan
point measured.

44. In the video window you can follow the progress of the scan. See
CHAPTER @ on this.
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Displaying Data

Select data sefs 45

Zoom

Set a cursor

Read data

1-6

46,

47

48.

49,

50.

51.

52.
53.

54.

55.

. Display a spectrum. To do so, in the toolbar of the analyzer, click o+~ and
select FFT in the context menu.

ciick ¥ to autoscale.

. You can display other signals for spectra apart from the measurement

signal. To do so, click ¥+ and select Acceleration in the context menu.
While 1'is activated, the selected signal will be autoscaled direcly.

Display the magnitude of the acceleration signal as well as its phase. To

do so, click 84 and select Mag. &Phase in the context menu.

Zoom the range between 5kHz and 10kHz. To do so, point the mouse at
the x-axis at 5kHz. The cursor becomes a magnifying glass.

Press the mouse button and drag to the right to 10kHz.

Undo zooming. To do so, click .,

Activate a cursor. To do so, click ,/i\.f.

Set the cursor in the analyzer. To do so, click in the diagram. A vertical
line will appear at the point which you have clicked.

You can see the cursor's coordinates in the legend. If the legend is not
visible on the right in the analyzer, select Analyzer > Legend to display it.

Move the cursor to the right or left using the mouse. The data in the
legend is updated simultaneously.

You will find detailed information on displaying data in CHAPTER 8.

Now you have finished the introduction. You will find further example
measurements in SECTION 7.8.
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2 First Steps

Poiytec's Scanning Vibrometer measures the two-dimensional distribution of
vibrations. The software in the measurement system has the following
functions:

Controiling the hardware

Defining scan points

Setting parameters for data acquisition
Generating excitation signals (as an option)
Acquiring digital data

Saving data

Displaying data and evaluating it

o & 5 & © & ©

First of all, read the following sections to familiarize yourself with the basics of
how to work with the software.

2.1 System Requirements

So that you can work optimally with the software, please make sure that the
following components have been installed:

+ For data acquisition systems, please use either Windows® XP (32 bit) or
Windows® Vista (64 bit) as your operating system.

@ Only for VibSoft-20; operating system Windows® Vista (32 bit)

& For deskiop PCs, the operating systems Windows® XP (64 bit) and
Windows® Vista (32bit) are additionally available.

Current Service Packs for Windows® XP or Windows® Vista
Microsoft® DirectX® 9
Microsoft® .NET Framework 2.0 SP1

The respective drivers for your measurement system. You will find
detailed information on this in the Release Notes on your software CD.

@ First of all, please carry out the installations as described in the Release
Notes.

24
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2.2 Installing the Software

To install the software, proceed as follows:

== When installing the software, please make sure you pay attention to the
supplements and special features in the Release Notes!

1. Only for a new installation: Install the required hardware as described in
both your hardware manual under Cabling and in the manual for your data
acquisition board.

2. Check that your hardlock (dongle) is available and has been installed
correctly.

@ While the software is being installed, you are asked to choose whether
you have instailed a local hardlock or a nefwork hardlock. Please note that
acquisition mode is not available with a network hardlock.

3. Switch on your PC and log in with administrator rights. See your operating
system manual on this.

4. Install the required software as described in the file
WPSV\ReleaseNoteseng on your PSV DVD.

Now you have finished the installation. Should any problem occur during
installation, please contact Polytec.

2.3 Integrating the Hardware

IEEE-488/GPIB

RS-232

2-2

CAUTIONI

Danger from mishandling! - Do not change any address or interrupt
settings! This could prevent the software from running properly.

You can control two Polytec vibrometers using the software and as an option,
an external funclion generator as well. See also in SECTION 7.8,2 or

SECTION 7.8.6 on this. Connect up the devices as described in your hardware
manual.

If you control some devices via IEEE-488/GPIB, then we recommend you set
the following addresses:

e Vibrometer controller 1: IEEE-488/GPIB address 5
o Vibrometer controller 2;: IEEE-488/GPIB address 4
¢ Function generator: IEEE-488/GPIB address 10.

If you controf vibrometers via RS-232, then the software recognizes the
controller connected to the lower COM port as Vibrometer Controlier 1.
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2.4 Starting the Software

To start the software, proceed as follows:

1. Check that the hardlock has been instalted correctly on the PC or on the
network.

2. Connect up the PSV and start it as described in your hardware manual.
3. After you have done this, switch the PC on.

4. After a short while you will be asked {o log in. You do not need
administrator rights to start the software. See your operating system
manual on this or contact your administrator.

<= If you want to change the hardware, you have fo log in as administrator. A
password has not been set prior to delivery.

5. Double-click the icon B2 on the desktop or select Start > PSV. The
application window appears.

6. Change to acquisition mode. You may receive an error message and
information on it (refer to SECTION 2.5).

You can now work with the software.

2.5 Modes in the Software: Acquisition and Presentation

Presentation
mode

Acquisition
mode

In the software you work in two different modes: Acquisition and Presentation.
You can use some functions in both modes. Acquisition mede is not available
in the desktop version.

To go to presentation mode, click < or select View > Presentation.

Ta go into acquisition mode, click & or select View > Acquisition.

When changing into acquisition mode, the software searches the PC
interfaces for external devices and initializes them. You may receive an error
message and information on it. You can switch off this error message as
described in SECTION 3.7.

o '} Fated to initlalize th fotowing device(s):
' Yibrometer Controller 2

If you prass IGNORE you wonit be able to use some Features of your software.

ghat | Retry Tonore

Figure 2.1: Error message when changing inte acquisition mode
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If you want to check the connection between the devices and if necessary
correct it, select Setup > Preferences and open the page Devices.

& Some Polytec instruments are automatically initialized in acquisition mode
and can not be changed. But when changing into presentation mode, all
the hardware used is enabled. This makes it easier to use the PSV
software in parallel to PMA or TMS software for example in the case of
MSA systems.

2.6 Windows in the Software

-

First of all, read the following sections to familiarize yourself with the various
windows in the software.

Application Window, refer to SECTION 2.6.1
Video Window, refer to SECTION 2.6.2
Analyzer, refer to SECTION 2.6.3

Project Browser, refer to SECTION 2.6.4
Presentation Window, refer to SECTION 2.6.5
Signal Processor, refer to SECTION 2.6.6
Arranging Windows, refer to SECTION 2.6.7
Zooming in Windows, refer to SECTION 2.6.8

2.6.1 Application Window

After starting the software, the application window appears. At the top you will
see the title bar, menu bar and toolbar, at the bottom the status bar. In the
menu View, you can show (hide) the toolbar and the status bar.

Initially the application window is empty. You are in presentation mode. Click

A to quickly create new signal processor documents, new combined files
or new scan files.

% Polytec Scanning Yibrometer _ {O0] x] l

File View Setup Macro Help

MMedpl@l seax | oz kex saam 2N

Signal Processor

Combined File. ..

Figure 2.2: Example of the application window in presentation mode
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By clicking “* you change into acquisition mode. There you will see the
video window, an analyzer and the project browser. The windows are

described in the following sections in detail. Click to display additional
analyzers.

Title bar + Polytec Scanning Yibrometer - Scan |_ [O] x|
Menu bar ——File Edit View Setup Acquisition Scan Macro ‘Window Help
Toolbar B & sae o ke [FI PR DA GLE0 (HBEM PR
T i Elzl . Scan Ej
-0 Settings . w|BROQAKE N R T Optics =
&) MyDocuments : OFY-5000
Video {2) Examples Points 157 B
window
Scan Status 4N ‘BE Fr
B fotMeasured  100.0 OVER @
= valid 0.0 ¥ Laser
Optimal 0.0 I~ Fiter
e ST Channels =1
rojec nvalidal y
browser ® Disabled 00 vGenerator
® NotReachable 0.0 [ |l e
® Hidden 0.0 vib 1
» i
Tmeo B il Bk o S
Components
Posiion =
i
L e
B8 Scan
on_ A FBo. | et : € o >
oo *3- - DN AL QX 4| t] A
Analyzer o A P
: : : H Vib Velocity - 3812°
t -0s10°
]
E 2D Point =l
I_,E?; 0 Index:
g Status:
=1 X
o h £1
0 2 4 5 8 10 z:{-0.0000 m
qI I_;J Time [ ms ] D:
Status bar — o Help, press F1 . FFT [Ava Off [10kHz[~ [100[~ [10ms [100Hz /D-03 10 min/sAl %
Messages on Settings for data Scanning head
Help data acquisition acquisition control

Figure 2.3: Example of the application window in acquisition mode

Menu bar

In the application window you can display and evaluate data. To do so, you
can use various windows:

e In acquisition mode: a video window, any number of analyzers.

e In presentation mode: any number of presentation windows and
analyzers.

If you restart the software, then the arrangement and signal selection of the
windows opened most recently will be restored. Please read SECTION 2.6.7 on
how to set the window layout.

Every menu contains a group of commands for working with the software.
Some menus are only visible if an analyzer or a presentation window is open.
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Toolbar

Status bar

Scanning head
control

By clicking the icons, you can execute some commands quickly which you
would otherwise have to select in the menus.

On the right, the status bar shows several settings for data acquisition. On the
left, in certain situations, you will see a short help text. For example, point the
mouse at one of the settings on the right and leave the cursor there for a
moment. Then on the left you will see which parameter it is for. For more
information on how to get help in the software, see SECTION 2.8.

When making a measurement, messages on data acquisition can appear in
the middle of the status bar See SECTION.7.5 on this.

In acquisition mode you can show (hide) the scanning head control in the

application window. To do so, click 7 or select View > Scanning Head. You
adjust the optics using the scanning head control. See SECTION 4.1 on this.

2.6.2 Video Window

Open

Toolbar

The video window displays the live image of the video camera in the scanning
head.

The video window appears when you change into acquisition mode.

Title bar 7. Scan =] B3
Toolbar —————— . | 3p HEHT(;J Q K L
Points 157
z : Scan Status
Live video o
image B Mot Measured  100.0 |
" Valid 0.0
Legend & Optimal 0.0
Overrange 0.0
®  Invalidated 0.0
® Disabled 0.0 |4
W Not Reachable 0.0 _‘3' 3
: ® Hidden 0.0 | o
Scan points
°fo >\
Time 65 .
. Components e
List of [FRoct Component
components

Figure 2.4: Example of the video window

By clicking the icons, you can execute some commands quickly which you
would otherwise have to select in the menus.To change between the 2D view

and the 3D view, click 3P . If you change from the 2D view to the 3D view, a
snapshot of the live video image is shown as a fixed-image. You can also use
the mouse to set the line of sight directly in the video window. To do so, click

iy
£J . The mouse cursor becomes a 2. Drag in the direction you require.
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image

Legend

Scan points

List of
components

Zoom function
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To change the view of the scan point status, click i v, Please see
SECTION 7.3 on this as well.

In the live video image, you control the position of the laser beam. Apart from
that, you define there scan points and follow the progress of a scan. You
adjust the image settings of the live video image (contrast, brightness, color)
as described in SECTION 4.3.

On the left you see a legend for the status of the scan points. The legend also
shows the number of defined scan points and the estimated time needed for
the scan. The display of the status changes depending on which view you
have selected (Scan, Geometry or Laser Focus).

If scan points are defined, you can show (hide) them in the video window. To

do so, click B or select Scan > Scan Points. You see the scan points as
markers in different colors. These colors show the status of the scan points.

In acquisition and presentation mode you can define geometry components
and assign scan paints to the single components. See also SECTION 5.4.3 on
this.

In the video window you c¢an zoom in on image sections and can pan the
zoomed sections. You will find the necessary tools in the toolbar of the
application window, refer also to SECTION 2.6.8.

2.6.3 Analyzers

Open

Analyzers show measurement data and evaluated data in x-y diagrams. You
can follow current measurements in analyzers or use them to display
measurement data from a file. In presentation mode, an analyzer can also be
part of a presentation window. See SECTION 2.6.5 on this.

An analyzer appears if you

e start a single shot or a continuous measurement or
e open a single point measurement.

2.7
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Title bar

Toolbar

Y-axis

If an analyzer is open, the menu bar of the application window is extended by

menus for working with analyzers. To open further analyzers, click or
select Window > New Analyzer.

=] B3
o
Wib Velocity
- Frequency
-Eé 1: 5935 Hz
= 2: 7030 Hz
g A 1095 Hz
§| B Magnitude
= 13 3.28 pmis
2: 6.29 um/d's
A 3.01 pmis
B |
X-axis Scroll bar Legend

Figure 2.5: Example of an analyzer

Title bar

Toolbar

Diagram

Legend

Zoom function

Scroll bar
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If an analyzer has the function of a measurement window, you will see the
name Scan in the title bar. If you have already saved the measurement or
have opened a single shot or a continuous measurement, you will see the file
name in the title bar.

You can show/hide the toolbar by selecting Analyzer > Toolbar. By clicking the
icons you can quickly execute some commands from the menu Analyzer.

You can see the data as a graph in x-y diagrams. You can set up the look of
the diagrams and the graphs yourself.

On the right you can show/hide a legend for the diagrams. To do so, select
Analyzer > Legend.

In the analyzer you can zoom on diagram sections and can pan the zoomed
section. In the toolbar of the analyzer you will find the necessary tools, refer
also to SECTION 8.2.1.

You can use the scroll bar to scroll if you have zoomed the x-axis.
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2.6.4 Project Browser

Open

In the project browser you can display folders in a tree structure with the
subdirectories and files in them. To do so, open a program on file
management, e.g. Microsoft® Explorer and use the mouse to drag the
required folder or folders into the project browser. These folders can now be
managed from here. |n these folders, you can also create new subfolders.
Please note that all actions are executed directly in the respective folder.

@ The folders in the project browser are not copies, but are direct links to
folders on your hard disk or network drives! Changes made in the project
browser, e.g. deleting or renaming subdirectories and files are carried out
in parallel in your fite management and in reverse.

é—’(‘;) Data

E}—g £x Cayboor 3D.svd

-4 £x FastScan 35 Hz.svd

E1-¥¥ Ex FastScan 377 Hz.svd

i -[® rrequency Band

£ AN Acquisition

L OF scan Points
LB Comera & Afgnmerk
B EX Fast3tan 4763 Hz.svd
#-|4) Ex Tene.pvd
i51- %% Exz FastScan 1700 He.svd
A1-%¥ Ex2 FastScan 3275 He.svd
i1 9% Example HighRes Bands,svd
7 %% Example.svd
B1-§8 EXANPLEZ.SVD
| e €5 EXAMPLES.SYD

Figure 2.6: Example of the project browser

@ You can not transfer individual files to the project browser. You can
remove folders again. To do so, click the folder with the right mouse
button and select Remove in the context menu. You can also delete
individual files.

The contents of the project browser remain saved, even after the program is
stopped. The display of contents is user-specific.

To open the project browser, click B or select View > Project Browser. You
can adapt the way the project browser is displayed, i.e. make it smaller and
move it to another part of the screen. If you drag the project browser near to
one of the edges of the software window and release the mouse button, the
project browser is automatically placed next to the corresponding window

edge. Click B/ in the title bar of the project browser to reduce its size again
and position it freely in the software window.

29
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Add folder

210

To add another project folder to the project browser, click the project browser
with the right mouse button, however do not click a file or a folder. Select Add
Project Folder in the context menu. The dialag Seilect Foider appears.
Navigate to the required folder and click Select.

@ Alternatively you can aiso select File > Add Project Folder.

Click a file or a folder with the right mouse bution to edit the contents in the
project browser. The commands shown in the context menu differ depending
on the level in the tree structure, the type and number of objects selected and
the mode you are currently working in (acquisition or presentation). The
individual commands are explained in the following.

Explorer: Click here if you want toc have the selected folder displayed in
Microsoft® Explorer as well. This command is only available for folders.

New Folder: Click here if you want to create a new subfolder in the selected
folder. The subfolder appears in the project browser and can immediately be
renamed respectively.

Refresh: Click here to update the display of folders and files in the project
browser.

Remove: Click here if you want to remove the selected objects from the
project browser, but do not want to delete them. The command is only
availabte for folders on the top level.

Rename: Click here if you want to give the sefected object a different name.

Delete: Click here if you want to irrevocabiy delete the selected objects.
Before deleting them permanently, you have to confirm a safety check. The
command is only available for files.

@ You can oniy delete settings if they are saved in their own file (*.set) {refer
to section 10.2.7 and SeCTION 10.1.4). You can not delete the setlings of
a scan.

Load: if you select Load, then the setting files (.set) that you selected in the
project browser are loaded. See also SECTION 10.1.4 on this.

Open: In principle, in the project browser you can open files from all
programs installed on your PC. Click Open and the selected file will be
opened using the corresponding program. If you open a file with the suffix
svd, a presentation window appears. If you open a file with the suffix spd, the
signal processor appears (as an option).

New window: Click here if you want to display the file you have already
opened in a second window again.
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Infa: Click here if you want to display the file information on the file you have
already opened. See also SECTION 10.1 on this.

Close: Click here if you want to close the selected file.

Save As: Click here if you want to save the selected file under a different
name or in another directory.

Create Scan File: Click here if you want to create a new scan file from the
selected file in the format Scan Data (svd), Settings Files {set), Universal
Files {unv), or ME'Scope Files (str). A condition of this is that the file contains
a 3D geometry. Only the 3D geometry is then transferred to the new scan file.
You can now add user-defined data sets and then save the file.

Paste: This command is only available if you are using the optional signal
processor (refer also to SECTION 8.6). If you have copied data in the signal
processor, you can insert this data into the selected file by using the
command Paste.

Edit: If you select Edit, a macro window will appear with the macro you
selected in the project browser,

Run: If you select Run, then the macro you selected in the project browser is
executed.

Properties: This command is only available to you for combined files in
presentation mode. You will then see the dialog Create Combined File with
the individual files in the set order. See also SECTION 8.5 on this.

Import: In the project browser, you can also import geometries in the format
Universal File, ME'Scope or ASCII. A condition of this is that you are in
acquisition mode, you have a valid 3D alignment and you have selected point
mode in the scan point definition. See also SECTION 5.2.8 on this. Apart from
that, in presentation mode you can also import measurement data in the
format Universal File, ME'Scope or ASCII. See also SECTION 10.1.5 on this.

You can copy files or folders in the project browser into other directories. To
do so, mark them and holding the left mouse button pressed, drag the marked
objects onto the required directory.

To move files or folders in the project browser, proceed as described above,
Also hald the shift key pressed while you are dragging with the mouse.
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2.6.5 Presentation Window

In presentation windows you analyze scans in 2D and 3D diagrams.

Open A presentation window appears when you open a scan. The menu bar of the
application window is then extended by menus for working with presentation
windows. You can then open further presentation windows by selecting
Window > New Window.

Title bar EIEXAMPLE2.SVD B ikt
Toolbar ———— - | o»- 2+ 25~ §¢- | $-[a0 [ M [T - 1700k AN @A K [ = | » w0 » [ 1] 1] 4
Domain FFT . Band 1 1.700 kHz
Signal Index 221
Object under vib Velocit
investigation o Magnitude
(zoomed) Magnitude 18,68 pmjs
Gauge —+ m‘m{s ‘ Status
Legend 2w 20 w4 Optimal
List of Direction |+z v]
components - [F]EXAMPLEZ S
X
Selected scan
point e
Z: I m
D: Unknown
e ta-aa- B0 AN ML K] vib Velocity
i ] Index 22
—1501 - Band 1 1.7 kHz
s Start 1.6 kHz
-
Analyzer 51004 - 1l End 1.8kHz
E width 0.2kHz
g sof -
=
o j
5 10 15 20
Frequency [ kHz |
Figure 2.7: Example of a presentation window in the Single Scan Point view
Toolbar You can show (hide) the toolbar by selecting Presentation > Toolbar. By

clicking the icons you can quickly execute some commands from the menus
Setup, Presentation and Animation.

View You can display the presentation window in different views. To do so, click

B~ and select the view required in the context menu. You can also select
Presentation > View.

Object You see the object in all views. You can present the object in different ways.

To do so, click #*~ and select the view style required in the context menu.
You can also select Presentation > View Style.

Gauge On the left you can show/hide a gauge for color-coding. To do so, select
Presentation > Gauge.
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On the right you can show/hide a legend for the data displayed. To do so,
select Presentation > Legend.

In acquisition and presentation mode you can define geometry components
and assign scan points to the single components. See also SECTION 5.4.3 on
this.

In the views Single Scan Point, Average Spectrum and Profile you will see an
analyzer at the bottom of the presentation window. See SECTION 2.6.3 on this.

-

In the presentation window you can zoom on the object in all views and in all
view styles and also pan the zoomed section. You will find the necessary tools
in the toolbar of the presentation window, refer also to SECTION 2.6.8.

2.6.6 Signal Processor (as an Option)

You can use the signal processor to recalculate measurement data for further
analysis and then compare the results with the original data. You can read
SECTION 8.6 to find out how to work with the signal processor.

Title bar 25 SigProz.spd =] B3
Toolbar K F P M FuPulf rrom® f 4 U0 [0 Poe [\ min max o i b 150 [eC [ Q| ~1! bomain FFT
Formulae editor ——~StatMean( A1} FFT  vib { Velocity
A 8 c lo e e e [n 1 2] points 0
. 1 |FFT{Vibjv... X F H:
Calculation “ Of%mle;e“"e“” el
table 3 g
s 761
Z‘ :‘ ¢ velocity [mfs]
< | Mo complex 1D
T 5 1 2% Ie ) TR
BN A M A Q& $itffe a1} Ust FFT {Vib | Velocity
10 T £ Frame 1 v
0
)
E
o
2
= o5
=
Analyzer 3
5
>

o
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Frequency [ kHz ]

Figure 2.8: Example of recalculating measurement data in the signal processor

Toolbar

In the toolbar you will find the most important arithmetic operations you can
execute with the signal processor. By clicking the icons, you can transfer the
formulae directly to the formulae editor instead of having to enter them using
the keyboard. The icons are active as soon as the cursor is in the formulae
editor. You can also select the function wizard to enter the formulae. To do so,

click @ and then the required icon. See also SECTION 8.6.1 on this. Apart
from the icon for the function wizard, you will find a list with all available
formulae. By clicking in the list, you can directly apply the formula in the
formulae editor.
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Formulae editor

Calculation
table

Analyzer

You are shown the contents of the selected table cell in the formulae editor.
This is also where you enter text or formulae which are to appear in the
selected cell.

You enter the measurement data and the formulae in the cells of the
calculation table. By linking the individual cells via the formulae, the software
can make various arithmetic operations using the measurement data and then
display the results at any point in the computing chain. Apart from that, you
can also enter comments into the cells.

@ In the table cells, you can display either the formula or the result. To
switch over, select View > Formulae or press the key combination Ctrl+#.

For linking individual cells you establish references. A reference designates a
cell or a cell range in the table and informs the signal processor where the
values or data used in the formula are located. With the aid of references you
can use data or values of a cell in different formulae.

Depending on the operation that you want to execute in the signal processor,
you can either use relative or absolute cell links. Relative cell links are
references to cells that are given in relative to the position of the formula,
absolute references are cell links that always refer to cells at a certain
position. [f a dollar symbol is prefixed to the letter andfor the number, e.g.
$A%1, then the column and/or cell link is absolute. Relative references are
automatically adapted in case of copying, absolute references are not
adapted.

The signal processing resulis are shown as a graph in the analyzer.

2.6.7 Arranging Windows

New window

Cascade

Tiling
horizontally and
vertically

Close all

Window list
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You can arrange all open windows in the application window using the
commands in the menu Window.

To open further analyzers or presentation windows, click B or select
Window > New Analyzer.

You can arrange all windows over each other so that only the title bar and the
y-axis name are visible respectively. To do so, click B or select Window >
Cascade.

You can display all open windows so that they are completely visible and

maximum size. To do so, click =ior 1. You can also select Window > Tile
Horizontally or Window > Tile Verlically.

To close all open windows, select Window > Close All.

At the bottom of the menu Window you will find a list of open windows. To
activate a window — i.e. move it to the foreground — click it in the list.
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settings
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Window setlings which you have made are automafically restored by the
software when you newly open the file. For this purpose, the window settings
are saved in a database under the complete path name of the file. This
database is located on the local hard disk of your PC. Each user which is
logged in Windows has its own database.

You can deactivate restoring the window layout and take over the setlings of
the active window as default for opening other files. To do so, first you have to
change to presentation mode. Then select Setup > Preferences. The dialog
Preferences appears. Display the page Display.

. d8 Reference Display | Messages |

C rWindow Settings —
¥ Restore Yendow Layout at the Start of the Software

‘ Apoly s‘e-tting;s of the activekmw a5 igmd_ for few Ms. : bBpply |
Reset sethngs for new mndows ‘ ) : ‘ . Reset |

—épuhdmmm.
ﬂmiser of Animation Frames: I 18 E];
* Apgular Resolation! 0@

. HNote: The maximun rumber of frames depends on
tha system's memory size.

. —-Tme . ‘ : '-. N - .
ﬂamwnwef{)isphyadsmes: |5242’ﬁﬁ "|

Hote: The higher this rerber the Faster your CPU and larger your
nemory shoold be.
C a5 only affect files opened after the change.

IOKI‘Ca'-ceI.HeIp

Figure 2.9: Page Display in the dialog Preferences

Restore window layout at start of the software: Tick this box in order that,
at the next start of the software, the window layout will be restored like it was
during exiting the software.

Apply: Click here if you want to apply the window settings of the active
window (only presentation window) to other files of the same type. To activate
the window, click it. The window settings are applied to every newly opened
file.

%~ In acquisition mode you can only load window settings from setting files.
See SECTION 10.1.4 on this.
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2.6.8 Zoonming

Zoom

Pan the image
section

2-16

Reset: Click here if you want to reset the window settings for newly opened
files to default values,

& The software needs a few minutes to open files in which the window
seltings are to be restored. You can not abort the process.

in Windows

You can zoom on image sections in both the video window and aiso in the
presentation window. You will find the necessary tools in the toolbars of the
application window and of the presentation window.

If you would like to take a closer look at a certain image section in either the
video or the presentation window, you can zoom on it.

Zooming in on the object helps you define the points and carry out 2D or 3D
alignment more accurately, thus enabling you to present the data more
precisely. This is an advantage, particularly if your object under investigation
has complex geometry or if your scan points are very close together.

To zoom in on a video or presentation window, proceed as follows:

1. Click & . The mouse cursor becomes a magnifying glass with a plus sign.

2. Holding the left mouse button pressed, draw a rectangle around the area
of the image which you want to zoom in on. You can repeat this step
several times.

@ |f you zoom in the video window, on the left in the legend a smaller view of
the measurement object will appear with a frame marking the zoomed
section of it. This means you can always ascertain which part of the object
under investigation you are currently viewing. Once maximum
magnification has been atfained, you will receive a message.

or

3. You can also zoom by scrolling with the middle mouse button (mouse
wheel).

You can pan the zoomed image section.

@ Depending on the video board, the image section selected may not pan
smoothly, but may move across the screen in small jumps.
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2 Flest Steps

Window settings which you have made are automatically restored by the
software when you newly open the file. For this purpose, the window settings
are saved in a database under the complete path name of the file. This
database is located on the local hard disk of your PC. Each user which is
logged in Windows has its own database.

You can deactivate restoring the window layout and take over the settings of
the active window as default for opening other files. To do so, first you have to
change to presentation mode. Then select Setup > Preferences. The dialog
Preferences appears. Display the page Display.

!« diReference - Display I Messagas I
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Figure 2.9. Page Display in the dialog Preferences

Restore window layout at start of the software: Tick this box in order that,
at the next start of the software, the window layout will be restored like it was
during exiting the software,

Apply: Click here if you want to apply the window settings of the active
window (only presentation window) to other files of the same type. To activate
the window, click it. The window setlings are applied to every newly opened
file.

%~ [n acquisition mode you can only load window settings from setting files.
See SECTION 10.1.4 on this.
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Reset: Click here if you want to reset the window settings for newly opened
files to default values.

@ The software needs a few minutes to open files in which the window
settings are to be restored. You can not abort the process.

2.6.8 Zooming in Windows

Zoom

Pan the image
section

2416

You can zoom on image sections in both the video window and also in the
presentation window. You will find the necessary tools in the toolbars of the
application window and of the presentation window.

If you would like to take a closer look at a certain image section In either the
video or the presentation window, you can zoom on it.

Zooming in on the object helps you define the points and carry out 2D or 3D
alignment more accurately, thus enabling you to present the data more
precisely. This is an advantage, particularly if your object under investigation
has complex geometry or if your scan points are very close together.

To zoom in on a video or presentation window, proceed as follows:

1. Click &', The mouse cursor becomes a magnifying glass with a plus sign.

2. Holding the left mouse button pressed, draw a rectangle around the area
of the image which you want to zoom in on. You can repeat this step
several times.

& |f you zoom in the video window, on the left in the legend a smaller view of
the measurement object will appear with a frame marking the zoomed
section of it. This means you can always ascertain which part of the object
under investigation you are currenily viewing. Once maximum
maghnification has been attained, you will receive a message.

or

3. You can also zoom by scrolling with the middle mouse button (mouse
wheel).

You can pan the zoomed image section.

& Depending on the video board, the image section selected may not pan
smoothly, but may move across the screen in small jumps.



Zoom out

Exit zooming

2.7 Printing

Print setup

Preview

Start

2 First Staps

To do so, you have the following options:

1. Using the middle mouse button (mouse wheel), click in the zoomed view
in the video window. Hold the mouse button pressed and pan the image
section. If you have given the middle button a special function (e.g.
double-click), then you will have to proceed as described in step 2.

2. In point mode {(APS, refer to SECTION 5.22) and during 2D alignment (refer

{0 SECTION 4.4}, click 4 and pan the image seclion while holding the left
mouse button pressed.

You can zoom aut again.

To undo zooming, scroll up with the middle mouse button (mouse wheel). To
undo all previous zoom actions at once, click "

To leave the zoom function again, click R The last image section selected
remains.

You can print out analyzers, presentation windows and signal processors. The
title of the window as well as the date and time are automatically printed as a
header.

To set the paper size, feed and orientation, select File > Print Setup. The
dialog Print Setup appears. Here you can select the current printer and set up
the page.

To see a print preview, select File > Print Preview.

To print out the active window {analyzer or presentation window), click & or
select File > Print. If you want to print out a signal processor or if you have
selected the view Single Scan Point, Average Spectrum or Profile in the
presentation window, you can define whether you only want to print one of the
graphics or both. The dialog Print will then appear. Here you can select the
printer and set up further print properties. To start printing, then in the dialog
Print click OK.
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2.8 How to Get Help

Online help

Context-
sensitive help

Explanation of
commands

Software version
and options

You can get help in the software as online help and through short
explanations of commands. You can also display the version of the software
and the software options which are installed.

To open the online help, click 2 or select Help > Contents.

For dialogs and windows you can get context-sensitive online help. To do so,
proceed as follows:

1. Activate the window or dialog you need help with. To do so, click it.
2. Press the key F1. The corresponding page of the online help appears.
or

When a dialog is open, then click Help in this dialog. The corresponding page
of the online help appears.

You can also get explanations for icons and commands without opening the
online help. To do so, peint the mouse at the command or the icon and leave
the cursor there for a moment. The explanation appears on the left in the
status bar. For icons you will also see a brief description on a yeliow
background next to the cursor.

To display the version of the software, select Help > About PSV. The dialog
About Polytec Scanning Vibrometer appears. To display the installed software
eptions, click Options in the dialog.

You can also display information on the operating system, the memory and on
the available space on the hard disk. To do so, click System Info.
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2.9 Controlling the Hardware with the PSV-A-PDA (as an Option)

With the optional PSV-A-PDA you can also call up several software functions,
suich as focusing the laser beam, defining and deleting scan points, etc.

Read secTION 2.9.1 on starting the PDA.

Read seCTION 2,9.2 on setting the IP address of the network board in the
PDA.

2.9.1 Starting the PDA

Control panel

To start the PDA and to call up the required function, proceed as follows:
1. Install the PDA as described in your hardware manual.

2. Make sure that your WLAN Access Point is ready to use and switch it on
as described in your hardware manual.

Switch the PSV on and start the PSV software.
Switch the PDA on.

Switch WLAN on the PDA on as described in the manufacturer's manual.

g © & ©

Setting up the WLAN connection can take several minutes. You can not
connect the PDA to the PSV software until the WLAN connecticn has
been made. The WLAN connection is shown with an icon in the title bar.

o

Select Start > PDASOoft.

~

If you want fo activate the connection to the PSV software, click Yes in the
pop-up message. The user interface of the PDA software appears.

Title bar Exit button

Controi panel

Laser
Menu bar  ——— View setup @[ %4 @I.

Figure 2.10: User interface of the PDA software

You can use this control panel to call up and execute the PDA functions. You
will find more information on this in SECTION 4.4 AND SECTION 4.5.6.
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Menu bar

Exit button

Functions

2.20

The menu bar contains additional functions. You will find more information on
this in SECTION 2.8.2. Apart from that, you make the connection fo the PSV

software here. Te do so, touch the icon . Near the icon the PDA software
shows in which mode you are in the PSV software (2D alignment %;, 3D

alignment @5, scan point definition %?, acquisition mode H or presentation
mode ‘@).

Touch the icon

1 to exit the PDA software.

The PDA supports the following sofiware functions:

Controlling the optics (refer to secTiON 4.1.2)
Switching the scanning heads (only PSV-3D, refer to SECTION 4.5.8)

Defining and deleting alignment points (refer to SECTION 4.4 and
SECTION 4.5.6)

Defining and deleting scan points (refer to SECTION 5.2.2)
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2.9.2 Adapting the IP Address

So that the PDA can communicate with the PSV software, the IP address of
the network board which the WLAN Access Point is connected {o must be
entered in PDA. On delivery of the PSV system, the correct IP address is set.
If you have to change this address at a later point in time, select Setup >
Settings in the menu bar of the PDA. The dialog Settings appears.

% You can only change the IP address if the PDA is not connected to the
PSV software. If required, touch the icon fo disconnect it,

Server [P Address:  |192,168.0.10
Network Timeout [s]: !ﬂ

Acoustic Messages

B

Figure 2.11: Dialog Seltings

Server IP Address: Here you enter the new IP address via the keyboard in
the PDA. To display the keyboard touch the icon B

Network Timeout: Here you select the time in seconds that the software has
to wait until a message is issued. We recommend the presetting of 10
seconds.

Acoustic Messages: Tick this check box if you want to hear an acoustic

message when you are setting/deleting a scan or alignment point or when a
message is issued.

2-2%
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3 Setting up the Software

3 Setting up the Software

Test mode (only
MSA/MSV with
option VDD)

PSV-3D

Before you make a measurement, you have to set up the software for data
acquisition.

@ [n almost all views and modes, you can use the right mouse button to call
up additional menus which contain several commands and functions that
are often needed at this point.

To set up the software, proceed as follows:

1. Gointo acquisition moede. To do so, click * or select View > Acquisition.

@ You can also set some options in presentation mode.

2. Select Setup > Preferences. The dialog Preferences appears.

3. The dialog contains several pages, each with a group of parameters. To
display a certain page, click the name of the group.

4, Set the parameters on all pages. You will find information on this in the
following sections:

Devices setup i SECTION 3.1

Channel settings in SECTION 3.2

Scanning Head settings in SECTION 3.3
Geometry and window settings in SECTION 3.4
Lens Calibration {only MSA) in SECTION 3.5
Seltings for dB Reference in SECTION 3.6
Messages in the software in SECTION 3.7

5. When you have set all parameters, click OK.

&

If you have installed the option VDD for the MSA/MSV (with VDD
decoder), run the fest mode. See SECTION 7.7 on this.

The measurement system PSV-3D enables you to measure and display
vibration vectors in three dimensions.

@ The settings in the software apply for all three controllers respectively. For
this reason, no distinction is made between the individual devices on the
user interface.
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Background
measurement
for UHF

3-2

For the UHF, you can carry out background measurements to attenuate for
the measurement spectral impurities generated by the oscilloscope. For a
background measurement you proceed as follows:

1.
2.

Ensure that the sample is not excited, i.e. does not vibrate,

Select Setup > UHF Background Measurement. You will be asked to
disconnect the excitation from the sample.

Then a measurement of the resting sample is carried out. The excitations
found in the measurement are no signals of the vibrating sample but
spectral impurities of the oscilloscope. These spectral impurities will be
corrected in the following measurements.

You can now start a single point measurement or a scan. Read
SECTION 7.1 or SECTION 7.2 on this.

Please pay attention that you have to regenerate the background
measurement if you:

restart the software.

disconnect and reconnect the vibrometer controller. Read also
SECTION 3.2 on this,

change the Bandwidth or the FFT Lines with a measurement in FFT
mode. Read also SECTION 6.2.4 on this.

change the Sample Freguency or the Samples with a measurement in
Time mode. Read also SECTION 6.2.12 on this.
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3 Setting up the Software

On the page Devices you set which measurement system and which external
devices you want to control with the software,

Depending on the measurement system and equipment, the page Devices
may look different.

. Davices Ichamelsl Scanndng Head| Geornetryl dB Reference | Messages
;i JuncionBox:  [PSV-E-01-tit ]
Device Type Connection | Addeess Warma
Vibeomater Cortietlor 1 | =R N
Vibrometer Controlzr 2 ) Auto _:J - Fr
Gomerstr i qbenat x| ]
Comsa  lpAL(sWdeo) x|use T I B 2O
ok | caxel | el

Figure 3.1: Page Devices

Junction Box: This list is only active for certain hardware configurations.
Junction boxes connected via the USB interface are recognized automatically
and displayed.

@ |f you have the option of changing the hardware selection, you have to log
in as an administrator to change it.

To use the option VDD for MSA/MSYV, you must select the junction box
VDD-Z-010, VDD-Z-011, VIB-E-400-VDD, MSA-E-500 (VDD), or MSA-E-40x
(VDD).

& QOFV-5000: To be able to run the test mode automatically, the controller
has to be controlled remotely via USB and has to be connected with VDD
Vib Controller 1 on the page Channels (refer to SECTION 3.2).

OFV-3001: In this case it is not possible to connect up a controller which
is remotely controlled. There is only a connection to the reference signal,
not the vibrometer signal.

Device: Here the connecled external devices are displayed.
Type: Here you sslect the camera type PAL or NTSC that you are using. If

you are using the junction box PSV-E-401 or PSV-E-401-3D, here you have to
select the camera PAL (S-Video) or NTSC (S-Video).
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Activate PSV-3D

PSV-3D in 3D
mode

3-4

Connection: Here you can select which interfaces should be searched to
iook for external devices. For the vibrometer controllers you have to state
where the devices are connected (RS-232 or GPIB). If the vibrometer
controlier is connected via the USB interface, it will be recognized
automatically. Then you do not have to make any more settings for this
controller. If you are using a generator, you can also state whether the device
is integrated into the PC (internal} or whether it is an externally connected
device.

Address: If you have given a fixed connection, then select the address here
or carry out an automatic search for it (Auto).

Warning: If you change into acquisition mode or have changed any setlings,
then the software will search the PC's interfaces for external devices and
initialize them. Here you mark the devices which you want a warning message
issued for if the software can not find them.

@~ These warnings are not shown if under Setup » Preferences on the page
Messages you have selected Errors or Show None respectively (refer also
to SECTION 3.7).

You can operate the PSV-3D in 1D mode (PSV-3D (1D}) and in 3D mode
(PSV-3D (3D)). In contrast to 3D mode, in 1D mode the signals of every
scanning head are displayed and processed without transforming the
coordinates. The channels measured are designated as Vibrometer Top,
Vibrometer Left and Vibrometer Right.

To activate the PSV-3D in 3D mode, select the junction box PSV-E-401-3D or
PSV-E-400-3D.

@ [f you want to change the hardware selection, you have to log in as
administrator.

Devices | Channgls | Scanting Head | Geometry | dBReference l Messages |

InctionBox:  {PSV-E-10t-3 =]

Deavica Typo Congaction ‘Addrsss Varming
Py ttplexer | Juse =l 2
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Gensratar lmtemat x| ¥
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GeometrySeantit | s =] 4

& | comel | Hobp

Figure 3.2: Page Devices for the PSV-3D
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3 Setting up the Software

On the page Devices you set which measurement system and which external
devices you want to control with the software.

Depending on the measurement system and equipment, the page Devices
may look different.
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Figure 3.1: Page Devices

Junction Box: This list is only active for certain hardware configurations.
Junction boxes connected via the USB interface are recognized automatically
and displayed.

& |f you have the option of changing the hardware selection, you have to log
in as an administrator to change it.

To use the option VDD for MSA/MSYV, you must select the junction box
vDD-Z-010, VDD-Z-011, VIB-E-400-VDD, MSA-E-500 (VDD), or MSA-E-40x
(vDD).

@ OFV-5000: To be able to run the test mode automatically, the controller
has to be controlled remotely via USB and has to be connected with VDD
Vib Controlier 1 on the page Channeis (refer to SECTION 3.2).

OFV-3001: In this case it is not possible to connect up a controller which
is remotely controlled. There is only a connection to the reference signal,
not the vibrometer signal.

Device: Here the connected external devices are displayed.
Type: Here you select the camera type PAL or NTSC that you are using. If

you are using the junction box PSV-E-401 or PSV-E-401-3D, here you have to
select the camera PAL (S-Video) or NTSC {S-Video).
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Activate PSV-3D

PSV-3Din 3D
mode

3-4

Connection: Here you can select which interfaces should be searched to
look for external devices. For the vibrometer controllers you have {o state
where the devices are connected (RS-232 or GPIB). If the vibrometer
controller is connected via the USB interface, it will be recognized
automatically. Then you do not have to make any more settings for this
controller. If you are using a generator, you can also state whether the device
is integrated into the PC (internal) or whether it is an externally connected
device.

Address: If you have given a fixed connection, then select the address here
or carry out an automatic search for it (Auto).

Warning: If you change into acquisition mode or have changed any seitings,
then the software will search the PC's interfaces for external devices and
initialize them. Here you mark the devices which you want a warning message
issued for if the software can not find them.

%= These warnings are not shown if under Setup > Preferences on the page
Messages you have selected Errors or Show None respectively (refer also
to SECTION 3.7).

You can operate the PSV-3D in 1D mode {PSV-3D (1D)) and in 3D mode
(PSV-3D (3D)). In contrast to 3D mode, in 1D mode the signals of every
scanning head are displayed and processed without transforming the
coordinates. The channels measured are designated as Vibrometer Top,
Vibrometer Left and Vibrometer Right.

To activate the PSV-3D in 3D mode, select the junction box PSV-E-401-3D or
PSV-E-400-3D.

% If you want to change the hardware selection, you have to log in as
administrator.
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Device Typa Connection | Address | Waming
P3Y 30 Mutiexer R v
Vibremeter Conteader 2 o [Mene _:J l_
Senwstr L emdlx] g
Cameia P (syide) x| <
GeometrySeantid | UsB M LV
® | camel Help

Figure 3.2: Page Devices for the PSV-3D



P5V-3D as
PSV-1D

PSV-3D in 1D
mode

Fault diagnosis
in 1D mode

3 Setting up the Software

The first device shown to you in the list is the PSV-3D Multiplexer. This
enables you to control all three controllers from the PC using the software via
a single USB cable. Apart from that, under Cennection you can select the
video camera which you would like to use {o view your object. If you have
arranged the scanning heads relatively far apart, then we recommend that
you select the optional video camera Center.

& If you are using a digital camera for PSV-3D as a center camera, select
Digital as the type. If you are not using the video camera Center and the
scanning heads are mounted close to each other, then the video camera
Left is closest to the middle for design reasons. If you are measuring with
the geometry scan unit, we recommend using the video camera Top.

You will find information on connecting up the PSV-3D in the separate
hardware manual.

To activate PSV-3D as PSV-1D, select the junction box PSV-E-401-1D or
PSV-E-400-1D. You will then only need one controller and one scanning
head. Your PSV-3D will then behave like a standard PSV.

@ The channel allocation does not maich the names on the junction box
(refer to SECTION 3.2).

To activate PSV-3D in 1D mode, select the junction box PSV-E-401-3D (1D)
or PSV-E-400-3D (1D). You can use 1D mode for fault diagnosis for 3D mode.

< In 1D mode you can make measurements with one, two or three scanning
heads. You can also use up to two scanning heads as reference.

If you have any misgivings about the measurement results in 3D mode being
correct, you can make a 1D measurement without coordinate fransformation
and check the plausibility of the vibration signals in this mode. The limitations
mentioned in the following apply here.

If you operate the PSV-3D with just one scanning head, then you have to

deactivate the other two scanning heads (vibrometers). To do so, click A2
and display the page Channels, refer also to SecTioN 3.2. Deactivate the two
vibrometers that you do not want to use for making measurements.

However, you can alsa use the other two vibrometers to make reference

measurements. To do so, click #C- and mark the vibrometers as reference
channels.

@ The Vibrometer Top can not be used as a reference channel.

Once you have identified the scanning heads as reference channels, they are
not moved during scanning and can also not be controlled via the video
image. Move the reference scanning heads using the icons Position in the
scanning head controller. You will find more information on this in SEcTION 4.1.

If the scanning heads have not been defined as reference channels, but

simply as Channel, then they are moved during scanning and every scanning
head supplies separate 1D information.
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Special features
for the MSA

3.6

If you are using the MSA-500 with the option MSAGeo, or respectively have
connected an XY positioning stage to an MSA with the option Data import:
Geometry (ImpGeo), then the additional devices are also shown.

 Devkes | Channels | Scanring Head ] Gebmetry | Lens Catbeation | B Reference | Messages |

JnctionBox:  [MEAESEIE ~]

Device Type. Warming
inbretister Controter 1 vi
wibremeter Cordraber 2 ‘L r
GEneratar : ¥
. ) . o 3
bI5A Geometry Unit ! [
R Postioning Stage j’ l_

oK © Canxel Help

Figure 3.3: Page Devices for the MSA

With the option MSAGeo in the MSA-500 you can control the optional XY
positioning stage, focus the laser beam, carry out a 3D alignment and define
3D geometries.

With the option ImpGeo in the MSA-400 or MSA-500 respectively, you can
control the optional XY positioning stage, carry out a 3D alignment and import
3D geomaetries.

@~ As default, displaying the warning message for the XY positioning stage is
not activated. Tick this box if you want a warning message to be displayed
when searching for the devices.



Special features
for the UHF

3 Setting up the Software

If you are using the UHF with the XY positioning stage, then the additional
device is also shown.

i | Devices |Chanmlsi Scanning Head | Geomelry | Lens Caibration | cB‘Refe:egxel Massagas |

Jundciion Box: ILeCmy véav;a?m ?ESﬁ _‘j . \

Device | Type Connaction | Addrass | Warﬁn;
Vibrometer Controter 1 ; |R5Z32 __J Auto ___J 3
Wibvometer Controter Z (Mo _:j |_
Gergrator : | Mone _'_v_] ) |_
Camera pAL(Svideo) x|mone  v| P
RY Postioring Stage j o IUSB :_E i [~

ok | cewed | mep

Figure 3.4: Page Devices for the UHF

Using the software, you can control the XY positioning stage and carry out a

scan with the UHF.

@ As default, dispfaying the warning message for the XY positioning stage is
not activated. Tick this box if you want a warning message to be displayed

when searching for the devices.
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3.2 Channels

3-8

On the page Channels you set which channels you want to use to control
Polytec vibrometers.

Preferences

. Davices Channels |5caming Head | Geometry | d8 Reference | Messagss | -
Channet Dasaription | Abbr, vibrometer
! Vibrofozter Jvks Vibrometer Cantroller 1 v |
2 Referenice 1 IRef1 Vibromete ontm'ierZ_v_J
8 [Refezncez  [Ref2  Nobcomnscted x|
4 Reference3 }Refa Mot connacted _'..I
ok | - cancd | heb

Figure 3.5: Page Channels

Channel: The number of channels displayed depends on which data
acquisition board(s) you are using and which junction box has been selected
on the page Devices (refer {o SECTION 3.1). However, the number of channels
is only updated if you close the dialog Preferences by clicking OK and then
reopening it.

@ |If you want to make a measurement with the MSA/MS8YV using the option
VDD, then you have to connect the channel with VDD Vib Centroller 1 and
set the appropriate junction box on the page Devices (refer to
SECTION 3.1).

Description: A meaningful name for every channel is shown here.
Abbr. An abbreviated name for every channel is given here.

Vibrometer: In this column, a channel is only active if: a Polytec vibrometer is
connected, the vibrometer had already been switched on before changing info
acquisition mode and the correct connection has been set on the page
Devices. Here you select which vibrometer provides the signal for this
channel. You can use the software to control the connected vibrometers as
described in SECTION 7.8.6. For certain hardware configurations and
measurement modes, channels are already permanently connected.
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In the following tables you will find the allocation of digital channels to the
different connections from the individual junction boxes.

Junction box
Channel PSV-E-401-3D PSV-E-400-3D
PSV-E-401 (3D/1D) PSV-E-401-1D| PSV-E-400 (3D/1D) PSV-E-400-1D
1 VELO VELO TOP VELO TOP VELO VELO TOP VELO TOP
2 REF 1 VELO LEFT | VELO LEFT REF 1 VELO LEFT | VELO LEFT
3 REF 2 VELO RIGHT { VELO RIGHT REF 2 VELO RIGHT { VELO RIGHT
4 REF 3 REF REF REF 3 REF REF
51 REF 21 REF 21 REF 21 REF 21 REF 21 REF 21
6! REF 22 REF 22 REF 22 REF 22 REF 22 REfF 22
7! REF 23 REF 23 REF 23 REF 23 REF 23 REF 23
81 REF 24 REF 24 REF 24 REF 24 REF 24 REF 24
1with PSV-E-408
Junction hox
Channel
MSA-E-500 MSA-E-40x msv-z-0ap |LeCroy wavePro
{UHF)
1 VELC IN VELO IN VELO CH2
2 REFIN REF IN REF CH3
Junction box
Channel VIB-E-400-80
VIB-E-220 VIB-Z-010 ViB-Z-012 VviB-2-015 VIB-E-400-1000
1 VELO SIG IN VELO CHANNEL 1 VELO
2 REF REF IN REF 1 CHANNEL 2 REF 1
Junction box
Channel VIB-E-40(-84
VIB-Z-014 VIB-Z-016 VIB-2-017 VIB-E-400-1004
1 VELO VELO VELO VELO
2 REF 1 REF 1 REF 1 REF 1
3 REF 2 REF 2 REF 2 REF 2
4 REF 3 REF 3 REF 3 REF 3
Junction box
Channel MSA-E-500 MSA-E-40x
vDD-Z-010 vDD-Z-011 ViB-E-400-VDD (VDD) (VDD)
1 Vibrometer Vibrometer Vibrometer Vibrometer Vibrometer
signat’ signal’ signaj’ signal’ signal’
2 REF IN REF 1 REF 1 REF IN REF IN

1The vibrometer signal is not fed in through the junction box; it is only available directly in the software (only with option VDD),
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Junction box
Channel
PSV-Z-040-H PSV.Z2-040 -F, -U
1 VELO VELO
2 REF 1 REF
3 REF 2 -
4 REF 3 -

With the junction boxes PSV-E-40x, PSV-E-40x-3D, VIB-Z-012, VIB-Z-0186,
and VIB-E-400 you can select iCP® for the reference channels and also
switch the differential input for alt channels on or off. You will find additional
information on this in SECTION 6.2.2 under the keywords ICP and Differential
input and in your hardware manual as well.

If in addition to the junction box PSV-E-40x or PSV-E-40x-3D, you are using
the junction box PSV-E-408, you can measure four additional reference
channels (Reference 21 to Reference 24) using a second data acquisition
board (PCI-4452 or PCI-4462).

Allocate With the PSV-3D, you can only adjust seftings on the page Channels if you

gg%nggls forthe have an additional reference (single point) vibrometer connected.
I

| Wbromster 30 iP5V 30 Yibremster Conteader 1o
 ‘Reference 1 _viomster Controler2 v ]
Reference 21 Hat connected 3

_{Reference 72 _iNot connected

5 iReference 23 Mot connected
~{Reference 24 Mot connected

Figure 3.6: Page Channels for the PSV-3D

@ |f you want to operate the PSV-3D in 1D mode (junction box PSV-E-40x-
3D (1D)), we recommend connecting the channels Vib Top, Vib Left and
Vib Right with the vibrometer PSV 3D. This way you can remotely control
all three controllers together.
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@ |f you want to operate the PSV-3D as a pure PSV-1D (junction box PSV-E-
40x-1D), then the allocation of the channels displayed does not match the
names on the junction box. Please note the following allocation: Vib
corresponds to VELO TOP, Ref1 corresponds to VELO LEFT, Ref2
corresponds VELO RIGHT and Ref3 corresponds to REF.

3.3 Scanning Head

You can set up the optics of the measurement system on the page Scanning
Head. The settings for the PSV-1D are described in the following. Further
down you will find information on the settings for the PSV-3D and special
features for the MSA and UHF.

Figure 3.7: Page Scanning Head for the PSV-1D

Scanning Head: Select the scanning head of your measurement system
here. The scanning head PSV-1-400 is delivered with the LR (Long Range)
front lens as standard, as an option you can also have the MR (Mid Range)
front lens. Itis necessary to make a distinction between the two front lenses in
the software to calculate the depth of focus correctly. Only PSV-200: Select
the OFV-055F if your scanning head is equipped with a color camera.

Preferred Scan Direction: Here you select how the laser beam is to be
moved when scanning. If the scan points are to be hit row by row, select X-
Direction. If the scan points are to be hit column by column, select Y-
Direction. In the latter case, the scanning time is shorter because the scanner
mirror for the y-direction is smaller and thus has a shorter settling time. If you
select Auto, the software independently optimizes the order in which the scan
points are hit. Select Index if the scan points are to be hit in ascending order
according to the index.

@ |If you have selected Index, you can individually set the order by changing
the indices of the scan points (refer also to SECTION 5.4.2).
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Geometry scan
unit

3-12

Focus Sharpness: This line only appears if you have selected the scanning
head PSV-1-400 LR or MR. You can set the depth of focus here. The smaller
the value you select, the less often the focus is corrected during a
measurement. The standard value is 100%. However you can also set values
to be greater than 100%. But please note that frequent readjustment of the
focus can considerably increase the measurement time.

@ For focus to be adjusted during the measurement, you have to select the
command Focusing during Scan in the menu Scan.

Pan-Tiit Control: This line only appears if you have selected the scanning
head PSV-i-400 or OFV-056 above. Tick the box if you want to control the
optional pan-tilt stage using the software.

Flip Video: Here you can flip the live video image on the x- or y-axis and
thus, if necessary, set it up properly again. Normally the appropriate boxes for
the scanning head have already been selected. However you can also
change the setting as necessary, for example if you redirect the laser beam
with external mirrors and thus obtain a flipped image, or if the scanning head
has been mounted in such a way that it generates a flipped image.

Angle Correction: The vibrometer measures vibrations parallel to the laser
beam. If the laser beam is at an oblique angle to the measurement surface,
then an angle error occurs. Here you select whether the software is to correct
the angle error for the respective axis. The angle correction only provides
correct measurement values if you are measuring a fat surface at right angles
to the scanning head and there is a pure out-of-plane vibration. You should
switch off angle correction for curved surfaces.

@ The function Angle Correction is not available for PSV-3D.

You can adjust the laser of the geometry scan unit and enter an offset to the
distance measured. To do so, first of all activate the vibrometer laser, position
the laser to position 0°/0° and mark the position on the object. Then activate
the geometry laser and point the laser at the marked position.

Current Position: Click here to apply the current position of the geometry
laser as angular deviation Offset X and Offset Y in the sofiware.

Offset Distance: Here you enter the difference between the theoretical and
the real beam path in the scanning head. You will find this value (Geo Offset
Distance) on a label stuck to the bottom of the geometry scan unit. The value
is in the region of max. £3mm.

Signal Level: Here you enter the signal level threshold in % of full scale from
which the scan points should be awarded the Geometry Status Optimal
Measured. The higher the threshold is set, the less scan points will be given
the status Optimal Measured.

@ You can enter values from approx. 40% fo 100%. The lower limit depends
in the geometry scan unit you are using.




Arrangement
gcanning hea

of

for the PSV-3D
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in addition to the setting options for the PSV-1D, with the PSV-3D you can

ds mountthe scanning heads at an angle relative to the video camera used. The

software will compensate for {his tilt if you move the beam with the icons
Position in the scanning head control (refer to sECTION 4.1). SO that the laser
peams can travel In the required direction, you have to set the tilt angle for
every scanning head. The respective tilt angles are given clockwise when
looking in the direction of the emitted laser beam. Two configurations have
already been predefined:

s Staggered horizontally ﬁ

o Star-shaped ®%

Figure 3.8: Page Seanning Head for the PSV-3D

Head Angle: Click & if you have the scanning heads mounted s0 that they

are staggered horizontally. Click ‘@% if you have the scanning heads
mounted In a star-shape. In both of these cases, the tilt angles will be entered
automatically.

If you have mounted the scanning heads with a different tilt, then please enter
the values yourself.

3143




Arrangement of

3 Setting up the Software

In addition to the setting opticns for the PSV-1D, with the PSV-3D you can

scanning heads mount the scanning heads at an angle relative to the video camera used. The

for the PSV-3D

software wili compensate for this tilt if you move the beam with the icons
Position in the scanning head control (refer to SECTION 4.1). So that the laser
beams can travel in the required direction, you have to set the tilt angle for
every scanning head. The respective tilt angles are given clockwise when
looking in the direction of the emitted laser beam. Two configurations have
already been predefined:

o Staggered horizontally - &
s Star-shaped @%

Figure 3.8: Page Scanning Head for the PSV-3D

Head Angle: Click @ if you have the scanning heads mounted so that they

are staggered horizontally. Click @% if you have the scanning heads
mounted in a star-shape. In both of these cases, the lilt angles will be entered
automatically.

if you have mounted the scanning heads with a different tilt, then please enter
the values yourself.
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Special features
for the UHF
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Flip Video: Here you can flip the live video image on the x- or y-axis and
thus, if necessary, set it up properly again. Normally, the appropriate boxes
for the scanning head have already been selected. However, you can also
change the setting as necessary, for example if you redirect the laser beam
with external mirrors and thus obtain a flipped image, or if the scanning head
has been mounted in such a way that it generates a flipped image.

if you are using the UHF, you have restricted settings on the page Scanning
Head.

Figure 3.10: Page Scanning Head for the UHF

Scanning Head: Here you are shown the UHF-I-120 as the scanning head.

Preferred Scan Direction: Here you select how the XY positioning stage is
to be moved when scanning. If the scan points are to be hit row by row, select
X-Direction. If the scan points are to be hit column by column, select
Y-Direction. If you select Auto, the software independently optimizes the order
in which the scan points are hit. Select Index, if the scan points are to be hit in
ascending order according to the index.

@ If you have selected Index, you can individually set the order by changing
the indices of the scan points (refer also to SECTION 5.4.2).

Flip Video: Here you can fiip the live video image on the x- or y-axis and
thus, if necessary, set it up properly again. Normally, the appropriate boxes
for the scanning head have already been selected. However, you can also
change the setting as necessary, for example if you redirect the laser beam
with external mirrors and thus obtain a flipped image, or if the scanning head
has been mounted in such a way that it generates a flipped image.
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3.4 Geometry

Hidden Points
Calculation

3-16

On the page Geometry you can get the software to calculate hidden points
and have the focus values calculated automatically using the focal length of
the lens in the scanning head.

Figure 3.11: Page Geometry for the PSV-1D

Calculate Hidden Points: Tick this box if you want the software to calculate
which points are hidden by other parts of the geometry.

@ If you are working with a large number of scan points, this calculation can
take some time. In this case, you can deactivate the calculation here.

@ Calculation of the hidden points is not available for the UHF.

Tolerance for Calculating Hidden Points: Here you can enter a tolerance
value for recognizing hidden points. The tolerance value is used {o
compensate for the deviations between the defined geometry and the actual
shape of the object under investigation. Scan points which can only be
reached by the laser beam if they pass the geometry at a distance smaller
than the tolerance value, are marked as Hidden.

Recommended: Click here and the software will give you a recommendation
for the tolerance value, the result of which depends on the typical distance
between scan points (approx. half).

Typical Distance between Scan Points: Here the software shows the
typical value for the distance between two scan points.




Automatic
Calculation of
the Focus
Values
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Calculate Focus Values Automatically: Tick this check box if you want to
have all focus values calcutated automatically on the basis of the focal length
of the lens in the scanning head. If you do not know the focal length of the
lens, then you will have to calculate it. To do so, start a scan with the function
Assign Focus Fast or Assign Focus Best (refer also to SECTION 5.6.2). Every
scan point is assigned a focus value. Then click Calculate.

<@ Aufomatic calculation of the focus vaiues is not available for the MSA/
M3V and the UHF.

Calculate: Click here if you want to calculate the focal length of the lens in
the scanning head from the focus values identified. The focal length will then
be entered automaticatlly.

Focal Length of Lens for Scanning Head: If the focal length of the lens in
the scanning head is known, you can also enter the value directly.

@ For the PSV-3D the focal length of the lenses for all three scanning heads
(Top, Left and Right) are entered here.

Figure 3.12: Page Geometry for the PSV-3D
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3.5 Lens Calibration (only MSA and UHF)

Adapt lens
settings

3-18

On the page Lens Calibration you enter the name or the type and resolution of
the lens used. The dialog already contains some {enses with the respective
values as defauit. You can overwrite these entries and add any number of
other lenses.

Figure 3.13: Page Lens Calibration

You can adapt the lens settings at any time, independently of whether you are
in acquisition mode or in presentation mode (refer also to SECTION 2.5).

Lens ldentifier: Here you can enter a name for the lens or the zoom factor of
the lens. This identifier is also saved in the scan.

Horizontal... pixels for...jym: Here you enter the number of pixels in a
horizontal direction which corresponds to a certain section length your
microscope image in jam.

Vertical...pixels for...um: Here you enter the number of pixels in a vertical
direction which corresponds to a certain section length your microscope
image in Jm.

Factor: Here you will be shown the magnification factor of the lens depending
on your entries. This value corresponds with that printed on the lens.

@~ Please pay attention that with the UHF the magnification of the lens is
decreased by the factor 4. You can only see the correct magnification
factor in the dialog Preferences on the page Lens Calibration.



Add lenses

Delete lenses

Determine
pixels and
distance
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You can only add further lenses for data acquisition if you are in acquisition
mode.

New: Click here to add a new lens to the list Lens |dentifier. The new lens is
given the same name as the last one selected, supplemented by a
consecutive number, e.g. x20 (2). The number of pixels and the distance
(horizontal and vertical) of the last lens selected are also applied. Overwrite
the entries with the appropriate values.

Delete: To delete a lens, select it in the list Lens identifier and click here.
Then, if necessary, select another lens and click OK.

To determine the pixels and the distance for the lens used, proceed as
follows:

1. Exit the P8V software.

2. Place the stage micrometer supplied under the microscope lens and use
the keys on the junction box MSA-E-500 or MSA-E-40x or resp. on the
controller UHF-E-120 to switch the illumination on.

3. Start the BCAMViewer. To do so, double-click the icon scapviewer ON the
desktop. The BCAMViewer window appears.

Figure 3.14: Exampie of the BCAMViewer window

4. Double-click the name of the camera, e.g. A101f in the navigation area on
the left side of the window.

5. Maximize the window and click @ The video image is displayed. If you
see a gray video image instead of the stage micrometer, you have to
deactivate the trigger as follows.
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Figure 3.15: Video image with stage micrometer

6. To do so, select View > Properties. The dialog Properties appears.
7. Here display the page Trigger and deactivate the check box Use Trigger.

8. If the video image does not fill the BCAMViewer window completely, click
B, The video image will be adapted to the window section.

9. Using the mouse, draw a frame over the stage micrometer. In the status
bar of the BCAMViewer, the width and height of the frame is shown in
pixels.

If you start the BCAMViewer again, you will be shown the last frame set. To
delete an existing frame, proceed as follows:

10. Click :_:. The frame is activated and maximized, i.e. it encloses the whole
video image.

11. Now, using the mouse, draw the required frame.

12. On the stage micrometer, read the width and the height of the frame in pm
and in the status bar, read the width and the height of the frame in pixels.

13. Close the BCAMViewer and start the PSV software.

14. Go into acquisition mode, open the dialog Preferences and display the
page Lens Calibration.

15. Under Horizontal enter the width in pixeis and in um and under Vertical the
height in pixels and in pm.

@ Make sure that you switch the microscope illumination off again before
making a measurement.
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3.6 dB Reference

On the page dB Reference you can define dB = 0. You can thus directly follow
an online measurement with a certain dB reference.

L odgReterence ] U
1

Angle

Angular Acceleration

i

1.. —
Argulsr Velodty S

!

!

!

Figure 3.16:Page dB Reference

@ Changes you make here only have an effect on the global 0dB reference
{appiies to all Polytec products). If you want to change the local 0dB
reference for the active document, you have to open the page in
presentation mode. See also SECTION 8.4 under 0dB Reference on this.

Default Settings: Click here if you want to recover the original settings for
the 0dB reference.

Quantity: All available physical quantities are shown here.
0dB Reference: Here you can define the factor for the respective unit,

Unit: The unit for the respective physical quantity is shown here.

Example:
Quantity 0dB Reference Unit
Displacement 2e-3 m

The 0dB reference for the quantity Displacement is 2Zmm.

@ |f you want to evaluate combined signals (e.g. Vib & Ref1, see also
SECTION 8.4 on this), define the 0dB reference for both quantities.
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3.7 Messages

3-22

On the page Messages you select which system messages you would like to
have displayed.

@ Message windows which contain queries or which advise you of faulty
input will appear in any case.

Figure 3.17; Page Messages

Show All: Click here if you would like to see all messages (notes, errors and
warnings).

Warnings: Click here if you would like to be informed of warnings and errors.
Errors: Click here if you would only like to see error messages.
Show None: Click here if you do not want to receive any system message.

Suppress Messages for Automation (Scripting): Tick this box if you want
to suppress messages during an automatic activity {Scripting). Otherwise it is
possible that the activity of macros is disrupted by these messages.

l.og Messages: Tick this box is you want to log all messages. You will find
the log file on the Control Panel. To do so, select Start > Settings > Control
Panel and double-click Management and then Display Events. The window for
the Event Viewer appears. Under Polytec you will find a log of the messages.

You can export the list. To do so, click B or select Action > Export List. The
dialog Export List appears. Navigate to the required saving location, enter the
file name and click Save.
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4 Setting the Optics

Depending on which measurement system model you have, you can control
certain optical functions:

Controlling the Hardware, refer to SECTION 4.1
Automatically Focusing the Laser Beam, refer to SECTION 4.2

image Settings of the Live Video image, refer to SECTION 4.3. Here, you adjust
contrast, brightness and color of the video image.

Performing 2D Alignment, refer to SECTION 4.4. Here, the positions on the live
video image have to be aligned with the position of the laser beam on the
measurement plane.

Performing 3D Alignment, refer to SEcTION 4.5. Here, the position and
alignment of the scanning head (PSV/MSA) or scanning heads (PSV-3D) in
the coordinate system of the object are determined.

You will find further information on achieving successful 3D alignment in
SECTION 4.6,

4.1 Controlling the Hardware

You can control certain functions of the hardware as described in
SECTION 4.1.1 and SECTION 4.1.2.

For the PSV-400, PSV-300 and the PSV-400-3D, you can use the software to
control all the optics and the optional pan-iilt stage.

For the MSA-500, MSA-400 or MSV-400 with the sensor head OFV-551/-552,
you can use the software to position the laser beam and aiso remotely control
the beam shutter and the optional dimmer on the sensor head. If you are
using the MSA with the optional XY positioning stage, you can control it using
the software. You set the other functions using the hardware. See your
hardware manual on this,

For the UHF-120, you can use the software to attenuate the laser beam and
also remotely control the XY positioning stage. You set the other functions
using the hardware. See your hardware manual on this.

For the MSV-/MMA-300 with the sensor head OFV-511/-512, you can only
position the laser beam with the software. You set the other functions using
the hardware. See your hardware manual on this.

For the PSV-200 you can only use the software to focus and position the laser
beam. You control the video camera and the opticnal pan-tilt stage with the
video box. See your PSV-200 manuat on this.

@ You can remotely control the connected vibrometer controlier. To do so,

proceed as described in SECTION 6.2.8 or use the range changer in the
status bar.
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4.1.1 Controlling the Optics with the Software

Focus the laser
heam

Switch the laser
heam on or off

4-2

To controt the optics with the software, proceed as follows:

1. Go into acquisition mode. To do so, click @ or select View > Acquisition.
2. 1fyou do not see the scanning head control in the application window,
then click " to display it. You can also select View > Scanning Head.

3. Only scanning head MSY, MSA-I-500 and MSA-I-400: From the list Lens,
select the magnification which your microscope is set at.

@ |f you can not see the list Lens in the scanning head control, then first of
all set up the software for your measurement system. See CHAPTER 3 on
this.

4. If necessary, maximize the videc window. To do so, in the tifle bar of the
video window on the right, click ],

5. If necessary, adjust the image settings of the live video image. See
SECTION 4.3 on this.

6. Using the icons in the scanning head control, you can now work as
described in the following.

Focus the laser beam with the icons ‘N {close-up) and F’
(infinity). With the PSV-400 you can also focus the laser

beam automatically with the icon ¥, You will find more
information on this in SECTION 4.2. Above the icons you will
see the optical signal level shown as a bar. This makes
manual focusing easier. The LEpD OVER shows when the
set measurement range is exceeded. In this case it lights
up red. If it lights up permanently, then you have to select
the next highest measurement range.

If you are using junction box PSV-E-401, PSV-E-400,
PSV-E-401-3D or PSV-E-400-3D, you will see the box
Laser for every scanning head. Click the boxes fo switch
the respective laser on or off.




Dim the laser
heam (as an
option)

4 Setting the Optics

If you are using a scanning head with the geometry scan
unit and switch to the geometry laser, then the box Laser
for the scanning head Top is not active. In this case it is not
the optical signal level of the vibrometer controller that is
shown, but the signal level of the geometry scan unit. if the
geometry scan unit receives too much light, the LEp OVER
lights up red. You can switch on a filter to weaken the
intensity of the laser. To do so, mark the box Filter {refer
also to SECTION 5.5). If there is not enough light available,
the signal level display disappears. This means you can
tell whether your measurements will provide an acceptable
result. To display the signal level, the geometry scan unit
has to continuously determine the lighting conditions. This
is why the laser beam blinks approx. every 2 seconds.

If an additional vibrometer controller is connected and
active, then another field is shown in the scanning head
control. As this vibrometer controller is not connected up to
the system via the junction box, you can not switch the
laser beam on and off here. However, the display for signal
level, overrun of the measurement range as well as
focusing the laser beam are available to you as described
above.

if you are making measurements using the UHF-120, you
will see the box Laser for the sensor head. Click the box
(refer to figure)} to switch the laser to full power. If you start
a measurement, the laser wiill automaticaily be switched to
full power. If the measurement is finished, the laser will
automatically be attenuated again. With the UHF, the
optical signal level can not be shown as a bar. For
optimizing the signal level, you have to monitor the
modulation amplitude of the vibrometer channel (CH2) on
the oscilloscope.

If you are using the junction box MSA-E-500 with the
scanning head MSA-I-500 or the junction box MSV-E-40x
with the scanning head MSA-I-400, you can control the
heam shutter and use it to switch the laser on and off. To
do so, click the box Laser. You can aiso switch the laser
beam on or off directly by pressing the key LASER on the
sensor head. See the manual of the sensor head on this as
well. Apart from that, in the scanning head control, the
slider Laser Dimmer is shown as an option. By moving this
slider with the mouse in the direction Max. you can reduce
the light intensity of the laser heam.
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Focus the MSA
laser heam (as an
option only for
MSA-500)

Show channels

4-4

If you are using the junction box MSA-E-500 with the
scanning head MSA-1-500 and the option MSAGeo, you
can focus the laser beam. Focus the laser beam manually

with the icons ‘N’ (close-up) and F¥ (infinity). In doing so,
you travel up or down the z-axis. You can position the z-

axis directly at zero position. To do so, click *. The z-axis
is then positioned in the middle of your range of travel. As
an option, you can alsc automatically focus the laser beam

. . ‘BAE .
using the icon ¥ Here, you automatically travel along the
Z-axis and stop at the position at which the signal level is
highest. The position D of the z-axis is displayed under the
icon {0...250um). Read af the top under Bim the laser
beam how to switch the laser on or off or how to dim the
laser beam.

Here you can watch the modulation of the active channels
(Vib, Ref1), for example as soon as you have started a
continuous measurement. You can use the slider
Generator to directly change the magnitude of the
generator signal. The scale of the slider is not linear. If you
point the mouse at the slider, you will be shown the value
of the amplitude on a yellow background. The minimum or
maximum amplitude of the slider is determined by the
value you entered for {the generator signal (refer to
SECTION 6.2.9). Apart from that, you can modulate

individual channels automatically by clicking H for the
corresponding channel. This optimizes the input range of
the data acquisition board or the sensitivity range of the
vibrometer controller respectively. You can modulate all

channels together automatically by clicking ‘# while
holding the shift key pressed.

If you are using the PSV-400-3D, the channel is shown
separately for each scanning head (Vib Top, Vib Left, Vib
Right). Modulation is displayed before the coordinates are
transformed. This is why you can check the cabling with
the aid of this display. If the signal from one of the scanning
heads Is missing, then the display for this channel will be at
zero at the start of the measurement.

If you are using the UHF, you can only watch the
modulation of the active channels (Vib, Ref1). Controlling
the generator signal is not available.
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factor for the
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You move the laser beam with the icons Position. To do so,

click the icon for the direction required. If you click *, the
laser beam is positioned in such a way that it is emitted at
right angles to the front panel of the scanning head
(position 0; 0).

Under the icons you will see the position of the laser beam
in degrees related to the horizontal and vertical axis. With
the MSA/MSYV system, the position is shown as a
percentage of the mirror deflection. At 100% the laser
beam is at the far right/at the top.

You zoom the video camera with the slider Zoom. Using
the mouse you can roughly set the slider. If the slider is
active, you can fine-tune it with the arrow keys Tand . (To
activate the slider, click it.)

You focus the video camera with the slider Focus. Using
the mouse you can roughly set the slider. If the slider is
active, you can fine-tune it with the arrow keys T and {. (To
activate the slider, click it.)

You can also focus automatically. To do so, click
Autofocus. Automatic focusing can take several seconds
during which the software is inactive.

You control the motorized pan-tiit stage with the icons Pan-
Tilt. If you can not see the icons in the scanning head
control, then first of all activate the pan-tilt stage for the
software. See SECTION 3.3 on this. To pan the scanning

head, click & or 2. Totilt the scanning head, click - or
i

if you are using the scanning head MSA-1-500, MSA-1-400,
MSV, or UHF-1-120, you select the zoom factor set on the
microscope here. The software will calculate the
coordinates of the scan points from the zoom factor set
and the position of the scan points on the video image.
Please pay attention that with the UHF the magnification of
the lens is decreased by the factor 4. You can only see the
correct magnification factor in the dialog Preferences on
the page Lens Calibration.
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Enter coordinates
of axes

3D Point

4-6

X

]

Bea

The efement 2D Point is displayed if there is 2D geometry.
Right at the top, the Index of the selected scan point is
shown, below that its Status (refer to SECTION 7.3 as well).
Enter the distance between the scanning head and the
measurement object in the empty field and press Enter.
The one of the three axes for which you can define the
distance depends on the direction of the vibrometer
channel in the dialog Acquisition Settings (refer

toSECTION 6.2.2). The figures next o this apply to the
direction +Z.

As the axis which shows the distance of the measurement
object from the scanning head is in the opposite direction
to the laser beam, the coordinate for the object always has
the inverse sign. if you enter the distance between the
measurement object and the scanning head as z-
coordinate, the software calculates the x- and y-
coordinates of the respective scan point under the
assumption that the object is flat and is positioned
vertically fo the 0° direction of the laser beam. The z-
coordinate is thus the same for every scan point. The
origin of the coordinate system is the point at which the
laser beam is emitted in 0° direction from the front of the
scanning head.

The coordinates which show the distance of the object
from the scanning head are used as a preset for the object
distance when exporting the geometry in Universal File
format and ME'Scope format.

For measurements with the close-up unit PSV-A-410 or
OFV-056-C, you have fo add 41 millimeters to the stand-off
distance. This corresponds fo the optical path length inside
the close-up unit (refer also fo SEcTION 10.2.3 and

SECTION 10.2.4).

The element 3D Point is displayed if there is 3D geomeiry.
Right at the top, the Index of the selected scan point is
displayed. Below that, the coordinates (X, Y, Z) of the scan
point are displayed. The coordinate system used here is
the one which you determined with the 3D alignment (refer
to SECTION 4.5).

The software calculates the distance D, i.e. the distance
between the selected scan point and the point at which the
laser beam in 0° direction intersects the plane of the front
of the scanning head. For the PSV-3D, the distance to the
scanning head Top is always given.
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If you are using the MSA-500 with the option MSAGeo or
the MSA-400 or MSA-500 with the option Data import:
Geometry (ImpGeo) and the optional XY positioning stage,
you can control this with the software. Controlling the XY
positioning stage is also available for the UHF.

Before you can use the XY positioning stage for a
measurement, you have to carry out a reference run. To do
80, click Reference. This travels the axes of the XY
positioning stage to the limit switches and then back to the
origin (0/0). Below that, the absolute position (X, Y} is
displayed. For the UHF applies: If you have not carried out
the reference run, it will be automatically carried out first
when you start a scan.

To move the XY positioning stage, enter the reguired
position in x- and y-direction and click Move. Tick the box
Relative if you want to move from the current position by
an offset. Tick the box Joystick if you want to control the
XY positioning stage with the help of the optional joystick.
See the manual of the XY positioning stage on this as well.

You can move the XY positioning stage using your mouse.

To do so, click ”I}’ in the video window and move the
positioning stage in the required direction while pressing
the left mouse button. Hold the shift key pressed and the
positioning stage will only move in the respective main
direction of movement. Zoom in on the video window to be
able to move the XY positioning stage more precisely (refer
to SECTION 2.6.8).
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4.1.2 Controlling the Optics with the PSV-A-PDA

Position the
laser heam

Focus the laser
beam manually
{PSV-1D)

Focus the laser
beam
automatically

Switch the laser
on and off
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To control the optics with the optional PDA, start the PDA as described in
SECTION 2.9.1. The user interface of the PDA software appears.

Laser !

GrEs

Figure 4.1; User interface of the PDA software

Move the laser beam with the icons < g % and To do so, touch the

icon for the direction required. |f you touch @ , the laser beam is positioned in
such a way that it is emitted at right angles to the front of the scanning head
(position ¢; 0}.

@ You can also use the 5-Way Navigation button on the PDA to position the
laser beam. To do so, press the button for the corresponding direction.

Focus the laser beam manually with the icons @N (close-up) and F%
(infinity). Below the icons you will see the optical signal level shown as a bar.
This makes manual focusing easier. The signal level displayed is identical to
that in the software and on the scanning head. The LED next to the icons
shows when the set measurement range is exceeded. In this case it lights up
red. If it lights up permanently, then you have to select the next highest
measurement range.

With the PSV-400 you can also focus the laser beam automatically with the
icon @& See SECTION 4.2 on this.

You can switch the laser on or off in the scanning head by ticking or
deactivating the box Laser.
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4.2 Automatically Focusing the Laser Beam

With the PSV-400 you can automatically focus the laser beam. There are two
ways to do so:

¢ Focusing with the Software, refer to SECTION 4.2.1
¢ Focusing with the PDA (as an Option), refer to SECTION 4.2.2

4.2.1 Focusing with the Software

PSV

PSV-3D

To automatically focus the laser beam with the software, click € in the
scanning head control.

@~ Automatic focusing can take several seconds, during which the software
is inactive.
If the laser is nearly optimal focused, you can automatically focus

significantly faster. To do so, hold the control key pressed and click Lo
The software only searches for the optimal focus in a limited range. Faster
automatically focusing is only available from a certain firmware version of
the vibrometer controller. Please contact Polytec on this.

If you are making a measurement with the PSV-3D, hold the shift key pressed

while clicking @5’5 This allows all three laser beams to be focused at the same
time.

== |If you have switched the lasers off, i.e. the check boxes Laser in the
scanning head control are deactivated, the software will automaticaliy

switch all lasers on as soon as you click &,

4.2.2 Focusing with the PSV-A-PDA (as an Option)

PSV

PSV-3D

Automatically focus the laser beam with the PDA by touching the icon @&

&= Automatic focusing can take several seconds during which the software is
inactive.

If you are making a measurement with the PSV-3D, you can select the
scanning heads and focus them individually automatically.
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4.3 Image Settings of the Live Video Image (2D View)

4.3.1 General

Title

Background

4410

You adjust the image settings of the live video image in the dialog Display
Properties on the pages:

e (eneral, refer to sEcTION 4.3.1 and
+ Video, refer to SECTION 4.3.2.

To open the dialog, double-c!‘ick the live video image. You can also click the
live video image with the right mouse button and then select Video Properties
in the context menu.

You can also activate the video window (to do so, click it) and then select
Scan > Properties. Then display the appropriate page.

@ Depending on the type of measurement and the geometry, not all settings
options are shown in the dialog.

On the page General you set up the view of the video window on the screen.

Figure 4.2: Page General

Show: If you would like to display a title above the video window, tick the box.
You enter the title on the right.

Font: Click here to format the title. The dialog Font appears.

Here you select the background color for the video window.




4.3.2 Video

4 Setting the Optics

On the page Video you adjust the camera settings.

Figure 4.3: Page Video

Monochrome: Here you can change color images to black and white.This is
recommended for measurements with the optional close-up unit PSV-A-410
or OFV-056-C, as it is equipped with a red filter.

Automatic Gain Control: Deactivate this box if you want to switch the
automatic gain control for the video camera off again. This function is only
available to you with analog, controllable video cameras (e.g. PSV-I-400 or
VCT-072 H).

Contrast: Here you set the contrast of the live video image.

Brightness: Here you set the brightness of the live video image.

Saturation: For color images you set the color saturation here (not for MSA/
MSV systems).

llumination: This slider only appears for MSA/MSV systems and for the
UHF. You can adjust the brightness of the illumination here. See your
hardware manual on this as well.

Graphics Transparency: Here you adjust the transparency of all inserted
graphic elements (e.g. scan points, alignment points, crosshair, signal level).

@ Maybe, this function is not available to you depending on the configuration
of your system.

Defaults: Click here to load the default settings for the live video image.
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4.4 Performing 2D Alignment

How?

When?

Tips

PSV-3D

412

To define scan points on the live video image and to move the iaser beam
using the mouse, you have to align the positions on the live video image with
the position of the laser on the measurement plane. As you are aligning two-
dimensional coordinate systems, you have to align at least two points with
different horizontal and vertical coordinates.

@ You have to perform this 2D alignment in any case for the PSV, PSV-3D,
MSA, and MSV. For the UHF, the 2D alignment is not necessary and not
workable.

You can perform 2D alignment with the software as described in the foliowing
sections. However you can also use the optional PDA to help you.

You have to realign when you

e are working at a different stand-off distance or
e have zoomed the video camera.

The following tips make it easier to align:

s The more points you align, the more precisely the software positions the
laser beam.

o Distribute the alignment points evenly over the whole measurement
surface. If, for example, you want to scan a rectangular surface, it would
make sense {o choose four alignment points near the corners.

o Align those points which you want to position precisely when scanning.

o To increase the precision, you can zoom in on image sections. Read
SECTION 2.6.8 on this.

< {f you want to import geometry data in point mode, you also havs to
perform a 2D and 3D alignment first. You will find detailed information on
geometry import in SECTION 5.2.8.

if you are using the PSV-3D, then you are making a measurement with three
independent scanning heads. So you have to perform a 2D alignment for
every individual scanning head first as described in the following.

After that, you have to perform a 3D alignment to position the three laser
beams at one geometry point and have to transmit the vibration data into the
coordinate system of the object under investigation. 3D alignment is
described in SECTION 4.5.

@ A 3D alignment without previous 2D alignment is possible. To make a
measurement however, you will need both.




Start 2D
alignment

Position the
laser beam

4 Setting the Optics

To perform 2D alignment, proceed as follows:

1.

Click % or select Setup > 2D Alignment. The software maximizes the
video window and displays the scanning head control.

If necessary, delete all existing alignment points first. To do so, click the
video image with the right mouse button {not an alignment point) and
select Delete All in the context menu.

Click the video image with the right mouse button and deactivate Auto
Align in the context menu.

Move the laser beam with the icons Position in the scanning head control
to an alignment point on the object, refer also {o SECTICN 4.1.1.

With a bit of practice, you can position the laser beam more quickly for
atignment by using the mouse to move it to approximately the right place
first. If necessary, you can then use the scanning head control for fine-
funing as described above. Hold the middle mouse button (mouse wheel)
pressed and drag across the video image with it. The laser beam follows
the mouse cursor, although not very precisely yet, as 2D alignment has
not yet been performed.

If you have allocated a special function to the middie mouse button (e.g.
double-click}, then this method of alignment is not available.

To set the alignment points in detail on the object, you can use the
optional PDA. To do so, start the PDA as described in SECTION 2.9 The

user interface of the PDA software appears. The icon 4’4* in the menu bar
teils you that you are in 2D alignment.

Laser

wewsetplQlty B

Figure 4.4; User interface of the PDA software
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Define
alignment
points

4.14

Center the laser beam by touching the icon @ with the stylus and
position the Iaser beam by touching the corresponding icon for the

direction <7, . =2, If you touch an arrow symbol for more than
approx. one second the PDA switches to fast forward. For fine
adjustment you can always briefly touch the icon again.

You can also use the 5-Way Navigation button on the PDA to position the
laser beam. To do so, press the button for the corresponding direction.

in the live video image, point the mouse precisely at the laser beam and
click. You can now see a target there.

If you are using the optional PDA, define an alignment point by touching

the icon *lii*. You can also use the central Enter key on the PDA. The
software searches for the laser beam in the video image and defines an
alignment point at this position. If the software does not find the laser
beam in the video image, defining the alignment point fails and a
corresponding message appears on the PDA.

Please make sure that you yourself are not caught by the video camera,
as your movement can interfere with recognition of the laser beam.

If the laser beam is not precisely in the middle of the target, repeat step 5.

Repeat steps 4 to 6 for at least one other alignment point.

Once you have aligned all points, click % again or select Setup > 2D
Alignment.
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Check If you are using the optional PDA, you can check the defined alignment points
alignment with the laser heam by toggling the points on the object. To do so, select View
points > Toggle Points in the menu bar of the PDA.

Laser

Figure 4.56: Toggle alignment points

Then touch the icon The laser will toggie backwards or forwards
towards the defined alignment points.

Delete To delete an individual alignment point, click it with the right mouse button and
ali?ntment select Delete in the context menu.
points

& |f you are using the optional PDA, then you can delete an alignment point
by positioning the laser beam on the alignment point and then touching

the icon % The software searches for the laser beam in the video image
and deletes the alignment point at this position, If the soflware does not
find the laser beam in the video image, deleting the alignment point fails
and a corresponding message appears on the PDA. Please make sure
that you yourself are not caught by the video camera, as your movement
can interfere with recognition of the laser beam.

To delete all the alignment points for one scanning head, click the video
image with the right mouse buiton and select Delete All in the context menu.

Special features If you are performing 2D alignment with the PSV-3D, please also pay
for PSV-3D attention to the following points:

@ Before starting with the 2D alignment, you have to enter the correct angle
of the scanning heads to the video camera in the dialog Setup >
Preferences on the page Scanning Head (refer to SECTION 3.3 under
Arrangement of scanning heads for the PSV-3D).
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1. For the PS8V-3D, define at [east four alignment points for each scanning
head. When doing so, the following applies:

o In the case of simple level surfaces, it is often already enough to use
four to six alignment points to get good resuits.

s The larger the surface, the greater the deviations, particularly in the
areas close to the edge.

s |fthe results of the alignment are not satisfactory (see below in section
Check alignment, step 3), then define at least ten alignment points per
scanning head.

2. To select the individual scanning heads, use the list in the scanning head
control or click the video image with the right mouse button and select one
of the scanning heads (Top, Left or Right) in the context menu.

@ When you select a new scanning head for alignment, the alignment points
of the other scanning heads which have already been defined are saved.

If you are using the optional PDA, select one of the three scanning heads
by touching the corresponding icon @ Top (O Lleft (O Right

@ Top Oleft ORight [ Laser

Figure 4.6: User interface of the PDA software for the PSV-3D

3. Once you have defined all alignment points for one scanning head, then
select the other two scanning heads one after the other as described in
step 2 and define the alignment points for these scanning heads in the
same way.

@ |f you want to define scan points in the scan point definition, it is
necessary for the laser beam and the point clicked on the screen to match
as precisely as possible. If you import or teach-in the scan points as a
Universal File, then an approximate match is good enough.
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Align with Auto  You can perform an automatic 2D alignment. To do so, proceed as follows:

Align

@ Before starting with 2D alignment on the PSV-3D, you have to enter the

correct angle of the scanning heads to the video camera in the dialog
Setup > Preferences on the page Scanning Head (refer to SECTION 3.3
under Arrangement of scanning heads for the PSV-3D).

video window and displays the scanning head control.

If necessary, delete all existing alignment points first. To do so, click the
video image with the right mouse button (not an alignment peint) and
select Delete All in the context menu.

Click the video image with the right mouse button and select Auto Align in
the context menu.

In the video image, click the point on the object at which you want to
define the alignment point. The software will automatically position the
taser beam there and define an alignment point.

@ This function is not available for the MSA/MSV.

Abort alignment  You can abort the alignment at any time. To do so, click % or select Setup >
2D Alignment. You will be given a message that the alignment was not
finished correctly and you can now decide whether you want to repeat it or

Check
alignment

not.

Now test the 2D alignment as follows:

1.

If the scan points are shown in the live video image, click m to hide
them.

Point at the live video image and click a point on the measurement plane.
The laser beam moves to this point on the object.

Check if the position of the laser beam corresponds to that of the point
clicked. If this is not the case, repeat the 2D alignment.

The live video image shows a two-dimensional image of the three-
dimensional object. For this reason, the laser beam does not precisely hit
points which are not on the measurement plane.

Repeat steps 2 and 3 for a few more alignment points.
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4.5 Performing 3D Alignment

3D alignment is always necessary if you want to use 3D geometries. 3D
alignment determines the position and alignment of the scanning head {PSV/
MSA) or scanning heads {(PSV-3D) in the coordinate system of the object.

@ For the PSV-3D it is imperative that you perform 3D alignment. For the
UHF, the 3D alignment is not necessary and not workable.

@ With the micro scanning lenses PSV-A-CL80, PSV-A-CL150 and
PSV-A-CL300 it is not possible to perform 3D alignment! The close-up
unit without micro-scanning lenses does not affect 3D alignment.

For 3D alignment you need points on the measurement object for which the
coordinate description is known in a cartesian coordinate system. You have to
hit these points with the laser. The software will then caiculate the 3D
alignment.

tn the following section you will find information on:

o Performing 3D Alignment for Different Systems, refer to SECTION 4.5.1
o Supporting 3D Alignment with the PSV-A-PDA, refer to SECTION 4.5.6
o Information for a Successful 3D Alignment, refer to SECTION 4.6

4.5.1 Performing 3D Alignment for Different Systems

PSV

PSV-3D

MSA

4-18

For the PSV you have the following options for performing 3D alignment.

pPsv

Scanning head without geemetry scan unit | Scanning head with geometry scan unit
Go to SECTION 4.5.2, Go t0 SECTION 4.5.3.

For the PSV-3D you have the following options for performing 3D alignment.

PSV-3D

Without geometry scan unit With geometry scan unit

Go to SECTION 4.5.4, Go to SECTION 4.5.5.

For the MSA you have the folfowing options for performing 3D alignment. For
this purpose you will need either the option Data import: Geometry (ImpGeo)
or the option MSAGeo.

MSA

MSA-400/MSA-500 with option ImpGeo

or MSA-500 with option MSAGeo MSA-600 with option M3AGeo

3D alignment for the scanning head system | 3D alignment for the object system

Go to SECTION 4.5.7. Go to SECTION 4.5.8.

@ Before carrying out a 3D alignment, make sure that you have set the
correct zoom factor in the list Lens in the scanning head control. The
software uses the zoom factor set to calculate the position of the laser on
the object under investigation.
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4.5.2 3D Alignment for the PSV without Geometry Scan Unit

2D alignment

Open dialog

Select the unit

if you are using a scanning head without geometry scan unit, proceed as
follows for a 3D alignment:

1. If you have not performed 2D alignment yet, do it now as described in
SECTION 4.4,

Click & or select Setup > 3D Alignment. The video window is maximized
and the dialog 3D Alignment appears. You can show or hide the dialog. To

r

You can also click the video image with the right mouse button and select
Dialog 3D Alignment in the context menu. The dialog 3D Alignment
appears.

@ if your PSV is equipped with a scanning head with geometry scan unit,
then for this 3D alignment, deactivate the box Auto next to Assign
Coordinates to Point. If you want to use the geometry scan unit, read
SECTION 4.5.3.

Figure 4.7: Dialog 3D Alignment for the PSV without geometry scan unit

3. Select the unit for the coordinates {m or mm).
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Position the
laser heam

Define
alignment
points

Delete
alignment
points

Set the
coordinates
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4. Now you can move the laser beam using the icons Position in the
scanning head control.

Alternatively you can also use the mouse directly. Using the middle mouse
button {mouse wheel), click in the video image. This will make the laser
beam jump to your mouse cursor. To position the beam, hold the middle
mouse button pressed and drag with the mouse until the laser beam is
positioned on the required point on the object.

< If you have assigned a special function to the middle mouse buiton (e.g.
double-click), position the laser beam using the icons Position in scanning
head control.

To increase the accuracy when hitting the required point, zoom the video
image. See SECTION 2.6.8 on this.

5. Once you have found the precise position of the required point on the

object, in the dialog 3D Alignment select @ Set New Allgnment Point at
Laser Spot/Assign Laser Spot to Point. Now in the video image, click the
point which the laser beam is currently at. An alignment point will now be

defined there. The alignment point is marked using a black circle .

6. Define four to seven alignment points in this way. You will find information
on appropriate arrangement of the alignment points in SECTION 4.8.

To delete an alignment point, click it in the video image with the right mouse
button and select Delete in the context menu.

To delete all the alignment points, click the video image with the right mouse
button and select Delete All in the context menu.

7. Enter the coordinates for every alignment point.

if you enter the coordinates manually, click Add. The dialog Add
Coordinates appears.

Figure 4.8: Dlalog Add Coordinates

Enter the values in the fields X, Y and Z and click Add. Once you have
entered coordinates for all the alignment points, click Close or press the
Escape key {o leave the dialog.

If you want to import the coordinates e.g. from an externai program, then
click Import. Then enter the file which you want to import the values from.

%= When you import, all coordinate lines that already exist in the dialog 3D
Alignment will be deleted!
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@~ If you are importing geometry from a file in ASCH format or a file in
Universal File format which does not contain data set 164 with the units of
the coordinates, you have to enter a scaling factor in the dialog 3D
Alignmenit (refer to FIGURE 4.9). Factor 1 stands for the unit 1 m, factor
0.01 for the unit 1cm efc.

Figure 4.9: Dialog Scaling of Imported Coordinates

Delete If the table contains too many coordinate lines, you can delete individual lines.

coordinate lines To do so, mark one or more lines and click Delete. Or mark the coordinate
lines you want to keep, click invert Selection and then Delete. This way you
will delete all the undesired fines at once.

If you want to delete all coordinate lines at once, click Delete All.
& |f alignment points on the video image are already linked with the

coordinates in the table, then the coordinates assigned to the points are
deleted, the alighment points themselves however remain.
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8. Then in the dialog 3D Alignment, select % Assign Coordinates to Point.

9. Inthe dialog 3D Alignment, mark the first coordinate line in the table and
click the associated alignment point in the video image. A tick will appear
in each of the columns xyz and Laser. These show that the coordinates of
this line are now assigned to an alignment point. The circle in the video

image is now shown in bold @;ﬁ and the marker in the table moves on one
line.

10. Now, in the table, assign coordinates to each alignment point.

@ Every alignment point must have a coordinate line assigned to it here.
However, there can be coordinate lines which are not assigned to an
alignment point.

if you make the measurement with the aid of a mirror, e.g. to scan a side of
the object under investigation which you can not reach directly with the laser
beam, you have to perform the 2D and 3D alignment on the mirror image.
Apart from that, in the dialog 3D Alignment mark the box Mirror.

@ Please note that for a scan, the scanning head can only be aligned either
to the mirror image or directly on the object. However, you can carry out
two scans with and without the mirror and then combine them (refer to
SECTION 8.5). To do so, you will need an individual 3D alignment for each
scan.

11. In the field Target Quality enter the maximum value by which the
alignment points may deviate from the given coordinates {e.g. 1mm).

Once you have defined the alignment points and have assigned coordinates
to them, you can calculate the alignment.

12. Click Calcutate. The software will now calculate the alignment. The
current quality of this alignment is shown in the dialog. If the 3D alignment
is successful, then the LED Status will turn green. If the LeD lights up red,
then the alignment is not valid.

@ [f the value for the current quality exceeds the value for the target quality,
then a message will appear. The Lep Status will turn yellow. Despite this,
you can use the 3D alignment.
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You can check the quality for the individual alignment points. The
alignment points for which the quality value for the respective scanning
head is lower than the value in the field Target Quality will have a tick in
the column Quality.
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Figure 4.10: Successful 3D alignment for the PSV without geometry scan unit

@ You can sort the entries in the table in ascending or descending order in
every column. To do so, click the head of the respective column.

Reassign the You can also reassign new laser positions to existing alignment points to
laser position increase the quality of the measurement resuits. To do so, in the dialog 3D

Alignment select @ Set New Alighment Point at Laser Spot/Assign Laser

Spot to Point. Then move the relevant laser beam to the point on the object
and click the alignment point in the video image with the left mouse button.
The new laser position is used to calculate the alignment again.

Abort alignment  You can abort the alignment at any time. To do so, click @ or select Setup >
3D Alignment. You will be given a message that the alignment was not
finished correctly and you can now decide whether you want to repeat it or

not.
Check You can also refrospectively check the assignment of the alignment points on
alignment the video image with the coordinates in the table of the dialog 3D Alignment.

points
13. To do so, in the dialog 3D Alignment, select W/ Select and Check Point.
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14. Then click an alignment point in the video image. The corresponding line

in the table is marked.

Or click a line in the table. The corresponding alignment point is displayed
biue in the video image.

If a valid 3D alignment is available, then the laser beam is moved to the
position calculated from the x-, y- and z-coordinates. You can visually
check the quality of the alignment at the respective alignment point. The
more accurately the laser beam hits the points on the object, the higher
the quality of the alignment.

Clear If you have already assigned coordinates to an alignment point, delete the
assignment respective table line in the dialog 3D Alignment. The assignment of the
alignment point to the coordinates is removed.

Add offset Once you have calculated the 3D alignment, you can add an offset to the
coordinates. To do so, click Offset. The dialog Add Offset appears. Enter the
required offset and click OK. The offset is added to ali coordinates and the
alignment is calculated again.

End alignment  15. Click &P to leave the dialog 3D Alignment.

4,5.3 3D Alignment for the PSV with Geometry Scan Unit (as an Option)

The optional geometry scan unit will make it easier for you to perform 3D
alignment. If you are using a scanning head with geometry scan unit, proceed
as follows for a 3D alignment:

2D allgnment 1.

Open dialog 2.

4-24

If you have not performed 2D alignment yet, do it now as described in
SECTION 4.4,

Click @ or select Setup > 3D Alighment. The video window is maximized
and the dialog 3D Alignment appears. You can show or hide the dialog. To

do so, click B or select Setup > Dialog 3D Alignment.
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You can also click the video image with the right mouse button and select
Dialog 3D Alignment in the context menu. The dialog 3D Alignment
appears.
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Figure 4.11: Dialog 3B Alignment for the PSV with geometry scan unit

Activate 3. Mark the hox Auto next to Assign Coordinates to Point to use the
geptmetry scan geometry scan unit for 3D alignment.
unl

Select the unit 4. Select the unit for the coordinates (m or mm).

Position the 5. Now you can move the laser beam using the icons Position in the
laser beam scanning head control.

Alternatively you can also use the mouse directly. Using the middle mouse
button {mouse wheel), click in the video image. This will make the laser
heam jump to your mouse cursor. To position the beam, hold the middle
mouse button pressed and drag with the mouse until the laser beam is
positioned at the required point on the object.

@ |f you have assigned a special function to the middie mouse button (e.g.
double-click), position the laser beam using the icons Position in the
scanning head control.

To increase the accuracy when hitting the required point, zoom the video
image. See SECTION 2.6.8 on this.
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Once you have found the precise position of the required point on the

object, in the dialog 3D Alignment select @ Set New Allgnment Point at
Laser Spot/Assign Laser Spot {o Point. Now in the video image, click the
point which the laser beam is currently at. An alignment point will now be

defined there. The alignment point is marked with a black circle and a
line is added to the dialog 3D Alignment which is automaticaily assigned
to the alignment point. In the column Distance the distance measured to
this alignment point is entered. In the column Laser it shows that the point
has been defined.

When defining every alignment point, the software automatically switches
over to the geometry laser and carrles out a distance measurement to the
alignment point. When defining the alignment points, you can save time
by activating the geometry laser first to avoid having to switch over. To do
s0, select Scan > Geometry Laser.

Define three to twenty alignment points in this way. You will find
information on appropriate arrangement of the alignment points in
SECTION 4.6.

To delete an alignment point, click it in the video image with the right mouse
button and select Delete in the context menu. You can also mark the
corresponding line of the table in the dialog 3D Alignment and click Delete.

To delete all the alignment points, ¢lick the video image with the right mouse
button and select Delete All in the context menu.

You have the following options to define the object coordinate system (object
system):

Paints with Free Coordinates: You mark at least three points and enter all
the coordinates of these points.

Origin, Axis, Plane: You mark the origin, any point of your choice along the
positive x-, y- or z-axis and any point in the positive haif plane limited by
the selected axis {e.g. 0, +x, x/+y).

Three Points on Axes: You each mark any point on the positive x-, y- and
z-axis.

In the following the option Points with Free Coordinates is described in detail.
Both the other options will be explained to you briefly at the end of this
section.

8.

Select Points with Free Coordinates from the list Coordinate Definition
Mode.
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9. Click the alignment point with the right mouse button and select Point with
Free Coordinates in the context menu. The dialog Assign Coordinates
appears. '

fisson Coordinate

! 00w
¥ | 00° mh
z 0.0 o

o | el |

Figure 4.12: Dialog Assign Coordinates

10. Here you enter the coordinates of the alignment point and click OK. XYZ
will appear next to the point.

11. Repeat steps 9 and 10 until you have assigned coordinates to at least
three alignment points.

% |f you have defined more than three alignment points, then you do not
have to assign coordinates to all the alignhment points. However, only
alignment points which have had coordinates assigned to them will be
used to calculate the 3D alignment. For further information please read
SECTION 4.6.

If you make the measurement with the aid of a mirror, e.g. to scan a side of
the object under investigation which you can not reach directly with the laser
beam, you have to perform the 2D and 3D alignment on the mirror image.
Apart from that, in the dialog 3D Alignment mark the box Mirror.

@ Please note that for a scan, the scanning head can only be aligned either
to the mirror image or directly on the object, However, you can carry out
two scans with and without the mirror and then combine them (refer to
SECTION 8.5}. To do so, you will need an individual 3D alignment for each
scan.

12. In the field Target Quality enter the maximum value by which the
alignment points may deviate from the given coordinates (e.g. 1mm).

Once you have defined the alignment points and have assignhed coordinates
to them, you can calculate the alignment.

13. Click Calculate. The software will now calculate the alignment. The
current quality of this alignment is shown in the dialog. If the 3D alignment
is successful, then the Lep Status will turn green. If the LED lights up red,
then the alignment is not valid.

@ If the value for the current quality exceeds the value for the target quality,
then a message will appear. The LED Status will turn yellow. Despite this,
you c¢an use the 3D alighment.
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You can check the quality for the individual alignment points. The
alignment points for which the quality value for the respective scanning
head is lower than the value in the field Target Quality will have a tick in
the column Quality.
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Figure 4.13: Successful 3D alignment for the PSV with geometry scan unit

@ You can sort the entries in the table in ascending or descending order in
every column. To do so, click the head of the respective column.

You can also reassign new laser positions {o existing alignment points to
increase the quality of the measurement results. To do so, in the dialog 3D

Alignment select @ Set New Alignment Point at Laser Spot/Assign Laser
Spot to Point. Then move the relevant laser beam to the point on the object
and click the alignment point in the video image with the left mouse buiton,
The software will carry out a new distance measurement to the alignment
point. The new laser position and distance are used to recalculate the
alignment.

You can abort the alignment at any time. To do so, click @ or select Setup >
3D Alignment. You will be given a message that the alignment was not
finished correctly and you can now decide whether you want to repeat it or
not.

You can ailso retrospectively check the assignment of the alighment points on
the video image with the coordinates in the table of the dialog 3D Alignment.
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14. To do so, in the dialog 3D Alignment, select N/ Select and Check Point.
15. Then click an alignment point in the video image. The corresponding line
in the table is marked.

Or click a line in the table. The corresponding alignment point is displayed
blue in the video image.

@~ If a valid 3D alignment is available, then the laser beam is moved to the
position calculated from the x-, y- and z-coordinates. You can visually
check the quality of the alignment at the respective alignment point. The
mare accurately the laser beam hits the points on the object, the higher
the quality of the alignment.

Once you have calculated the 3D alignment, you can add an offset to the
coordinates. To do so, click Offset. The dialog Add Offset appears. Enter the
required offset and click OK. The offset is added to all coordinates and the
alignment is calculated again.

@ |f you have selected a different coordinate definition mode than Points
with Free Coordinates, then when an offset is added, the software will
automatically switch into the mode Points with Free Coordinates.

16. Click & to leave the dialog 3D Alighment.

Origin, Axis, Plane

To define the object coordinate system this way, replace steps 8 to 11 in
section Define and assign coordinates with the following:

1. Select Origin, Axis, Plane from the list Coordinaie Definition Mode.

2. With the right mouse button, click the alignment point which you want to
define as origin and select Origin in the context menu. Next to the
alignment point a 0 appears. The origin coordinates (0/0/0) are displayed
in the dialog 3D alighment.

3. With the right mouse button, click the alignment point which you want to
define on the x-axis for example and select Point on +x-axis in the context
menu. An +x will appear next to the point; an arrow will be drawn through
the point. The distance and the coordinates (+x/0/0) of the point are
shown in the dialog 3D Alignment.

4. With the right mouse button, click the alignment point which you want to
define in a half-plane and select for example Point on x/+y plane in the
context menu. An x/+y will appear next to the point. The distance and the
coordinates (x/+y/0) of the point are shown in the dialog 3D Alignment.

5. Now continue with the 3D alignment as described from step 12 onwards
further up.

@ The target quality also has to be entered in this coordinate definition
mode. The current quality ascertained is always 0. If you have defined
more than three alignment points, the excess alignment points are not
taken into consideration when calculating the 3D alignment.
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Three Points on Axes

To define the object coordinate system this way, replace steps 8 to 11 in
section Define and assign coordinates with the following:

1.
2.

Select Three Points on Axes from the list Coordinate Definition Mode.

Use the right mouse button to click the alignment point which the x-axis of
the coordinate system is to run through and select Point on +x-axis in the
context menu. An +x will appear next to the point; an arrow will be drawn
through the point.

Repeat step 2 for one more alignment point each on the y- and z-axis.

Now continue with the 3D alignment as described from step 12 onwards
further up.

The target quality also has fo be entered in this coordinate definition
mode. The current quality ascertained is always 0. If you have defined
more than three alignment points, the excess alignment points are not
taken into consideration when calculating the 3D alignment.

4.5.4 3D Alignment for the PSV-3D without an Activated Geometry Scan Unit

2D alignment

Open dialog

4-30

% |f you are using the PSV-3D in 1D mode, you only have to perform the 3D

alignment for the scanning heads which are not marked as reference.

If you are using your PSV-3D without an activated geometry scan unit,
proceed as follows for a 3D alignment:

1.

If you have not performed 2D alignment yet, do it now as described in
SECTION 4.4.

Click @, or select Setup > 3D Alignment. The video window is maximized
and the dialog 3D Alignment appears. You can show or hide the dialog. To

do so, click or select Setup > Dialog 3D Alignment.

You can also click the video image with the right mouse bulton and select
Dialog 3D Alignment in the context menu. The dialog 3D Alignment
appears.

Deactivate the box Auto next to Assign Coordinates to Point. If you want
to use the geometry scan unit, read SECTION 4.5.5.
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Figure 4.14: Diatog 3D Alignment for the PSV-3D without an activated geometry scan unit
Select the unit 3. Select the unit for the coordinates {(m or mm).

Select scanning 4. In the scanning head control, select a scanning head, or with the right
head mouse button, click the video image and select one of the scanning heads
{Top, Left or Right) in the context menu.

Position the 5. Now you can move the laser heam using the icons Position in the
laser beam scanning head control.

Alternatively you can also use the mouse directly. Using the middle mouse
button {mouse wheel), click in the video image. This will make the laser
beam jump to your mouse cursor. To position the beam, hold the middle
mouse button pressed and drag with the mouse until the laser beam is
positioned on the required point on the object.

@ |f you have assigned a special function to the middle mouse button (e.g.
double-click), position the laser beam using the icons Position in the
scanning head control.

To increase the accuracy when hitting the required point, zoom the video
image. See SECTION 2.6.8 on this.
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6. Once you have found the precise position of the required point on the

object, in the dialog 3D Alignment select @ Set New Alignment Point at
Laser Spot/Assign Laser Spot to Point. Now in the video image, click the
point which the laser beam is currently at. An alighment point will now be
defined there.

The alignment point is marked using a black circle. This icon shows you
which scanning head you are currently aligning:

@ designates the left, the right and @ the top scanning head.
& If for example, you click on the same place in the video image for the top

and the left scanning head one after the other, you will be shown . For

all three scanning heads will appear.

7. Inthis way you define four to seven alignment points for all three scanning
heads. These alignment points can be the same for all three scanning
heads, but this is not necessary. You will find information on appropriate
arrangement of the alignment points in SECTION 4.6.

To delete an alignment point, click it in the video image with the right mouse
button and select Delete in the context menu,

To delete all the alignment points, click the video image with the right mouse
button and select Delete All in the context menu.

8. Enter the coordinates for every alignment point.

if you enter the coordinates manually, click Add. The dialog Add
Coordinates appears.

Add Coordinates: 0 3
.4 | 0.0 mn
¥i 00. mm
z [ o0 i

acd dose |

Figure 4.15: Dialog Add Coordinates

Enter the values in the fields X, Y and Z and click Add. Once you have
entered coordinates for all the alignment points, click Close or press the
Escape key to leave the dialog.

If you want to import the coordinates e.g. from an external program, then
click Import. Then enter the file which you want to import the values from.

@ When you import, all coordinate lines that already exist in the dialog 3D
Alighment will be deleted!
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%= |f you are importing geometry from a file in ASCII format or a file in
Universal File format which does not contain data set 164 with the units of
the coordinates, you have fo enter a scaling factor in the dialog 3D
Alignment (refer to FIGURE 4.16). Factor 1 stands for the unit 1m, factor
0.01 for the unit 1cm etc.
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Figure 4.16; Dialog Scaling of Imported Coordinates

if the table contains too many coordinate lines, you can delete individual lines.
To do so, mark one or more lines and click Delete. Or mark the coordinate
lines you want to keep, click Invert Selection and then Delete. This way you
will delete all the undesired lines at once.

If you want to delete all coordinate lines, click Delete All.

@ [f alignment points on the video image are already linked with the

10.

1.

coordinates in the table, then the coordinates assigned to the points are
deleted, the alignment points themselves however remain.

Then in the dialog 3D Alignment, select 5% Assign Coordinates to Point.

In the dialog 3D Alignment, mark the first coordinate line In the table and
click the associated alignment point in the video image. In the column xyz
a tick will appear which shows that the coordinates in this line are now
assigned to an alignment point. The circle In the video image is now

shown in bold @ and the marker in the table moves on one line.

If you have assigned coordinates to an alignment point, then in the dialog
3D Alignment in the table Laser you will see for which scanning head you
have already defined the respective alighment point. The three dots in the

icon * stand for the three laser beams Top, Left and Right.
Now, in the table, assign coordinates to each alignment point.
Every alignment point must have a coordinate line assigned to it here.

However, there can be coordinate lines which are not assigned to an
alignment point.
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If you make the measurement with the aid of a mirror or several mirrors, e.g.
to scan a side of the object which you can not reach directly with the laser
beam, you have to perform 2D and the 3D alignment for the respective
scanning head on the reflection of the object. Apart from that, in the dialog 3D
Alignment, tick the corresponding box in the column Mirror.

@~ Please note that for a scan, each scanning head can only be aligned
either to the mirror image or directly on the object. However, you can carry
out two scans with and without the mirror and then combine them (refer to
SECTION 8.5). To do so, you will need an individual 3D alignment for each
scan.

12. In the field Target Quality enter the maximum vaiue by which the
alignment points may deviate from the given coordinates (e.g. 1mm).

Once you have defined the alignment points for all three scanning heads and
have assigned coordinates to them, you can calculate the alignment.

13. Click Calculate. The software will now calculate the alignment for each
scanning head. The current quality of this alignment is displayed in the
dialog for every scanning head. If 3D alignment for a scanning head is
successful, then the respective LeD Status wilt be green. If the LED lights
up red, then the alignment is not valid.

@ [f the value for the current guality exceeds the value for the target quality
for one or more scanning heads, then a message will appear. The
respective LeD Status will turn yellow. Despite this, you can use the 3D
alignment.

You can check the quality for the individual alignment points. In the
column Quality up to three green markers will be displayed for one
alignment point if the quality value for the respective scanning head falls
below the value in the field Target Quality.
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Figure 4.17: Successful 3D alignment for the PSV-3D without activated geomelry scan unit

&= You can sorf the entries in the table in ascending or descending order in
every column. To do so, click the head of the respective column.

You can also reassign new laser positions to existing alignment points to
increase the quality of the measurement results. To do so, in the dialeg 3D

Alignment select @ Set New Alignment Point at Laser Spot/Assign Laser
Spot to Point. Then move the respective laser beam to the point on the object
and click the alignment point in the video image with the left mouse button.
The new laser position is used to calculate the alignment again.

You can abort the alignment at any time. To do so, click & or select Setup >
3D Alignment. You will be given a message that the alignment was not
finished correctly and you can now decide whether you want to repeat it or
not.

You can also retrospectively check the assigniment of the alignment points on
the video image with the coordinates in the table of the dialog 3D Alignment.

14, To do so, in the dialog 3D Alignment, select /1 Select and Check Point.

15. Then click an alignment point in the video image. The corresponding line
in the table is marked.
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Or click a line in the fable. The corresponding alignment point is displayed
blue in the video image.

& If there is valid 3D alignment, then the laser beams are moved to the
positions calculated for the x-, y- and z-coordinates. You can visually
check the quality of the alignment at the respective alignment point. The
more accurately the laser beams hit the points on the object, the higher
the quality of the alignment.

If you have already assigned coordinates to an alignment point, delete the
respective table line in the dialog 3D Alignment. The assignment of the
alignment point to the coordinates is removed.

Once you have calculated the 3D alignment, you can add an offset to the
coordinates. To do so, click Offset. The dialog Add Offset appears. Enter the
required offset and click OK. The offset is added to all coordinates and the
alignment is calculated again.

16. Click 68 to leave the dialog 3D Alignment.

4.5.56 3D Alignment for the PSV-3D with Geometry Scan Unit

2D alignment

Open dialog

436

@ If you are using the PSV-3D in 1D mode, you only have {o perform the 3D
alignment for the scanning heads which are not marked as reference.

The geometry scan unit will make it easier for you to perform 3D alignment. If
you are using a PSV-3D with a geometry scan unit, proceed as follows for a
3D alignment:

1. i you have not performed 2D alignment yet, do it now as described in
SECTION 4.4,

2. Click @ or select Setup > 3D Alignment. The video window is maximized
and the dialog 3D Alignment appears. You ¢an show or hide the dialog. To

do s0, click B2 or select Setup > Dialog 3D Alignment.

You can also click the video image with the right mouse button and select
Dialog 3D Alignment in the context menu. The dialog 3D Alignment
appears.
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Figure 4.18; Dialag 3D Alignment for the PSV-3D with geometry scan unit

3. Mark the box Auto next to Assign Coordinates to Point {o use the

geometry scan unit for 3D alignment.

Select the unit for the coordinates (m or mm).

in the scanning head contro!, select the scanning head Top or click the

' video image with the right mouse button and select Scanning Head Top in

the context menu.

Now you can move the laser beam using the icons Position in the
scanning head control.

Alternatively you can also use the mouse directly. Using the middle mouse
button (mouse wheel), click in the video image. This will make the laser
beam jump to your mouse cursor. To position the beam, hold the middle
mouse button pressed and drag with the mouse until the laser beam is
positioned on the required point on the object.

if you have assigned a special function to the middle mouse button (e.g.
double-click), position the laser beam using the icons Position in the
scanning head control.

To increase the accuracy when hitting the required point, zoom the video
image. See SECTION 2.6.8 on this.
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Once you have found the precise position of the required point on the

object, in the dialog 3D Alignment select @ Set New Allgnment Point at
Laser Spot/Assign Laser Spot to Point. Now in the video image, click the
point which the laser beam is currently at. An alignment point will now be

defined there. The alignment point is marked with a black circle @ and a
line is added to the dialog 3D Alignment which is automatically assigned
to the alignment point. In the column Distance the distance measured to
this alignment point is entered. In the column Laser it shows that the point
has been defined.

@ When defining every alignment point, the software automatically switches

over fo the geometry laser and carries out a distance measurement to the
alignment point. When defining the alignment points, you can save time
by activating the geometry laser first to aveid having to switch over. Te do
s0, select Scan > Geometry Laser.

Define three to twenty alignment points in this way. You will find
information on appropriate arrangement of the alignment points in
SECTION 4.6.

To delete an alignment point, click it in the video image with the right mouse
button and select Delete in the context menu. You can also mark the
corresponding line of the table in the dialog 3D Alignment and click Delete.

To delete all the alignment peints, click the video image with the right mouse
button and select Delete All in the context menu.

You have the following options to define the object coordinate system (object
system):

Points with Free Coordinates: You mark af least three points and enter all
the coordinates of these points.

Origin, Axis, Plane: You mark the origin, any point of your choice along the
positive x-, y- or z-axis and any point in the positive half plane limited by
the selected axis (e.g. 0, +x, x/+y).

Three Points on Axes: You each mark any point on the positive x-, y- and
z-axis.

In the foliowing the option Points with Free Coordinates is described in detail.
Both the other options wili be explained to you briefly at the end of this
section.

9.

Select Points with Free Coordinates from the list Coordinate Definition
Mode.
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10. Click the alignment point with the right mouse button and select Point with
Free Coordinates in the context menu. The dialog Assign Coordinates
appears.

Atsign Coordinate:

g [ 00, mm
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i 00
1 |—ox_| C caned |

Figure 4.19: Dialog Assign Coordinates

11. Here you enter the coordinates of the alignment point and click OK. XYZ
will appear next to the point.

12. Repeat steps 10 and 11 until you have assigned coordinates to at least
three alignment points.

@ If you have defined more than three alignment points, then you do not
have to assign coordinates to all the alignment points. However, only
alignment points which have had coordinates assigned to them will be
used to calculate the 3D alignment for the scanning head Top. For further
information pilease read SECTION 4.6,

If you make the measurement with the aid of a mirror or several mirrors, e.g.
to scan a side of the object under investigation which you can not reach
directly with the laser beam, you have to perform the 2D and 3D alignment on
the mirror image. Apart from that, in the dialog 3D Alignment, tick the
corresponding box in the column Mirror.

% Please note that for a scan, each scanning head can only be aligned
either to the mirror image or directly on the object. However, you can carry
out two scans with and without the mirror and then combine them (refer to
SECTION 8.5). To do so, you will need an individual 3D alignment for each
scan.

13. In the field Target Quality enter the maximum value by which the
alignment points may deviate from the given coordinates (e.g. 1mm).

Once you have defined the alignment points for the scanning head Top and
have assigned coordinates to them, you can calculate the alignment for the
scanning head Top.

438
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14. Click Calculate. The software will now calculate the alignment only for the
scanning head Top. The current quality of this alignment is shown in the
diatog. If 3D alighment for a scanning head Top is successful, then the
corresponding LeD Status will be green. If the LED lights up red, then the
alignment is not valid.

@ As you have not yet defined any alignment points for the scanning heads
Left and Right you will definitely get a message. However, if the value for
the current quality for the scanning head Top exceeds the value for the
target quality, then this will also be listed in the message. The LED Status
will furn yellow. Despite this, you can use the 3D alignment.

You can check the quality for the individual alignment points. in the
column Quality one green marker will be displayed for one alignment point
if the quality value for the scanning head Top falls below the value in the
field Target Quality.
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Flgure 4.20: Successful 3D alignment for the scanning head Top with geometry scan unit

@ You can sort the entries in the table in ascending or descending order in
every column. To do so, click the head of the respective column.

You can also reassign new laser positions to existing allgnment points to
increase the quality of the measurement results. To do so, in the dialog 3D

Alignment select @ Set New Alignment Point at Laser Spot/Assign Laser
Spot to Point. Then move the refevant laser beam to the point on the object
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and click the alignment point in the video image with the left mouse button.
The software will carry out a new distance measurement to the alignment
point. The new laser position and distance are used to recalculate the
alignment.

Now perform 3D alignment for the scanning heads Left and Right. You define
the coordinates of the alignment points for these scanning heads with the aid
of the scanning head Top. To do so, continue as follows:

15,

&

16.

17.

18.

18.

20.

21,

22,

Move the laser beam of the scanning head Top to the required position.

While doing so, it is not absolutely necessary for the point to be on the
object or respectively in the video image. Read SECTION 4.6 on this.

Once you have found the precise position of the required point, in the

dialog 3D Alignment select @ Set New Alignment Point at Laser Spot/
Assign Laser Spot to Point.

Now in the video image, click the point which the laser beam is currently
at. An alignment point will now be defined there. The alighment point is

marked with a circle and a line is added to the dialog 3D Alignment
which is automatically assigned to the alignment point.

Select the scanning head Left and move the laser beam to the same point
at which you positioned the laser of the scanning head Top.

In the video image, click the point which the laser beam is currently at. An
alignment point is now defined there for the scanning head Left. The

alignment point is now marked with the circle .

Select the scanning head Right and move the laser beam to the same
point at which you positioned the lasers of the scanning heads Top and
Left.

In the video image, click the point which the laser beams are currently at.
An alignment point is now defined there for the scanning head Right. The

alignment point is now marked with the circle .

Now define four to seven alignment points this way for the scanning heads
Left and Right which also each have to be defined with the scanning head
Top. You will find information on appropriate arrangement of the alignment
points in SECTION 4.6.

Please note that the alignment points defined in this way are not used for
calculating the 3D alignment for the scanning head Top. You have fo
define these alignment points with the scanning head Top so that the
coordinates for the alignment points for scanning heads Left and Right
can be calculated.

Once you have defined the alignment points for all three scanning heads, you
can calculate the alignment for all three scanning heads.
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23. Click Calculate. The software will now caiculate the alignment for each
scanning head. The current quality of this alignment is displayed in the
dialog for every scanning head. if 3D alignment for a scanning head is
successful, then the respective LED Status will be green. If the LED lights
up red, then the alighment is not valid.

@ If the value for the current quality exceeds the value for the target quality
for one or more scanning heads, then a message will appear. The
respective LED Status will turn yeilow. Despite this, you can use the 3D
alignment.

You can check the quality for the individual alignment points. In the
column Quality up to three green markers will be displayed for one
alignment point if the quality value for the respective scanning head falls
below the value in the field Target Quality.
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Figure 4.21: Successful 3D alignment for the PSV-3D with geometiy scan unit

= You can sort the entries in the table in ascending or descending order in
every column. To do so, click the head of the respective column.

You can abort the alignment at any time. To do so, click & or select Setup >
3D Alignment. You will be given a message that the alignment was not
finished correctly and you can now decide whether you want to repeat it or
not.

You can also retrospectively check the assignment of the alignment points on
the video image with the coordinates in the table of the dialog 3D Alignment.
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24, To do so, in the dialog 3D Alignment, select N4 Select and Check Point.
25. Then click an alignment point in the video image. The corresponding line
in the table is marked.

Or click a line in the table. The corresponding alignment point is displayed
blue in the video image.

@ |f there is valid 3D alignment, then the laser beams are moved to the
positions calculated for the x-, y- and z-coordinates. You can visually
check the quality of the alignment at the respective alignment point. The
more accurately the laser beams hit the points on the object, the higher
the quality of the alignment.

Once you have calculated the 3D alignment, you can add an offset to the
coordinates. To do so, click Offset. The dialog Add Offset appears. Enter the
required offset and click OK. The offset is added to all coordinates and the
alignment is calculated again.

& If you have selected a different coordinate definition mode than Points
with Free Coordinates, then when an offset is added, the software will
automatically switch into the mode Points with Free Coordinates.

26. Click &9 to leave the dialog 3D Alignment.

Origin, Axis, Plane

To define the object coordinate system this way, replace steps 9t0 12 in
section Define and assignh coordinates with the following:

1. Select Origin, Axis, Plane from the list Coordinate Definition Mode.

2. With the right mouse button, click the alignment point which you want to
define as origin and select Origin in the context menu. Next to the
alignment point a 0 appears. The origin coordinates (0/0/0) are displayed
in the dialog 3D Alignment,

3. With the right mouse button, click the alignment point which you want to
define on the x-axis for example and select Point on +x-axis in the context
menu. An +x will appear next to the point; an arrow will be drawn through
the point. The distance and the coordinates {+x/0/0) of the point are
shown in the dialog 3D Alignment.

4, With the right mouse button, click the alignment point which you want to
define in a half-plane and select for example Point on x/+y plane in the
context menu. An x/+y will appear next to the point. The distance and the
coordinates (x/+y/0) of the point are shown in the dialog 3D Alignment.

@ The target quality also has to be entered in this coordinate definition
mode for the scanning head Top. The current quality ascertained is
always 0. The target quality is used later for alignment of the scanning
heads Left and Right.

5. Now conti